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Zow N7 — 2 S
AHAARER %y MU =279 — L 22 FORL T, —ERI2k-> UL @&

AERE R 2 H 0 T, sEllE, H9E Ry AT—S VY= XANDT
I ZATBX—=INEBIHL TIES0n,

KDET 2 7 b v 7 DRith



A/
KlobViewer#Z #C8f L ¥ 9, KlobVieweriZld, 7V U ZIZHEEL =AY 3
ITMFoRENE T, Flc OV TUE, 124/H TKDETOHIY 3 7 DB
1 (210 X—=) B L TLZ &0,

Firefox
Firefox Web~” o o ZC#i L £ 9, FFIC DWW TUL, 155 Firefox # #
L7572 27231 N=) B L TLEEn,

Ead(h 7 1 )
OpenOffice.orgZ fCffi L, HFHDO RF a2 X NEHEET, Zod 71 A
AA — MIDWTIL, H3% OpenOffice.orgZ 7 + A XA — I (77 X—7)
EHBIHL TL7ZE 0,

N )V(KDETIE, Kicker& & IFIENE NI AN—T, WwHIL HHO L E 7=
FTICEINTHNET, [ X2 ViE, 77— 300 AT LDE
7. BEOEERKEERS T U r—3 a v ANOEZ77 72 ZCHT 5 1ER
PIMET L LIS TOET, 74200 FICRA V2 2 MiT5 8. i
BRSSO RSN E T,

X 1.3 KDE 7~V (Kicker)

= A @ Sm £ 1| Eux-Kongueror 10:33 am
g ‘Eﬁ E— 'ﬂ' f% \,‘g 2 Start Page - KDE Help Center Q@Q a ot

031407

INEIVITIEE. (ROT Y 7o SN TnET,

AAf A= a—T A

T 74N T RNV, A A A= a2 —(KDETIFKA =2 —
EMHINDEZ OV H Y FNEFHL T A 2 H Y, MSWindowsT A7 b v
TNCHD [ZE— ] R ML THET, A RA=a—F, FH
BT TV =g AT ATEL OIS, KBS h/=iiEIc e 5
TWET, £/, a7 RNLEV 7TV =2 a v eMEBELIZDT S L
AR TFELMEEIC OV T A= a—JHHLVH D F9, ZEMICOWTIL,
I131H XA A=Za—A"DT7 7R 11 X=NeBIHL TS
Uy,

DA TIT0F%
AV AZa=TAAVOM, VA9 7T F¥BHVET, 74y
75 F wld, U EERKSEEC T T U = a7 A4 a2y 2 RFL
F9, ZHICLED, A RA=Za—2EITYHZD LIgERL T 7V

KDE =.—#J7 A K



r—varEEETcEEd, £/-, HelpCentero 7 A 2> bHV, v A5
LT ATV VT EFRORTEET,

FTAT Ny T T Ea—7
DALy IIF DI, FAZ Ry T L2 —=THHY ., YoF A
7Ry IR RENET, INHEFAZ by Tk T FERARITT S =
EMMTEET, [AFRCEZLS 0TS L2 MiHlT581E. 12DF A7
Ny T 2ho7darI Lk T LT bI1DPDT AV My I TE
72O Tal o LtFITTLHIEMNTEET, TRV by T2YY
BADIE, "RXNVTT A Ny TRV ET )y 7 LET,

B A IN—

BADN=F. TAT RNy T T L a—T7oIcilEISNTHWET, 7
THINVKRT, BEIL THWETITRTCOT7 T r—o g vy G Tnbs 1 v
ROIMBE A N1 FoRENL0, BIUET VT4 TT A7 hy 7T ThH
LMEIMITHEHDET, WTFho7 ) r—2 g b7/ ATEE
T, BAIN=DHR T4V RIDZA "NV 7T 5 Tl
ST 7TV =2 a4 7 o0 NIV EST, To7 T r—
SavBC T T T RIZh s TWABIRWT, 74 v RooX A K
N2V 2358, TO7IVr— g dkMeshEd,

VAR ULA
INFINVDHIHOEMTIETIL. AT L 7ay 7, R a2 —L8H, Bk
DD WL ODPDANIN—=T T r— 3 V25 L 7,

A AZma— TAZ by TrAay, IR E, TAZ by T
ORAREMEOFETTFEICOWTUE, NRAE [FAI Ny TA TV =27 v
HIEL BT X—=) & NRWH TAXIVOHEE] (63 X—)] ZBIHL TL
7280,

131 ALV AZa2a—"DT7I A

NAINVDKHNCH LT A A ZHL T, A A=a—2lSET., £
3 AL+ FIXF =2 L 9, XA > XA==a—I1& [Most Used Applications ]
(&L bbb 7 7V r—3 ay),  [All Applications] (TXTO7 TV ir—
Ya NI RCoO7 TV =y arBhralicafichizA=2—). B
KO [Actions] (772 a)D32D® 7 ¥ q XN TnhEd, BBT 5
TIVr—vasid, REBMHLLETZ TV r—>a>] ¥y a Vidkd
FLFRKRENET,
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ZDAZ a2 —IKEBET L OREIC R > TBY., 7T =3 g v ORI
MERNWEDRIGETYH, HINICG 7 TV r—y a vy EEICHEDT S
ZEMMTEET, 7T g VOLANE 2T L & S ARTO TR
Mo TNDED, A VA= a—06 DOCENTENNRRIG L. [£2To7
Fr—2 2] I a  lhOMEREER T TX £,

K 1.4 XA X=2—fpRREGE

All Applications

e L s

= J"J Utilities

MET 4 —VRICT T — g v 4o—8% AT 57207, Enterd — %
TSI PVEIZH Y ETA, 7TV — g VBV AT LA VA R—)V
SNTWBEGIE. COT7 TV r—o g OB A= a2 —EBEA A

I, AL AZ2—DEHEBETEL0 L O OEEIC O W TEIAL £ 7,

Rl > /=7 7 A4
BRIV 7 7 ANV T A VIDBFORENE T, NFa X2 M EIERT 2
. TDORF2 XY MNERR, fWET D007 T ) r— g ot L
F9, ZORFa AV oMHERIHETL2ZL U TEET,

VA AT
R=LT 4 L7 NIRRT 4 7T NA A&, BN 2N E R
X7 ATEET,

av > NEFET
AV REANLTCTY TV r— g o wEET 50084 7aZ Ry 7
AEREET, KIS, a2y REET7 T — g V4R NCTERE
L7zbolle ) £9, 72720, it ehoEd, avr RoHEIAT]
WREZ R 21CiE, a2 RADRFIDOLF 2L D2 ATIL TS
<Tab>F —ZML 9., DFlCca~y RWETINTBY, fcH L F

KDE =.—#J7 A K



THELaA< Y RBRWESIE. 20a<xy REDTRTOLFENHERE
nEd,

a2 —F =Dl z
A Ea—F T GUI(Z T T4 Na—H A F T == ) HHT S
2EHOY Yy Y a VEBKBT LIE. [2—VolFx] 28R £7,
BiEovyya ig7r54 7oxE, floa—PelLTtarsA o357k
o rA yEEVFORENET, IEHOY Yy v 3 VICRAIZIE, Ctrl+
A+F7XF —Z L E9, Lty v a A7 7 AT HEEIE FIX—
DO VICE8F—Z2L 7, [EMIc. Thllfficarsf o Lizky g
VST 7 AT BIEIE. ENTENCI+Alt+ FO~F12F% — 2 L £9,

Ty gy
A= ORENLIEEIC, HEEZ Ty 7 L o2 -2 L b ANE
T RAEIETAZEMWTEET, gy 7RI, A7 ===
BB SNET, By a i ﬁ07ﬁkx?é lZ. N2 — K& AT
LPENH Y FT, oy 7 BT 51 WEoOayZ A XA — K%
ATILET,

Log Out
FATOZICIESERA T a v BB RSNET, CoF L Tash
5, Blifokvy a7 LY, ava—2%EF 7LD, av
Ya—4e/iitedLizn, Hﬁ?ﬁb%#&/kwﬁé EMTEET,
[HlEDty > a9 >0 7] 28R 25815 ¥ AT LEH| S fin S PR
L. Kolowa 7 A Ty 7Y 7 — /a/#mméMi? VAT AT
BHEHIEHEINTOLEEE. ava— 222XV K752
TEET, 2hiud, BAXRVYRT L e, KED Y 25 LREINTESLIC T —
N5 G L0 EHICR b2 TT,

132 UL—NTIV AT 4 POBAE = 1EHE

+=

f
ZﬂVE;wﬁKULvﬂVﬂVXf%?KDROM\?V&ﬂdﬁﬁilﬁBZ
T4 PRI A, itiwﬁﬁbﬁ NSO AT 4 TIXHENIC

Mt & 9., KDEDEGEIL. ﬁméﬂthf?@@ﬁa FTDRATF 4T
ZRIHT 215 @ﬂ7/a/#&47mﬁﬁ/ﬁz CRRENET, X
NLFA T a0, HASNIZAT 4 7OFHIC L > THEZR Y £7,
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X 1.5 USBZ7 ¢ v 2 DHEIE

% A new medium has been detected.
\% What do you want to do?

Medium type: Mounted Removable Medium

Open in New Window

XDO Nothing

[ Always do this for this type of media

[ Configure... HV OK HX Cancel I

Ty AN =TV ¥ TT —F efoRr T 55518, [Openin New Window] % %
RL<C. [OK] #7V v 27 L%7, Konqueror7 7 f V<% —V %2, Ul—
NINVTFNAL ZADONENFRRENTET .

1.6 USBRXT 1 v 2 DHAEDKIR

Location Edit View Go Bookmarks Tools Settings Window Help

Q0L O QaEEms

B Location: [!szstem:/medla/sdm H =
@ Home Folder — —

[Eabin |
W <ADesktop o S
[C'Documents encrypted secretasc  SuSEfirewa

@ [E3public_html asc 12

[}
=

O
('S

o

E

o
%
D
M
]
&

= @3 Items - 3 Files (53.0 KB Total) - No Folders

HEDHHD Y L— A7»%747%ﬁxbtﬁ CHEIRIC 77 > a vhvsE
(TEINDL LT LG, XoREN/ZF A 7T [Always do this for this
type of media ] %ETRLT?J‘%\ [OK] %7V v 7 LET,

LUKS(LlnuxUmﬁedKeySetup)’EﬁoTE FAENTHDLE Y AT LI L=
TIWAT 4 7 RIFA, Rl 725, KDEIXZ n%mﬁb NAT—RDA
NEFERT DAy -V FoREnEd. M17. THS{LUSBAT 1 v 7 D

KDE =.—#J7 A K



—

HEfifrt ) (15 X—=)2 B L L7230, B AT 4 7778 AT 57
WDNAT — R AJJLTL7ZE 0,

E1.7 0E51EUSBZ 7+ v 7 O FHEteH

Generic USB Rash Disk

\) {Idevisdb1) is an encrypted storage
device.

Please enter the password to decrypt
the storage device.

Password: |*='=‘=‘=‘=‘*H='='1 ]
26Caenls)

JL—=NT)N AT ¢ 7 Ol LoifMlE,  TJH [Encrypting the Content of
Removable Media| (5342% Encrypting Partitions and Files, 1 Deployment Guide) |
ZHIL TL IS0,

FIFE11 UVL—NTINRAXTF 1 POUYHEDZE

HEM 7 A4 7 a7 Tld, UL—NTI AT ¢ 7 OFFICIE L 7200 5%
WETEET, A WHBICHIHT MO AT« 7T HFET — 4
PRESNTODLIEE. TOMEDORAT A 7RA A=V a =77 S r—
Vg Y CHEIMCHHL EHICHETEET,

1 HEMRE Y A va ¢, [RE] 227V 7 LET,

2 WEMTA7aric, MHAEERT RTo7 7Y a vIRoREnNE 7,

3 Medium types] K2y 7 X YA NE 7y 7 LT, FREDOT7 VY a
VEATO AT 4 7 OMBEEAERL £, ERL MO X7 7o
T, FIHTEER 7 7 ¥ a v O BBFRRSNE T,

4 e v a v EEIRL,  [Toggle as Auto Action] =7 V) v 7 L &
K

KDEF 27 v 7 DBil:
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1.8 UAL—NINAT ¢ POKDEFREY 1 717
Notfications | Advanced |

Medium types: [Camera H

D Open in New Window - Add
@Browse with Gwenview

@& Open in Digikam
x Do Nothing Toggle as Auto Action

[ o | st o |ty | % cone

5 [iF] 2 T% 2y 7 L. [Enable medium application autostart after
mount] F = v 7Ry 7 APERSN TS Z & 2Rl £7.

6 [OK] %7V vy 7 LT, ZEAREZHHL, XEX¥A 77 %HC %
T, INT, FFELIHEO AT 4 7ERHAL 2 & SICHERYEL 27
7y ISHEIMCE TS ET, DI My A 7ariRoRsnhd
ZriEFHY FEEA,

FIE1.2 T 74k X770 7ORICUFEA 72 5 >

FEDFHEDO AT 4 VI L THELZT72Yaryz2 vy ML, 740
NREICR TSI, RoOFIHICHENET,

1 A A=a—06, [HAZE] Z#ERL T, KDEaZ>» ha—)Lt >~
b —FRdi L £,

2 EfloF ey —y g A=, [JHURE] > [Z -2 X771 7]
DINERL £9, GHICEEY A 7 7BFoRsh 7,

3 [Frank] . L] olcs Yy 2 L&, KEXF ¢ 7 %A

TLEeXICHOHIMMME A A 7a rForsh, AF 4 7 oI kg
FRIFECEET,

KDE =.—#J7 A K



133 VLA—NTIVATF 4 PNOT7I LR

KDETIE, UA—NTIAT 4 VICT 7 AT LT, S IERITEMN
HESNTWEY, TAI Ny T [vraba—4] #2)y 75k,
(119, T=Afarta—%] AT XN—=INIRT LI a—NRRahZE

ER

e
X119 ~vr7aba—%
Location Edit View Go Bookmarks Tools Settngs Window Help

100000 =

B> Location: €9 sysinfor [~ ] [s,

i}

Y[

@ My Computer

Falders, Harddisks, Removable Devices, System Infarmation and mars...

Common Folders Disk Information
Device Filesystem Total space  Available space
> Eloppy Drive auto
J2iGMeda @ reise s 2000GE 168 GB
J54GMedin  reise s S500GB 487 GB
%4 10G Removable Media  vfat 97446MB 96844 MB

0S Information

s
‘ou are online
Linux 2.6.16.42-0.6-default i686

o tux@e218
SUSE Linux Enterprise Desktop 10 (i586)

CPU Information 351 Level "

m Processor (CPL) AMD Athlon(tm) XP 2200+ Display Info
Speed 1.797.48 MHz

| vendor  Matrox Graphics, Inc
ke Model  MGA GA0D AGP
Memory Information Driver  mga (No3D Support)

RAM) 50428 MB

801 MB (+ 32832 MB Caches)

Page loaded.

Konquerorz 7 7 A V<% — ¥ ¥ (1.4H [7 4 )% & UKonquerord®d % 7 7
A IWVOEH] (19X—=NEBIA) e L TREIL T, BB+ > Rons [Xh
L= X7 7] 27Uy 7350 £EF5Y —)L/N—Tmedia: /% A
JIL 72856, [X1.10. TKonquerorNd X7 ¢ 7 DFRoRx| (18 N— V) Trd &
912, KonquerorliZ A b L — Y FNNA ZANFoRENE T,

KDEF 2 7 kv 7 DRith
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X 1.10 Konqueror N X5 ¢ 7 DK

Location Edit View Go
Window Help

GULY O

E# Location: ['_I_IJ media:/

Bookmarks Tools Settings

A Q. EE =6

RN
10G Media 10G Media 16G Media
16G Media 21G Media 43G Media

'9‘@%

Audio CD Floppy Drive USB Stick J

USB Stick JJf Mounted Removable Medium

Konqueror Cl&, USBAT 14 v 7 D& D70V L—/NT )T NA A4 Z T
52 &b TEET, Konqueror CUSBAT 1 w 725271 v 27 LT

> . [Tanx
T ] BEIRLEY., [—#R] ¥ 7T, AN7 4 —I)VRIC&RIZ AL
[OK] #27 Vv 27 LET

o (KIA[USBAT 4 v 7 AL Tz & &, Konque\rorL:
EZ DA ENE T,

INETRAFEDRANT, AT 4 7MW [0 hERTHEZE) (T AR

TUCHEINTNDZ &, XT 4 7DT—ZICT I CRTEL0ICVE) %
#L F9, 1@F. SUSE Linux Enterprise Cl&

L UL=NTITFTNA AT
RENTHENEIDERT H2LEETHY EFHA, T74NVETIE w7~
NMEIHEIRI TN E T,

AR AT 4 TOREBRYSSL

AVE2—=IMNOERAT 4 T ERDVATIHGEE. AT T7HOT =277
Vrr—ygra— %#?7tzbfwﬁw’&éﬁﬂbf<téwox
FATHNOT =BT 7EAL TNLEXIIAT 4 72T L., 57—

KDE =.—#J7 A K



I ONLIGEHMRMERH Y T, AT 4 7 2LV TICE. I
FlEIHENF T,

LIRTCDOYVL=NINVAT 4 7EFRTLE2— S ET,

2. OATAF 4 7RE2 Y w27 LT, [SafelyRemove] % 7=1% [Eject]
RIEIRL £9.  [Sdfely Remove] ZBERL =¥, AT 4 7D~
AR SN, T2 Ea = MO0 AT I M TEL LI F
T, [Eect] #iERL /=454, 2> ¥ a—%DCD/DVD KT A T3]
fHChE £9,

134 CHFHEDEIE

ZHFE IR =7 DT y A NERKNT B0 DT 4 L7 YT,
Ty AN 2=V EET AT by TIme, ITADKERE VML -F
FT7A AL ETHRFETCRTIv L, 7A4arvzRkay7LET, Wb,
TAALEEI Vv I L, Ama =IO [ RIFNFE] #BRTL2 T
TFET, ZRHOTA A EI ) TLHE, TONEEFRRTEET, L
FIIEL T, ZAMoMCHBEEEIYET b TEET,

Ty ANEHEZ )y 7 LT [HIF] %R 55 THIR L2568, To7 7
AL ZTHFAHEISNWE Z 2, TLlICHIRshE T, ZAHoTIcH
577 AINEHIMT HICE. TERFHoTA a7y L. [THREE
ZEICG L] BERL 9,

1.4 7 # V5 & & UKonquerorD & %
274 IVDEIE

KonquerorlZ, Web7 7 7%, 77 A< %—T %, REXaRX R Ea—7,
A A=V E2—=TOREY —NVTT, RO¥r¥arTlE 77 )VEHRD
7= 8% OKonqueror DfF I DWW TEIHL £9°, Web” Z 4 & L T dDKonqueror
ICDWTCIE, BB 1438 Konqueror Z ({5 /2 75 7 X (227 N— N BIHL T2
Iy,

KDEF 27 v 7 DBil:
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NIV HDLRODOTA AL )y 7 LTT 7 ANV A=V x e LTD
Konqueror % itCiifj L ¥ 9, KonqueroriZld, "—LF 1 L7 h U OHENTRE

g7,

111 7 7 AL~ % — 2 v Konqueror

Location Edit View Go Bookmarks Tools Settings Window Help

QOO0 00 = aaEmn=R
E Location: [!home!tux |'] £l
PN onc Foige
(Ebin ' {{
e ADesktop |
DDocyments bin Desktop Documents public_html
@ [Egpublic_html
b
izl
[=]
(T
[¥]
E
o
o of
D
M
&4 tems - No Files - 4 Folders

Konqueror 7 7 f V< 32— v 7 1 ¥ Rold, (ROEFM SRS N ET,

A= a—/8—
AZa—N—2lk TrANoav— Ml FEER Ea—o%
BBy — Vv olddf, REDTET. BLUOANNVTOEREDT 7 v 5
VICHEHT A= —THARSH D £,

Y =)L\ —
V= WN=Z M5 e KT AREERICRIRICY 782 TE £,
CHOOREEICIE. A=a =20 b 778 ATXET, 7Aaro HR
A NS 5 L. AP RSN ET, Y= =Gl
IZ. Konqueror” A 2> 2% V. 54 L7 K RWeb<—Y o — K,
FEA—Ya yERRSNET,

BERITY — LN —
AT —WR—=12lE. 77 ANV AT LT 4 L7 MY ERET7 7400
NDONIMFITRENE T, KoRT7 4 =V RNICATITE. T4 V27 MU D
12% 7 V92 T5ILT, T4L7 N)ANDEIFEODNAE ASJTTEET,
AT = W=D FEMRCH 5. BICHIREDXBHENN—=% 7 1) v 7 L

KDE =.—#J7 A K



T, TONELZHMLET, 7KL 2% ATL 2k, <Enter>F — &3
INATHT OIS 5 [IEL] 7 A 2> %7 ) v 7 LET,

Windowsh XL —F 4 V7Y AT LERLY . LinuxTIE R I A4 T XFIE
FHLERA, WindowsTlE, 7w bE—5 4 A7 KT A4 T%a:\TT7 K
L 2ZF8E L. Windowsy 27 LT —ZFC:\D FIZH 5L, Dk HITi
D ¥4, LinuxTlE, IXRXCDOT77AI)veT 4 L7 bUMNY Y —HRET
MEINET, kEfioFTs L7 MVIE 77 ANV AT LIV — NET
W/ eHEINnE T, oI XToF4 L7 MR, 226778 AT
EE9, KIS, Linx7 7 ANVY AT LANOROEERT 1+ L7 MU ol
WA2 Rl £9,

/home TlE, Y AT L EICT7hH Y > Mo IR TCoa—VFofi A\F—%
PRFFENET, 2oT4 L7 MIICHL 7 7 ANVIE, TORTEE 7213
VAT LEMELNEETCIEEA, L AE SHOETA-LVT 4 U
7RV 20T L7 RMUICHY FT,

FEL Ay PO —VRETOR—LF4 LI MY

o NI =TSR L T aiEGIE. m"—4L7 4 L7 b VJId/home
SWFMEINZZNZ EDRHY ETH, T AN AT LAHNOEDT 4 L7
KDICb<ww BT TEET,

/mediaTld, — RISV AT LDN—=RFT 4 27PN OH DL 5 A4 TD
R4 TWRFSNET, USB7 T v v a RIA T, fmshd

& /media® MICFoRENET, L, TIF NN AFUSBEMHT S
B E 2 IIDVDRCD R 5 A 72 B L 125 & bR T,

fust/share/doc® T2, LinuxY AT LEA VA=)V &Ny r—JIC
HT2H06P5MHO~Y=a7 V%Y 9, manualh 75+ L7 K VI
X, 2OX=ZaT7VoFYa)ab—siiov=a7)l, TLTA A
=L EN/Linux Y AT LDON—=Y g 0D ) —A ) — MDBSEPIN T
¥9. packagesT 4 L7 MUICIE, VI R =7 Ny —=VIlffET L~
Za VIR RSN E T,

/windowsld., ¥ AT L FICMS Windows & Linux Dl /5754 > A k — )L &
NTWABEEICORFIRENTE T, 2 2IiE. MS WindowsD 5 — & 135
@ij‘o

KDEF 27 v 7 DBil:
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Linux7 7 A V¥ AT Lot BLOL ViR T 1+ L7 MU U AR
DUTCUE, JH [Linux Directory Structure] (55153 Working with the Shell,
tDeployment Guide) % ZH{L T 72 &1y,

FEF =g %)l
<FO>F—%ML T, Felr—> a3 o "x N EIERRBLIOARICTEE
T, = g AR, VY —Ea—ToOBRMFEREINET,
Tl = g N RNV ENCHLEE T TRV EZY v 7 LT, o
LEWHEREZRELET, 742 o FicARA o2 2EL &, fijil
RN ENE T, e xlE T AN AT LBV N T AV F
7ZIFAR—LT 4 V7 NUTBBEINSGY Y - L THRRTEET,

RR7 4 —IVER
FoRT7 4 =)V RICE, BIRL72T 4 L7 MU EIET 7 A VONEDFIR
SNET, [ofn] A=a—T, [FAarba—]., [VI)—-bt=—],
F20F GEY A RNER] o2 —TF— RNodihpos iy hnziEil
THEERKRTEES, 77 AN%EI Vv §5E, KonquerorlZ NED
7V51*ﬁ%féh6W\7Y4Wﬁm®@ﬁ%ﬁ57fUﬁﬂyay
ICa—REhET, 77400 LTI ARA 2 2T 5 &,
KonqueroriZid, Fr#H. &R, ZEHfZRE, 77 A VoOFMERO H
LY = Fy INFORENE T,

T ANVBNTIE, WET7 72 AFLIFFRRLLEWS AT LT 7 AL ED
L 7 7 AV ;'EKonqueror IR REnEFE A, LinuxTld, RRL77 A0V
DOHNCIZE Y A R2MTT e ThE T, RBL 7 7 A NV EFRE RITIERR
29 512lE. [K] > [Show Hidden Files] DIFEIZERL £,

141 774D —, BE). /=138

Ty ANVDaAt— M, £REHRBRO LI RT 7Y a v OFRTICIE. T
T VST S T A VLT 7 A ST B RS, T
¥AN=I v ¥ g YOEHEOFMICOWTUL, 143/H 77 2 2FEOLH)
(24 X—=NEBIHL TS0,

T 4 v 7: KonquerorCDA TP 1 b DIER

Konquerorh @7 » A WE/ZIZ T AN TR IV 9w 7T L e, T7ANDEHE
X7 L a—RREN, ZANVTDEEITZDT7 #I)VEDHINET,
MSWindowsD ik D 2 —H — 2 & - Tk, ZOFEIIELb > Tna b L

22 KDE = —# A R



NE¥A, o722 3 L TT 7 AINVEERZT L IEWIGEIE, <Crl>
F—2ML oA TV b ey 7 LET, NDDIZ, KDEZ Y |
H— ) H =TI AKELEZLEL TLZSW( T Peripherals (56 X —
) B,

T ANERIET AN T e a —F23MET 512F,. RoFIEZFETL £
ER

1 ATV 27 v etm527 0927 LT AVTFXFARNAZ 200 [aE—]
FF [OIRY] 28R L9, A7V =27 837 Uy T R— RICHE
HEINET,

2 ATV NEWATL 7 A NVAICHENIL £, BildeT VX %1457
Uy 27 L. [BO1] 23R ET, A7V =7 hlav—, £/203
MisnE7,

KTy 77y RRay T4 &, Konqueror COA TV =7 hDAE—
F 23N EOBREMRIHICTEET, 72 AE RIv 7 T57207T, 1
DO 4 Y RIS D T 4V RIICA TV =7 N RICHIITE £,
ATV N Ry 7958, TOFA TV =20 NeMEIToraE—-925%
MemRdb Ay —INFoREINET,

Ty ANEZT AV EEHIRT 11 ROFIEEZFITLET.

s TV =2V MeEIRL T<DebF— %I, 77 A4 NVEHZ Y v I LT
MWE, AVTFANRAZ2—=06 [TERMANFE]] 2 ERL T, 47
Yl MITHRFEAMEISNWE T, DEREGGIE. T ANVERITT AL
Bz 2o fTd om0, TelclibdszentsEd, HiigaH 134
JH [ZRFOEH] (19 X—).

TVl NEFEITCTEOGEICHIT A1, RE] > [HIFA] %
7 7350, Shift+Delx —%IL £9, avFF AN X=a—I1C [H

FRl 28NS 35508, [FRE] > [Konqueror 78 E] > [E)fF] DIE
W2V 7 LT T ey ZRy 7 22BN £,

1.4.2 TL WD # LS DYFERK

Konqueror CH1 L W7 # )V 7 AT 51213, RO FIEICIENE T,

KDEF 27 v 7 DBil:
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1 BT 74 NVF 0BT+ V2570 v 7 LET,
2 [Create Folder] %R L £9°.

3 [HiLvogas] ZFA47ar <, fiLuerx)VZodHlzE AL T,
[OK] %7V v 27 LUT,

143 7O ERIEDEE

LinuxlZ<¥ NV F 2 —H T A5 D=8, Linux7 7 A IV AT LHDT 7 A )b
lE. ThhZha—YR I NV—T gL ET, A—-N—za2—-FLE0, TXC
Da—PIZiE, SHOKR—LT 4 L7 MUDBHESRTWET, 20574 U
7 R)IE, RRa X b, Ty rv—r, FRITEFA-NVLEDEANT —
ADMREFEENET, F7A4NLERTIE. NS5 DER—LF 4 L7 hUADEX
ART 72 ZIATEEICRESNTOET, 77 AL T 1 L2 Y DR
FHlX TOT 7 ANANDT IR AMREELET LI MW TEET, & XU
FERT =2 DHDLT7 7 A ML T, o2 —Hn 6 ofnAAI) 7 7 2 A
EX L2 DECISD T 2 =12k B 7 7 A IV DAY . FHEIA
HFELTRTEIT]TLZEMTEET,

WEREBY, LinxY AT LD T 7 ANA TS 22 K213y A=y
YA VAERSNET. 203ty Mo HAINY @), HXARW). KT
DENR=I v aryBhy,. ThTABMEHD 2 —Y(7 7 A VATHE.
UV—F . Zofina—)Z LIcEESNET, LinxofEZico 0T,

[TH TUsers and Access Permissions] (5 155 Working with the Shell, 1 Deployment
Guide)] #BHL TS, Y2V CT 7 v AERELHT 20K kD
7 012, KonquerorME(E T 2GUIZFIHT A2 e b T %9, 1)

7 7 A INVONERZ ZRET 5121E. Konqueror CLL F oA 7 g > &2 %R L TXL
ZEW,

Forbidden
Ty AN AT LRHDT 7 A NVEIFHERTEE TN, 77 A IV EFHCTain
AINDH Z LT TEFEHA,

Can Read
Ty ANEHOWTBIHTEETN, EEHTLZLIEITEIEEA,

KDE =.—#J7 A K



Can Read & Write
Ty ANEHOCTCEHRANS 2D, BHLZ)TEET,

KonquerorZ ffiffl L CT7 AV FDN—3 v ¥ a Y EFET HHGIE. (Rod 7
YarEifTEEd,

Forbidden

TP AN AT LD T )T LITHERTEETN, 74NV F 2L Z &
TEFHA,

Can View Content
TANTDONEEFRRTEET,

Can View & Modify Content

TANTONEREFRR LT, ZOTFIVEHICH LT 7 A ILoH T
TANTEFRTCEET,

TIVAN=I v aryeXETLHIE ROFMHEICENET,

1 KonquerorZ L)L T, 727 ¥ ANR=I v v a VEEETL T 7 AL
THNVE LR T,

2 Iy ANELZ Yy L, [TanNT ] ZERLET, Ly A7
B E LT

3 [Permissions] % 7% 7 Vw7 LET, ZTOTEINE. 77 AV F T
W37 A NVF OFTG BRI FORSNhE T, ¥ 7o FERiciE, BliEo 7 7
Y ANR—I v g rBRoREanEd,

4 [Owner] . [Group] . BXT [Others] V ARNE, 77 A N7 7
WHICRET L7 72 AN=I v v g v EIERL T,

5 [OK] %7 Vv 2 LT, EENEZHEHL T,

Konqueror Cld, 77 A WY AT LA TV =7 MIFT HERDT 72 A8~
Sy ¥ arolEN. ACL(7 7 AHIHIY A MEMH T2 bTEET,
ACLZ UL, ko =3 v ¥ a e TiFen Tzl o s—3y
VarvEFTIERTEET, £ A=y v a VATLOTHEECHE
DFFfE 7 NV — ATHEL TR WGE Tl ¢ 02—V E /i3 7V — T2 %
ILTN= v arEEDLTLZ e TEET, ACLOG L, H13%E
Access Control Lists in Linux (tDeployment Guide) % Z L T 728 Wy,

KDEF 27 v 7 DBil:
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HEOZ—Y LTI TN =TI, T7ANRT A NVEIHT L7 78 A/ —
Ry varEH5ZLI1IF DToFEICHES> TLEE 0,

1 KonquerorZ fCEfiL C., 727 ¥ AN—=I v a v EEHTLT 7 A LR
T ANV EIERL £7,

2 HNoT7 v ANV [Fanxsr] ¥4 7alZxdx.  [Permissions] %
TRV LET,

3  [Advanced Permissions] %7 ) v 7 LE£T, ¥A 7Ry 7 A2, F
TV =2l NOBEFEOT7 72 A= vy g oM RrENET,

~Access

Special
SetUuiD
Set GID
Sticky

Type Name r w x Effective || Add Enty..

Owner vvY o w
& Owning Group vy -
- Others H v - Delete Entry
O
[ ok ] [ gares

4 [ Vo] #7270y 27 LET,

5 77 ANRTANAICTZEAIN—-I v gy 2HEOZ—WFITH 25
WCUE. [BHIfTE2—] 23R T, U A N»S HINO 2 —5 23541
L£7.

T ANRT A NFICT I ANR—2 v g v RFEDI IV —TICH 2
L% [ZAIME 20— 7] Z2%ERL T, VA NPSHKNO I V—T
ZEIRL £,

6 [Advanced Permissions] %A 727 C., iBML a2 —H 7 ) — THH
FEDONR=I v a DU ARNIFREINET, 77 AN T 4 IVFITH
L G0 . FEIAR, FRFFEITHERDN G A 6N T A5G, Th
Zho[r] . [wl. 723 L] SRR oF =y 7w — RSN E
ERS

26 KDE = —# A R



SetUD
SetGID
Sticky

Type Name r w x Effective Add Entry.
Owner %% w

& Owning Group vV - ELENT

& Others %4 -

/1 Mask V¥ ¥ wx

£ Named User (18 VW W wx

Delete Entry

7 2—Yo [r]. [w]. £F x] WoF=vr=—0%71) v I L
T, Z0a2—YO7 I 2 AEREELET LN TEET,

8 VI RAMERENTEL Kb >726, [OK] 27 Vv 7 LTHA 70l

ZHCET,
9 LHEHNEZWMHL T [Properties] 7 A 707 %BL5I121%  [OK] %
70w 7 LET,

1.4.4 7 7 4 ILOBEESITOEE

Konqueror Cl, 7 7 A WEBK DI T L2 ERH L7 TV r— a %
ERTE £,

KDEF 27 v 7 DBil:
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Previews & Meta-Data
. g Description
{[PNG Image | ‘
File Associations
Web Behavior
Java & JavaScript

AdBlocK Filters

X 1.12 Konqueror TD 7 7 A )L D BIH#( 1] DE

@ [a| Configure file associations

i Find filename pattern: General | Embedding

Known Types |

sopuarmes | [T = I
;
9 — | |2 || |-

Filename Patterns

-;c- ~Application Preference Order

o

7

B Y[ [meroe ]

1 Konqueror ¢, [E] > [Konqueror%#ikE] > [ 7 7 1 /LBl

1] #7)y 7 LET,

TR T2 MET H120F, kT2 [77 ANy — 2 23] \ICATIL
FT, MERICNT ATy ANNRE — 2 BTy AT A TIET
MU ZAMIFORENET, e RE 77U r—vari g7 7 A
IVCEET BTV, pngk [ 77 ANNE =2 5] ICATILET,

[ % 7] VARNT, Z79ANIA T2V 7 LT DT 7
ANI AL TIZOWTDOHREFA T ST, 742>, 77 AL
YN =2 W, BT T =Y g EE L EETE £,

Y= )UISY A NIRWIEE. [T U= g > oEEV] o [iE
ml 22w 2L TCFOY—)voa<y REALET.

J2ZMZ Y N DIESEZEET 2120, BT 750271 97
L. [ LICHE] £720% [NICFE] 2270 v 7 L TR EWEREE
FIHCNEREAE VY TET, XA TOT7ANEI) v 7T 5
. VAN EBHCHET TV = a vy T 7 NS E
7.

KDE =.—#J7 A K



4 [fHios 4 7] URARNIBRNT v AT A THPFERIGEE.  [18
] #2092 358, FV—TRERL YA TLEANTLHZ0D
A TAT Ry 7 ANFREINET, FNV—T&k>T =T 14,
A A=Y THFAN, ETAREDAAL VA THREY 3, HEFE
E 77 ANVZA TN ONTINEH DY TLZ M TEET,

da [OK] %7V w7 L7=6. Z7ANVOIEETEREL T,

4b T X AT 4 — )V RIZEIFE AL, T 7 7V r—vave
TEEL £,

5 [OK] #27 Vv 27 LE7,

145 Ea—070O7 74 IVDRTE

[FKR] A=a—oitk [Ba2—F—F] Z#ERL T NHEDOT7 4NV
D a—% —IICEETEET, EENETEZ TN TOT 4V HFICHEHT S
BEld, Ba—7a 7 s A IVIGKENTEZRFLET., RENBTLZRFT S
IZiE, Hilob 2 —ICEE L RIS, [RE] > [Ea—oTarryr iz
PRE] OIFERL £9, Kic, RETL7a 77 A V%% ATIL,  [IREE]
#2927 LET, IRTCOT7A VAL T, Ba—oZLEINHA S E
T, REERE. o7y A NVIRESNET, ZoTa Ty AV,
[BE] > [Ea—D 77y A NEiAiAHR] OIRIERL T, WO TY
11— RT&E£7. KonquerorlllET 7 4 )V M T, SEIEFRFEEHE2— 71
Ty AN OPHESINTWET, choo7ary f)viE, =— X
L CEET LI TXFET,

1.4.6 KonquerorCT A IVAASICTIE
A9 B

KonquerorZ L T, TV X NARAFICE TV RVATEET, BEVLDOA R
FRUSBAR— MIEL £T. W ATTAALBTAY by IR ShE
I, Zo7A A )y b E, AT Konqueror CRIE £9, AT
121, Konqueror CURL(camera:/)Z A/JLCO 77 ATEET, HRXT
DT 4 V7 NUENZHEIL T fHO7 7 A NV efRoRxL £, WED

KDEF 27 v 7 DBil:
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camera:/

30

Konqueror 7 7 A WEHKERERZ L T, 2heo 7y A NV EREIEETa
E‘r‘ L/iba‘o

1.4.7 Konqueror CE{§%& &R RT %

Konquerorid, f A=Y bEa—7e L fHTL2ZbTEET, T4 L7 b
JHICEEN TN TR TOMGOME LRI RT HICE, T4 V27 b
JEERL, Y= N—=D [ X =P 2—F] 7Aar270)y 7 LET,
LR ANDPERSH, 70 v RuoEicRRENET, WIhdrod L
FANET ) 7T DHE T v RIOHBANSZ DG T VY A X THRR
SNET, OV I N=TUE AR B{EO X —L00lE AT A R
Ya—ERHAO T A arbEENTHET, BEOIRIYVEZ 51218,
V== [Ffa>taz—] $lF [Y)—-bta2—] 27Uy 7 LET,
N

Z OFSREDIFMNIC, HE 2 T IUALEATRRT 54 A =TI F» T U BAEK
TE %9, Konqueror CA A=Y 7 4 L7 MU ZRHE, [>—J] > [Create
Image Gallery] DIFICEIRL £9, ¥4 7 s, s iysf. X—
VA M. X T ORGSR EORERRETCEET, [OK]%E7 ) v
JLTC 77 arvkEBBLEY, 774V F T index.html& ) 7y
ANDMERENE T, ZD7 7 A )V %Konqueror 27 Vv 7925 &, HI{EAVI
SLBHINTHRRENE T, WIhbol{EE2 Yy 735, TLPA
ACHRRCEET,

KDE =.—#J7 A K



X1 1.13 Konqueror T4 X —2F+ 7 1 Z(EKT 5

Page Look
Page title:
Look

[Image Gallery for fhomestux/ ]
} Images per row:

[~]

Folders | —— 9 .

b
E [%| Show image file name [ | Show image file size

Thumbnails | oy, image dimensions

Font name: [Sans Sernf

Font size:

Foreground color:

1.

Background color:

[=‘- Create HX Cancel

GwenviewZ ([fiH L T, B2 FRT 52 &b TEFET, Gwenview# iLff 7 5
12l At+R2F— %2 L CgwenviewZ AJJL £, Gwenview D :EHHIC D
TiE GwenviewDF > T A4 NIV T e BIHL TS0,

FIOANHATPSHEEHEEZY Y oa— K, fwed si121d. 5195 7~ 220
Rz L 2> g > DEF (279 X—) THHIN TS k9 ICDigiKam% {ff
ﬁﬁ‘(v%ij‘o

15 2y bD—O VY —ANDT7 It
A

TAT Ny TIMe, Z7A4N0T 4 L7 M), BEOVE—FKRAN Lo
EOYV—E 2772 ALEY, BADTZ 7 ANVRT 4 L7 M) &Ry hTU—
J oo 2 —YICHH S5 Z AT E $£9, SUSE Linux Enterprisel 2 13,
Iy hT—=HEFY =217 7 ALY, UV —2AEERT B0 0,
SFEIFERFEMHESNTHET, ZHHo Xy hT— 27 G B o

KDEF 2 7 kv 7 DRith
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AVEL =Y ORERICL T, *y bT—=2 LOHFY Y =200 - 2%
Konqueror® 7 7 A )V~ 32—V ¥ Z i L TRIHICSIHTE £,

ZTDEDIE, TAIV Ny T [fy NT=IZI] 7A A%V 7T
57, F7zlTKonqueror &L L T, #HATY — b —ICremote: /& AJJL &
T, T4 R INIT I RATEDL Sy N =7 v =7 OFHNTRORENET,
Fy NT—=2 U —=2ADffZ 7 )y 7L, 778ATLH%y hU—73HHp
2V LET, 2P L N2AT—-RKEASILTY Y — ANDHEREN
ROSNLGERH £7,

X1 1.14 Windows Networkd 7 — 2 7 )b — =

Locatien Edit View Go Bookmarks Tools Seftngs Window Help

,0.00/0 NN ko]
E# Location: It_fremote:f |'] o
#yHome Folder
@ 117 [ ]
© " &bin - b
ADesktop — s
;‘_r —_
gsccumems SLP Services ~ SMB Shares tux Zeroconf
un Services

@ [Epublic_html

] 5

s \

[=]

w

u Add a

E Network Folder

M

©

=

@5 Items - One File (0 B Total) - 4 Folders

POV, TR %y hU—2 Y —=ZAD T 7 X (173 X—))
ZBIL TS0,

16 AVEa—3FLET7A4ILIR
FLADT—48 DRE
KDETCIE, A bEa—2FRE 77 ANV AT LTOT — 2 MEHICEHE D

TV =y aryMEEE T E T, KeryZ AL T, AABRORE
FTGEENIAR— L7 406, R¥axy b, BT A=), Web/@hf, IMITC

KDE =.—#J7 A K



el VY —2a— R, W{§, SEIrAN, TIUIr—v gyl &
FANEREMEICMERTEE T, FHMcO VUL, P Kerry (- o185
(201 R—=)ZBIHL T2 Sy,

KFindClE, 77 A VONE., B, s, 2377 A0 A4 X0y, &
FIFMESFMEGHAL AL Ea— 2R T v AN AT LNDT 7 A )L
EMFETEET, AA A== [PTUr—2g>] > [y 11/
T AN EZDRFE] IR GEENL £9°, £7/20135, Alt+F2% — 23 L Tkfind
EATILET,

B 1.15 KFind%{#> /=7 » £ L DIE

Mame/Location

Named: I']

Look in [iile:.f.f.fhomeﬂux |v][ Browsa ] I sawess.

@ Include subfolders

[ ] Case snsitive ssarch

Name | In Subfolder |Size | Modified Permissions | First Maiching Li

[FSkusmakeddoc pdf SUSEDOCimavdo/... 145031 0120061443 Read-wrie

[Fsvndoc. paf SUSEDOC/novdoc!... 245 114 012006 14:43  Read-write
Ready 2 files found ] Help

1.6.1 7 7 A ILDIRER

NEDT 7 A INVEDOMEZFITT HI2lE, ROFEICHEGNET,
1 A RA=a—FFa<s >y R4 on6, KRind%ildiL £9,
2 [BEVEAT] % TR 270 927 LT, ERNMELZTRITLET,

3 [HZHI] TMFHTDHLT7 7 ANVOELAIZRELET, ROLI%T AR
N—REfHTEET,

TAEVYV AT
TAZ VAT L, 02 ZL0L ORI TS LFERLET,
7z & ZE. marc* DM TIE. marc. marcpng, B LT
marc_must_not_read_this.kwd® 7 7 4 V& MZETE £, mar* kwdD

KDEF 2 7 kv 7 DRith
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M ClE. marketplace.kwd¥ & O'marc_must not_read_this.kwd?/)’SR55
‘(“ % i vg‘o

FERITY
BEMIFTONE, 1XFERLET, & AL mar?OMEE Tl marc
IIMEETEE TN, marc?DMZTIE, marck & Omarcpngs ™5
BHID 7 7 A VI TS £ A, MEFTEHICIE, GET L7200
OG22 ANDLZ EMTEET, TOROLFEPIMZEINE
ER

MEFIEH T, 220040V Kh— Rid5&2illagb¥s o enTcE s
7,

4 [MRFHPH] THMZT L7 NI RIFET L. [ZH] #7V v 2L
THRETLTANVEEIRLET, [T 73N 72 50] 2%EIRT 5
S AEELE T AN ISR EAR Y T I AN T TR CeMETLHI LY
TEET,

5 <Enter>F% — %I [MFE] 22w LET,

1.6.2 SEET 7 4 IVIRER DFEIT

HHMETRICOWTE, 77 ANICEENTH DL EDOH LT F A MY, &
SICEEMZeA Ty a v RIEET L2 M TEET,

1 A A=Za—=n6, FRFa<x s R4 o5, KEndZieE# L 9.

2 [BRVGAT] 5 7% 2 ) v 7 LET,

3 [HZHI] TMERTL 77 AIVOLAIEIEEL £7,
4 [IeEHIH] THMZEEREITT LT A INARIRET AN, [BHH] kY

Vo Z LTI ANVTEIRLET,
[NE] 2 T7%2 )97 LET,

w1

6 [7rANEAT] T METLTI7rANDI A TEIFEL £7.,

KDE =.—#J7 A K



7 [EFNE7FZAR] IS, METDLDIT7ANMCEENTHELEDOH D
HiEF -3 7L — X% AL FT.,

8 SOIEFHAA T Y a v BIFELEWGIE. [TanNs ] ¥ Tk
Do 27 LT fFELIEOA Ty a v 2@RLEY, A 7Y a v Fid
T4 —=IVRD IS D AR, 22 2 MENT 5 & BEZSIORES N
ESCIR

9 [MF] &7 Vvl LT MEREFEITLET,

o] gEZe Mz 7 3 v OFFINEHIC WL, KFindAd > o4 o~V T %
ZHL TL &0,

SIS MEI IR, MSEANY — TR AT 222 b T £,
KRegExpEditor Cld, 1FFRBUCIEDWMZA 7o g VMEf s E 7,
KRegExpEditor% YaST% ffi [ L T, /v /r—Ykdeutils3-extra& L TA ~
ARN—=VTEET, MENAY = BLOTAIN R — ROIERFKBOFMIC
DWW, JH [Getting Started with the Bash Shell] (5155 Working with the
Shell, 1 Deployment Guide) % ZIH L T 72 &y,

1.7 775 —2a VEDTHEAMD
Y2l

FHXARNEZ Yy TR—=RlZab— L THMMHAT LICE, fERDOMS Windows

—FHEMNCY a— My REF—Ctrl+CF—&Ctrl+VExF — 2L L
iﬁo:mmlmmfbﬁﬁ@%é%%bi?okﬁulmuﬁuégnﬁ

TX¥ANaE—, ATLZHEOHESNTWET, sFANEaLE—
?é . HNOFTHF A M2~ ZTEIRLTHSH. 207 3 2 hofifi Aty
FIETCYT AN =Y NVEMRENILET, T ADORRY %27y 7 LT, T
FANEBIFAL £ETQORY O~ 2 TlE, WO~ ZARE v %[RRI
L E9),

WL OPDOT TV —2arTld, TXANEHFAT LY I U r—2 a7
TXARNPTTITEIRSN TV EEIE. 7Yy TR=RIZHLT T AN
mwﬁﬁéhtfﬁxbfﬁé%éhfbiﬁwf\:@E%@ﬁ%f%i
YA, 2OEIRYEE, KDEV 7V 7 —3 3 > OKlipper 3k ir b £7°,
Klipperid, 7V v 7iR— RICHEIL 7otk U % T50E) LET,
KlipperlZ. 77 # /)L h Tld, KDEX I — R& /& JISREIL, Spxuicy

KDEF 27 v 7 DBil:
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Jy TR—=Ro7A4are L HRKRRENET, 7y TR—-RFRONFE KR
T LICUE. Klipper7 A 2> %27 Vw7 LET, IHroTy hUBN—& Eick
REN, HOF = /=0 THUNTH L Z AVRENET, Klipperil k&
TR ANEIE-LEEEE. TXRANORYOITIENTRORENET,

T X 2 N ZKlipper» 67 T U r—v g lab—95i1llE aE—795%
TXANEI Uy 7 LTHERL, xUARS v E a—Seo7 7)) r—3 g
VICHENL Tt~ 2R S &7 1) v 7 L7, Klipper®Efflico
WL, Klipperd A > T A4 NIV T BIHL TL S0,

1.8 41 58—y PDER

KDETl&, 77 # )V k ®Web7 = 7 13Konqueror €9, Konqueror# it 4 2
IZE, NIV TCKonqueror 7 A A2 % 7 U 7§50, At+RIF—%ZifL T
konqueror & AJJL £9 . Web7Z 4 & L TDKonquerorlZ DWW Tk,  [E
1435 Konqueror z (¥ - /= 7' 7 X'(227 X— )] HBIHL TL 7280,

KonquerorlZ /1A C. MozillarX— A D 7 Z 74 Firefox b[THTEE9, A A
¥ A= a =M B Firefox & fE) T 570, Alt+ 23— %L Tfirefox& AJJL
£, WOWebT T TFLEL L D1, EICd DY — A —127 B LA
AT LD X=TIlHDHY /9%7 Uy 7 LT, PloX—I /-l © s
F 9, Firefox® il _Ob\'( X, BB15% Firefox Z L /=75 ?//?
(237 XR—=NEBHL TL7EE W,

1.9 E-Mail (BEFA—INERT YV a—
IVERE

KMailllZET A =)V 7 54 7 > KT, POP3RIMAPR EDE A —)L7a ka
NWaEHFR-BFLTWET, £, BROBEFA—INVT AT Y OV R— K,
Wh1172 7 4 W&, PGPIGUPGT A Ny —, BLUOF Y IA L ORTT7 7 A4
IVOKEEENSH D FT, AA v A= 2 —5KMailk il T 57, Alt+F23% —
L Ckmail & ASJL £ 7,

Kontactld, KMail, KOrganizer, 5 J U’KAddressBook72 & L fI6N5 7T 7
Vr—var&loof 27 =—AHa Lk, f{AEREHEEPM)Y b
TY., ZHUCKD, WA, ALy F— 7 RUVRIR ZOfioPIMELHE

KDE =.—#J7 A K



ICRHHIC 7 72 A TE 9, KontactZCE 9 51218, Alt+F2% —%f L.
kontact & ASJL £9. KontactdJiFH D FAHIC DWW TClE. 42 Kontact: 351
X= L >F D) 7113 N—=)EBIHL T2 &0,

1.10 OpenOffice.orgCHD RKF a1 XA b
DA —F 2V F ol IERK

* 7 4+ AAA — FOpenOffice.org Tld, "— K7ty ¥, KitHV 7~ 7
VB T —Yar, X7 2, BEOT—FX=20a viR—1 2 Mg
fEEx ¥ 9., OpenOffice.orgld H DA XLV —F 4 VIV AT L THHTE S
e, AVEa—FT 4 VI TSy v —LMT, BT EHTEE
I, F/o. LETHNIE Microsoft OfficelSINT 7 7 A W ZBIWTHREL. =
DIZAICR L TRIFT L2 b TEET,

OpenOffice.org Z fCET 5 121%, Alt+FR2&F—ZL T, 0oo& AJJT 50, 7
ANy T T [ AT74A] 7A4ar%22 V92 LET,

OpenOffice.org D iFAllE. 3% OpenOffice.orgd 7 + A Z A — | (77 X—7)
¥ 72130penOffice.org 71 7T LDV T e BHAL TL 72 &0,

1.11 KWallet¥v ~r—> ¥ IC K B /8 R
ol N

RSNV V=2l A T LB ERNAT — RE2TXCEHIET S
DIFREETT, KWallet?32—HIfb > TNA T — RZEEL £7°, KWallet

i?«fwhxv REED TSNz T7 v A NVITRFELE T, 10D~

AHNAT — R ASJTH720T, U4y hE2BWT, T2 MU DOFRIR,

Mz, HIRR, ERZITD) 2 eMTEET, lmHIE. =2 M) 2 FHEITHAT

éﬁ%i%@iﬁk KDEIC & - TV VY — ZIEREEAE N & D DT &
L RIS EICKWallet S H B ISCE S v E T,

KDEF 27 v 7 DBil:
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EFEEIFHH: KWallet/S2 7 — R D{RE

KWallet/ 27— REZENTL - 5513 BETEERA. TONZT—
REfl>Thbitho2—9E 4Ly NHOTRTOMNREINGTET
LEWVET,

1.11.1 KWalletDiE)

KWalletZ ] CEEENT 5 L (72 & 21, a2l A VHANRAY — K& AT 505
D& BHWebY A NMIT 7 VAT LHEGERE), L5 2 ZHEMNFRINET,
[FARZE] S e [EERRE] Db PSR £7, [HARE]
ZIEIRL 7285 80, SRR SN L ME T, HAERERFET L9050 %
iR L £9°. Konqueror°KMailZs & D —EDKDEY 7' V) r — 3 > Tld, 7 r
Ly Y257 L% L TWeb 7 # — LT — ¥ XCookie® fRIEFCX £9. 1%
T LA, KWalletZ{F 9 572012 [idv>, KDE7 4 L v N Z [/ L T
MNEREZRFLET, ] 2EIRL o, [Z7] 27Vv 7L %7,

[EERFE] 2R LT, (X250 LV] B REN
F9, BEIFT 7 AN BORETHATTN, EENVEICRLIZELHY
£, [7A FREEDwallet 2 HEIICFH U 5] %8R T 56 &, —ERFRH
Manznworby NIECONET, ry hT—=IX2AT—-RKeua—h)v
WAT = REP e IRIFT DG, [fy U= NZXT—RNea—
INR 17— RNZ&fllDwallet 7 7 1 IVICIRIFS &) 2RI L 9. [Finish (5
Nl =#72V927L%7,

NEI)VDOKWallet 7 A 22 %527V 2 LT [Tg Ly h#FE] #8RT 25
EL WO THYHELELEETEET, ¥4 7T Ry 7 ANFTRENT, 1L
OWDF T a v EEIRTEET, TT7AINBNTIE. TXRTHONRAT — KA
DD 4 Uy b, kdewallet, (TR SN ETA, FrL v+ Ly MEIBINT
LHZEHLTEET, FEMNT T TLHE. KWalleth SN2 JLIcFER~ENE T,

1.11.2 KWalletv 2 —> +

TA Ly MIT = ERML 20 NEEFRORLZD T 5121F, 7SRV OKWallet
TAAYEIYy 7 LET, A7 TRy 7 ANFTREINT, VAT LT
TR Aa[gE T A Ly FRORENET, UaLbw bEZ Yy I LTHE
$9, N2AT—=RDASZRDDL T 4 ROBFRENET,
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a7 A NIINT 5L, KWallet< % —Y v 7 1 » ROUBFRENET, 2h
L. 32DEMIAPNTHET, FERCEME,. G RhcEy 7740y,
T 74 VvF oMY AN, ZLTH NSEERLEZZ Y FYORE
MEREINET,

KWallet< % — ¥ % CTld. KWalletO < ZZ N2 T—Ri3. [Zr7A0] > [N
27— REE] 2{FHL TCWOTCHEETCEET,

X 1.16 KWallet~ ¢ —> v ¢ > RN

Eile Edit Settings Help

B search 2 Passwords (1)

Folders Passwor d: mail

[E@Form Data (0) Hide Contents
© [EAPasswords (1)
Binary Data

TANEDIBMEINIHENTEE T, 74 NVF e ERTLHE, 74V F T
YRMUDYANBIOMERTBEH SNET, 74072 MY Z2iERT
e, TURNUVDOHEDNRA UDEFTSN, TOZY N EHEETES L9
WSROV FET, Tl TANFTOHNRICONTDALYT X AN A= 2 — %]
L. T MYEERLIZOHIRLIZD TH6Z2 2 TEET,

LWy MY ZEAT AT, RoFHEICHENET,
FIE1.3 ALy MH LT N EHFATD

1 74 R0 EENT, = M) RIBNTA59 774 V7 28R £
7,

NS, BT 74 NVHIET A2 MU AR RENE T,
Loz bV % [Maps] F7-1% [Passwords] \ZIEMITCEEd, F—
CEDOXRTH LGEE. [Maps] AL 9, X207 — KN,
HMOZ N2 EZ0HLI LI TEET,

2 TLnww2aT— K289 51ci%.  [Passwords] =2 N ZH7 U v
7L, AVFXARNAZ 2 =06 [FH] 28R £7,
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3Ly MY ERIZEATIL, [OK] #27 Vv 27 LET., ZRhT,
LW RUMT AN T MY D FICFRRENDE LD T,

4 oMLY MY EHANCFORT SIS, =N E 2Dy 27 LET
HIDE, ZDT7 ANV HFIFZETT),

5 [ShowContents] %7 V) v 7 LT, FrLWWRZAT—R%E AT 520D
AJI7 4 = )VRZBEET,

6 N2 — K& ATJLT, [RiF] #27 Vv 27 LT, KWalletl, i#R
L7z T T 4NN HNICNAZAT— RERFLET.

1113 Dx by bZRODaAVE1L—F(CO
E—9%

2L DG, KWalletl I A ) VICHEE L, LEICIEC CTHEIRNSHACR Y £
I, L. Uaby by ANENOa L Ea—F(Ty T by TR E)a
E#T%iToﬁﬁVvF%V%*V&W4VF7@%774»75@$W4
YRTICRT I TLHETTT, 2k, JoORIRICERET 5720
L r Ly hE2EHICNy r =Y TCE 7, 72 & \ﬁLWWﬁV/
N2 L—=NTNTTy s aRXAEYTFNANAL AR LEZDaE—- L2075
CEYHLTCEET, EEAANART - RIFIZ 2SN b 07T, Yotz
DNWNAT— REMHTLZEMTEET,

112 7—HhA TDOFRR. R, LV
YERK

N—=RF 4 27 DERBEHAT LT, BT 7o Lz2fHL T v AL
T4V NI EEMEL, 2ROV A oL ET, 77U r—v g
VAR, ZOEI BT —NA TOEHIEHTEEY, 27TV - g
. zip. tar.gz. tar.bz2. lha. rar’& &0 — &2V KR — b
LChET,

AklE, A AZa—06, FllFav RI4 2 Tavy Rarkz AJJL
TEEIL 9, T CICHMET 7 A VBFEET 5155, Bl 7-Konqueror™ 1 >
KoM BAkY 4 > R %hb@7?4w%%ﬁbf7 A T DONE%E K

KDE =.—#J7 A K



~L F9., Konqueror C7 —HA TORET L Ea—%FrT HICIE Konqueror
TT7—hAT%EG2 V2L, [Frba—] e [7—hAN] ZERL
£9. ZONbVICAKT [Z7 o] > [HS] ZRL T 77 AV EkE
R 2 b TEE T,

K117 Ark: 7 7 AT =G4 TDTLE=2—
File Edit Action Settings Help
PR R R a)

E» Search:

Filename | Permissions | Owner | Group Size | Timestamp Link

mytest.html -rW-r--r-- tux users 148 2005-02-24 10:36
i -rw-r--r-- tux users 2 2005-02-24 10:35

0 files selected 2 files 150 B

W TZABWET —h A 712, SESER v sy a v 2R KT eEET, [
sraz] W [ZrangiEm] . [T sziEn] . (IR . [
[z [ﬁﬂ] [TV r—2a>TmE] . BLXO [77 ) r—235>
TR ] e DF T arhidb 7,

LT =N A TEAERT DL [ZrAu] . > [FH] 28R £7.,
FoRENAALATar I Ly —hA TGz AfjL. [Z71 4] T
FEREZEIRL £9, [RE] #2270 v 7350, Enterzif L TIERR & hfid 9
e, BOT 4 Y RUNKREINET, 20T 1 Y RII, 77 A0~ % —
VI¥YME Ty ANRT A VI M) ERT IRy JTEET, ®BE
12, AkIC L 5T, ERLA7— A TR TIRToT7 7 A VT 1 L7 b
UMD SNE T, AkOFEMICOWTIE. [~ T] > [ArkN> K7y 2]
R L TLE &0,

113 RO Y= 3y baigbd

KSnapshotZ ({9 2% &, WA c 07 TV r— a4 RODAF Yy
TVay NERFTEET, A v AZa—2oTar I Lk BT 50,
Alt+F2F% —Z L Tksnapshot & AJJL T, Zo7a I h%i#L £7,
KSnapshot® % A 7 2 7121%, 22083050 £, LI (Bt AF v 7
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Yay M OICWEHEEOEBEO S LEa—, BEOAZ Y —vy gy &E
& RFT2720D3D20R7 UHoRENET, FEhiciE. 22U —rvay
N DEBOVERICOWTDE S5 T arH ) £,

[X11.18 KSnapshot

EJ[ New Snapshot

Capture mode: |§Fu|l Screen |'l
Snapshot delay: E
& s~

AP ) —=ray NelRbIE, [FHAFy 72y b 22Uy 7L T
IOERBRICAZ ) =y ay NeERT2ETCoRfZ [XF v 7> gv b
DVEHE] WP CREL T, [—V I Toryr > Ro] BWEMRIEE.
RAVENHDL T4V RIS NhET, 22V —-2v gy bEREFE
THICE. [RFyTay N2RF] 22y 7 LT Loy A 7a s
WCHLHFHEIZCOWTCDTF 4 LI M) Ty A NEEIFELET, [XFv T
Savyv hEH] 220y 2L T A2 —ray hEHRIL £,

72, GIMPRIHL T, 27 VU= ay h2iRH5Z2EHLTEET, GIMP
ZRHICIE, A+ REF—ZHL THhHgimpé AJJL £9, GIMP% ¥]9 Tt
o8, R—LF4 L2 MVIZHLOL DD T 7 A IVISA VA =)L &
N, TO7 7 ANVERIRICHEHT 22 s 0CcE 84 7ariforangd,
GIMPO I DWW, #5185 Manipulating Graphics with The GIMP (261 <X —
NETAIANNTEBIHL TLZE 0, YaSTEZ i TANVTEH A VA K=V T
LN S LG H Y £ (kdeutils3-extra),
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1.14 KPDFIC L APDF7 7 1 VDR

BZHLPDRE. EELRRXF 2 A M7 7 A VERDIDTL & 5. KPDFIL.
PDF” 7 A )V D5or & HIlil 2 n] BEIC T HAKDEV/ 11 75 N CT,

KPDFZCE) T 5 121%, Alt+FR2F — 2L Ckpat & ASJL 9., [Z7 A0 ]
> [F<] #¥RLCPDF7 7 A V%1 — KL £3., PDF7 7 A JL7’SKPDFD
AL T4 Y RCKRRENET, 2o v N EHAIE. SLx AL
MEREINDLT A KN= HRE2=BHV ET, VLAx AN TX=T DM
FERAUETEX T, HAE2—IE T v Z~—20H0Y., 2hez sy L
TRFa X MAEZHEITEE T, HAE 2 —NZEDE L. ZDPDFTIE
Ty <= B R—- kSN TRz e rE %Li?

AL T4 Y RN =V e FRoRT HI12lE. [#x] > [Two Pages (2N —
D) BERLET. [KR] A=a—CRIOERL/220F Ty g vicdk -
TAZ 2 —REMELRY £7,

W = VN — DR — VR L CHIR AR 2 e b e 9, UATE
i, Ry 77y T A=a—TC, TOHEIBEZT AN & L GEIRT 200,
FRFTI T4 v 2 LU CGERT AN Z2IFELEY, HIBIZZ Y v TR— K
ICab—3nFET., 79 AMHEETLZ L TXFET,

1.15 KMix%Z # > 7= > K D&l

mﬂu‘Bﬁw@:yan~9u%éﬁﬁyFﬁ~F%E%WK@&%;@
RELFET., £7-. YaSTD [Hardware] £ =2 — )V ZiciL T, FEETY
7/%% REHRETHZ L TEET, VI N h—REHELZERIT
ISXY -2 TH I RORY) 2 — LR T U AL TEET,

F4 v T X H—DRHE

TX7F/7®A$w IXFY—TA A (AE— il BRI ey

Eld. Alt+FR2% — %Tqﬂbfﬁ‘b kmix% ATJT L. AL A==2—»
%i#%*%ﬁﬁbi?oﬁ%i$%~@\[ﬁUJ—AﬂyﬁB*w]
DOPMIHY £,

TIZHNITIE, VAT ALMVAICHIRMIXT A A2 27 )y 2§58, <
2z ayba—IfoRENET. 226, DEINERY 2 —L% EFT-

KDET 27 b v 7 DBl 43



44

D, TV TEFET, Y70 RK&EIa2—bT5120%, FREDLEDEZ VY v
7L TCL7EEn, S a—MLES, LEDIFEL 2D ¥9, 95 —FLED%
7w 2358, Ia—BRENET, BTy xVoY Ty RREER
M <HIHT BIclE, KMix7A 2> 252U v 2 LT, [ShowMixer Window ]
PEIRLET, XA 20 Vv RUTIE [Output] (H117). [Input] (A7),
B L [Switches] (Z A v F)eHETEET, RET LT /A AL, TN
A2AT7AL A EHI2 ) v 7 LTERRENLEZTNTNDA L THFANRA= 2 —
MHYET, EFA AL, @IS 2 — FEREFRET I TEET, KMix
DFFCONTUE, Ao FA IV TEBIHL TS0,

X119 KMix3 F49—

File Settings Help

Input | Switches

L
', O

#
&

~

|IEC958 Playback AC!

Master
Master Mono
PCM

Intel 82801DB-1CH4

1.16 ZENY — )V sy b=
=1F

ZENY —)Vl%, ZENworks Management Daemon (zmd)?® 75 7 ¢ Jj)V7x 71 v

RV RELToEEZRIZL, VI T=27DA A N—)VHIER ZXa
U547y 77— Mo, y—vx/hyaroEi L o gL EICAT
AFET,
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1.16.1 /N—3 v 3 VOEE

Linux> A7 LT/ 7 —= VR EIT 51218, rootffRAMAETY, ZENY —
Nerugllld, 2—H%NBY T N7 7y TT— e A VA N—NVT LD
OIH D2 —PEH Y 27 LPHE ST E T, ZENY — )L TR AERR
BT L EFITL LD & TH e, mllldroot/NA T — KD A%
RKENhET, "2AT—-RRMEES s, 2a—FEHY 25 LIla—Fo7
NI ERA-I v Y g YTHEIMIZIEMENE Y., ZhoOoREER
FEaR. ZHET 21003, 22—V EHa~ > Rrug® AL £90H Trug User
Management] (5583 System Configuration with YaST, 1 Deployment Guide) % %
).

1162 VO D277y T5—hOREGEEA
VA N—=J

Software Updaterld, /3% L DilfIHIR(GNOME) % /2133 25 2 b L A (KDE)
12 HERDEZ L7 A ar e LTHRRENTHWET, Zo7 A avid, v
NT—=2 U IRHT7 v 75— FOIRBUSIE L T B RBZEALL £,
Software UpdaterlZ1 HIZ1[H, ¥ ZAF LD T v FF— "3 D0 E 5 Ik HEf
FNCF 2w 7 LET(FNF = v 7 2o HEE 74’3/%*7U/7LT
[EH] ZERLET), L7y 7T5— l\fJ‘E)é Bl /N RV DSoftware
Updater” 7 L v b2, HIFERDOTEZ 6, 4 l///O)*b+ JERIEERF M &7z
sz L £9,

FE: Ty ITF—bMAIOQTOTIECEAEBENOIS —

Ty IT= N EATZICT I ATEROEG, ERORAIN TS
LY £9, i@E. SUSE Linux EnterpriselZ 1314 & 72 1334F 0 E 43R
MWHY, ZOWENICTY v ITF =MW IIT I RATEET., 207
7 2 FERAMSIN G LIER S hET,

7/77 cMhrarZ~o7 72 AMEEShLHE1E /NI hAs <
ATV RALTE ﬁ%%uﬁé a%%HTé%%x/ﬂ DN
?%Tézhi?‘ IR AH < o H —1TlE,. http://www.novell.com/
center/ C7 IV RATEET,
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ININTA AV Ry 7T 58, Ty TT—r7 40 v RUNFRENE
T, ZDT7 4 Y RIIE, FAHTEL Ny F PNy r—=IoRraEhT
WET, SEHEIQEE RS, hT IV 7 A 2 (LRI E
T, X2V T4 Ny FIlE WEOFOFEE L= o h T,
7 aroyFiZid HLIWEEOMM TN THET, HEEET Ly
FIE, M=o THhETA, &2 T 0 8y FhEK
REN, KICHERET BNy F. ATV a oy FOIEICF RENTHET,
RIS, FTLAR=Y g 0oy r—IBEREnEd, XRTLHy r—
VERET LG [TXT] . [Ny =] BXRO [Ny F] Bl
AL ET,

AR Ny =T ENRyF
Novell 5 ARICY D — 2SN T7 v 5 — M. [Ny F] &L THERIRE

NEJ, oy =200 LNV g DNy r =%, [Ny r—
] LR RENET,

FPEDHHICE T 55l 2 &9 2121F, v~ ATIHHZ®ERL T U A
NIt Y RODTICHD [GFH] V2%V 7 LET, A VA= LT
LIEHZW®RT 21213, U T2HHDOTF =v 7Ry 7 22 @RL 9, ¢
NCONy F LU, ETERMRT 205513 [TXT] BEU [&L]
ML EY. [Z#] 2#RT5L, @RLAETar I L0844 2 =)
ShEY,
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120 Y7 ho=7 7w 75— hDER

@ Software available for update:

dbg-glibc-debuginfo (Optional)(noarch)
O O ptional update for glibc-debuginfo
Catalog: SLES10-SP1-Updates Type: Patch

dbg-kernel-debug-debuginfo {noarch)

O ptional update for kernel-debug-debuginfo
Catalog: SLES10-5P1-Updates Type: Patch

dbg-kernel-debug-debuginfo (Optional)j(noarch)
O Optional update for kerneldebug-debuginfo

Pl 1 ES AR S04 1 lncdeban Trrmn: Fodbnkb

= Details

L D]

=l

Select: All None

Update Version: 2581-0
Category: Optional

Status: Needed

[This update adds package "kemel-debug-debuginfo’ to SLES10
SP1.

Debuginfo packages can come in handy when experiencing

Configure... X Close
g

v

1163 VIO MDD T7DA VA M—Ib

VINT TNy =V A VA R=VTHIE, A=a—6 [V 7 o=
TDOAAZAN=IN] BEIRT LM, Fioldzen—installerZ2FEITLTLE
Iy, A F 7 =— AL, Software Updater & |3 & A LRI U T (1.16.2/H TV
ThI=2T7 7y ITF—hOIEEA VA N—=)V] 45 X—) BB, =7
L. RNulr—=VoMERU AN T 4 V2 U 2 Il A s 2oL hsE
BoTWET, A VA= NVTEINY T =V DF =y ViRy 7 A% ERL -
5. [A2RZAM=] 27Uy I FTLeRX9r—DA AN —)LDHER &
NET, oy r —v & oIREBRRIE. A 2 M= PEEIINCHRL £

ER

KDEF 27 v 7 DBil:
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1.16.4 V7 b = 7 DY

VIRNT 2T Ny r =% 7 AV ARN=VTHITE, A=a—06 [V
~7 = 7oHIBE] ZEHRT 5. Floldzen-removerZ2FKITLEFT. Ny
=YDV A MIFORTHIHHEZWRET S, [#hg] @ihekz 7oA
VAN, [NF =] ONF — > DiffllTInstalling and Removing Patterns
JH (487 System Configuration with YaST, 1Deployment Guide) % ZHH), [/Vv
=] [Ny F] VI EMEHLET, UZAMPOHIRTLIEHOF = v
IRy 7 AEEIRL. [HIk] ZERT5L. R r—YD7 A VA N—
VISR SN E T, EIRE Wy r —=DIHKIEFET 2o Ny r —I0h -
eHEld. The oy =Y bl nEd., Zoha. TNy r—
VU OHIMETET D A v~ VDR RENET, CORXyE—VITHLT

[Frot] 220903, EORXyIr—Ib7 A A=V EN
FHA,

1.16.5 Software UpdaterD &=

ZENY — )V 3ET LI, 77U r—varg Y Roube [FE] &7
V27 LEd, e R [—x] . [H4a7] ., BLO [RE]
DIfEFHD X TFTRENE T,

el il Sl KA m KA

BN -2, VI NI =27 Ny =T ZOEREIREET LY — 2
TY, &YV —v L 12FLTEROh a7 i T2 M TcEET,

[(—eR] Z72E AICEL2 IR —vRE, ZOIAT, AT —
5 ZNERPFORENET(RO2DDNRVRA NG EIE T4 v oA
AL TS ), -2 Zibfn HIBRT 2123, [T —EXof]
Bp] £7213 [H—exoibm] Z2HHLET. Ror—e2s 4 T2HHT
TET

YUM
Ny Iy — V5 — ZIZRPM-MDIZA\ % 5 2HTTP. HTTPS., 7ZIXFTP
BN, .
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ZYPP

ZYPPY—E 2L, YaSTTC [V 7 D =7] > [ 2> A=V —Z] D
IEICSER L CiEfn& iz, YaSTA > AR =LY =TT, £ VA k=)
YV — A %&IBIN9 5121%. Software Updater £ 7213 YaSTZ M AL £9°, fxf]
ICA VA R =)V L 7=V —ADVDE /ZI1ZCD-ROM)S, FHARESH TV E
T, 20V =A% EREEEL LGS ThEthofihih, o=
b=V = Z(ZYPPY —E )L EIRL TS, £H LAane, #L
WY TR =27 %A VARV TEERA,

AR R

YaSTA VA M=)V — A, YaST Ny =Y URTY MY, BILUZYPPY —
BRI, ENYLY TR 2T EA AR NTELY—ADZ L RRL
TWET,

SV
[ bh] 25T, avbEa—FII7 Y hENTHEF 4 L7 Y
AL Z ENTEET, ZokFEIL. 72 & ZATEMRICNovell YUM
P—=NNDIT—1) T ET, ZTONFEA— NV 3y NT—=FIZT T
A—=bT2E5%xy NU—IRNETKVHEET, T4 L7 MY ERIBINT

HI1E. [HF—EXURI] T4 V27 RUAND I NN AERIEEL TL 2 E
U,

NU

NUIZ, Novell 7 v 75 — b (Novell Update) D 1 #&J2C 9, Novelllx, SUSE
Linux Enterprise ® 7 v 77 — K&, NUY—EZ2& L TIREL T E T,

A VA=Y v 77— M OEEEAT> 2. U A M DNovell
NUY —AADFRoREhE T,

A VAN=NVIZTY v I 75— MXEEZ ATy T LHEE, av oA
VIPBsuse_registerZFKITTHM. FzlFroot—H & L TYaSTH
5 [VY7ho=7] > [#GEEe] OIIC7 U v 27 LTL S, Software
UpdateriCNovell 7 v 75 — M — DSBS 77,

RCE ¥ ZENworks

Opencarpet, Red Carpet Enterprise, ¥ 7z1XZENworkst — & 21, WEE+R v

FNT—=JTCINHDOY —EANKESNTOLIGEICORNHTE LT,
o 218, g —o—"he 7y 55— M 2T 59— R
N=F 48Dy 7 by =7 E2FHL ThH5E. 2o ot — e ZIEFH
TEEXHA,
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SUSE Linux Enterprise% { > A k=)L 5 & 2ffH DY — U ADHAIRE S
NEd, ZYPPH—b 22 LTDA A ~—)LY—Z(DVD, CD-ROM, F7/-
Exy hT—=271 YV —=2), BLUY—1E A& L THSUSE Linux Enterprise 7
77— M N ESRFRCIBEIN S NS)TT, lE, IO OXKEEEET
LT H Y FEA, V= EARRRENLROEGEIL, rooty = )L 2L
T, suse_registera <y REFITLTLZE 0, y—E2ANRHEINIZIE
mEhEd,

hsaos

Y- AT, BERLIEEOV T N7 =T Oy r =V L2, B
HLN—=Tq D) T NI =T DNy lr— Y (RCEXRZENworks— B Z1XZ 95 L
T ERIEET e TEET, chold, ZraZefighs s
WLV EINTWET, Wy ar2EE ITERRT 2113, 04T
LHNEATDF =y VRy 7 ZA%ER F 23S L £9.

B Cl. SUSELinux¥ — B Z(YUM & ZYPP)IE, W J # v 73t L <
WEHA, V- RIE, 12 AhZarsnb ) A, A AN -V
ICsuse_register #{f 5 TSoftware Updater % :XE L /=5 &1, YUMB L O
ZYPPHh Z R HENMNICERR S NE T, Flc— 2 &IBNL 5513
IhoohZar BT L 0ERHY 7,

H e E

[F#F] & 7C. FCHfFFCSoftware Updater & BR300 &) & REL £,
root 2 —|%, Software Updaters ¥ Ex ZHTHZ & b TEE T, RO
2L HELZBHTLILLNTEELA, FHEOFMICOWTL rug
D=2 T NN =V B L TLIEEN,
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BHERIC DWW T Z 2 CaAL 727 7V r—3 3 > olENS. KDEEFftho £ @
TIVr—2 g eI ATTEET, ZLOEELRT T r— 3 v OFFIC
DT, ZOX=aT7IVHOMOEEN 2 SIH L TL7E S0,

« KDEBLOKDEY 7V /7 —3 g »OiF#Ic D0 TUE, http://www.kde
.org/B L Unttp: //www.kde-apps.org/ BB L TL 72 &0,

o NJUAR— MOREEECR OB 21T 9 1C1E, http://bugs.kde.org/%
ZIL TS0,
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H Ol AN 72l 0 MBS L T KDETF A Y K w T B filifE#
HTEET, mmrxﬁ%/7@%ﬁ%ﬁ%?é 1. ﬁiéiﬁﬁ&ﬂ
DET, 2—VOEEE. Kot Ty ar2RHTEET,

s TN OTFTAY by TATY =7 FDOHOMERENE2 L ET 2513 —
WHNCA TV = e tiZ )y 7 LTHEXA TR TICT 7R ALET,

« KDET A7 kv 7 ekoREH 2l a2 2T 551%, KDEa Y ha—
N2 —%HALET, arta—Lkr ¥ — C@ Sk S EEEER
EEYVa— WS A 7alPBHESNTHWET, 2hooX¥ A 7ar7o—
L. TAZ by IA TV =27 by THFARNAZ 2 =67 72
TEFET,

21 KDEa> bO—vtE59—DFEH

MEHVFD*WﬂV&@\mmflﬁbv7W®éi§i@3Vﬁ*\
N OMBIRENELZLET 2 GICHoNET, avia—)lkr ¥ —%jic
3512, X%/Xwn*#bféﬂh10]>[@ﬂ ] DIFIZIER
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File View Setings Help
B —
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T, LEIZINC T, 77 ANTA TR CEY 7T ) r—y a0 %
T 57200, T7ANVRNOT 7y A NVHETEEETLZ2 2 TEF
9. Konqueror”? 7y f VR 2=V ¥y DA T2 a Vv eXHELET, a7 A/
r vy M UROR Yy Y g YO IRNTEEEFRLIZD, ANV F 2y
DA T a ERETHIEMTEET,

Peripherals

TINA, TAATVA, VaAfAT 1y 7, F—=R—K, ¥7A OBEX
TNA A, T or, YAy, BLUCDROMXUSBAT 1 v 772 & D
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Security & Privacy
Axv K2, KWallet(KDE/S 2 — RE E&wﬁw®ﬁ7/a/®
E. KDEDWGSALE E BIOKIIAAWZRXa X b, Riiihi:
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Sound & Multimedia
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TNA ZADREICHT LA T a vnH 0 £7,

System Administration
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KDY 7> g Clk, KDETAZ by TOREEGEMZIND FFTnE 9,
22 TR My TATO 5 PDEE

KDET A7 kv Ji2ld. TAZ by I T7AaVBHENLOERSINTHE
T, TANE, Ty A, Vo OREDA TV =7 M 2iBNTHZLI12k0.
F2A7 by T Rt A as#2EKRLIZY, BMEEZEET L EMTEE
7,

FIE 2.1 T2 kv T7A 3 DMEKEEE

1 LT A by ATV =7 MEBINT 51213, 72 & 2 1FKonqueror
DALV A=a—POIHAZIERL, ThET A7 by JICRT v 7L
¥4, JHH%Z a2t —, Mlild 200, $234 7V v V7 %
VERT 2D TR TELa L FF A MR 2 —FRENET,

(:&] Find Files/Folders

@ Home (Personal Files)

!a' Personal Settings

@ SUSE Help Center
Actions

D Recent Documents

!:J My System & Link Here Ctrl+Shift
g Run Command... _
E Switch User

5 Lock Session

@ Log Out

2 $/o. TRV My T oo EGA 2 Y v 7 LC.  [Create New] %
WIRL, :TILWTFRAY Ny T ATV 2/ NIRRT AZ L b TXFET,
COHG, YT RA=a—W6T A7 by TIHERT 547V =7 ~ofl
iR LEd, 7407, 7740V, 77U r— g0l >
7. 77A), WebPV A K. F£/21FCD-ROM 7% & DT NA A% 5HRT 5
CEMTEET,
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SUSE Linux Enterprise®|Z (%, A7 U =2 —=N=2 5P COFKES N T
F9. HENTITEHRICEETEET,

FIg22 227U —->2t—NDHFE

1 727 by 7 Lozeoiikz427 Y v 7 LC. [Configure Desktop] %
HIRL 7.,

2 KoREhsHE AL 7arne, [Screen Saver] %R L £79°,

3 A7V =22 N=DYUANPEAI )= 2—N=%21) v IT5h
Lo A4 7ol L a = RoREhE T,

Screen Saver Settings

~Screen Saver

Phosphor 1 I '

\’é Slide Show

Behavior StarWars

I The Matrix

XJack
Multiple Deskiops B Desktop Distortions
EFlying Things

B Fractals
ElGadgets & Simulations
[ Setup. ] [ Test
Display —Setlings
(%] Start automatically
o —
[ Require password to stop
@ Help Defaults [V oK l [V Apply ] [ # Cancel

4 [Setup] %7V vy 7 LT, WERERREDT T a 2T F
7,
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RN —= BT U A NFKRTLHI L TEET, e tF T g v
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Ny 2759 RODOBEEEELRZD .,
EHZERL/ZY TEXET, KDECIIUETZAZ by T2 TX 5720,
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7 [OK] 2270y 2 LT, BEAFZHEAL, REFA 77 2B %
7.

Ny 2 7oy Roe LT 5

FIE23 TR b~y TOIEEDEE

1 TA7 by T ML RWEfTEZGH27 ) w27 LT,
ZEINL $7, HEFYA TR RoREhET,

[Configure Desktop ]

Change the background settings
e Setting for desktop: | All Desktops |~
(Background All Deskiops
T Desktop 1
Behavior " Deskiopi2
(@ Picture: default-1280x1024
O slide show:
Multiple Desktops
. ~Opions
=S Position: | Scale & Crop
f— Colors: | Single Color
Display
f [
Blending: [No Blending
O
@ Help Defaults * cancel

2 [Settingsfor Desktop] CT. ZHEZEH T HIET A7 by TE2ERL £
—g—o

3 BEOHFEPEETLEE.  [Picture] #27) v 27 LT, UARDPS
HEZERLET, W2AYL0HFEEZMHHTLICE VAN NIHD
TANWERZ )y I L, T7ANY AT LPSEIET 7 A ) %%
RLET.

4 254 R¥ g —F— RCHNOEIGZ R RT DL, [Slide Show] %
70w 7 LET,

5 Ny 2750y FMICHFEEZMML 20 EE,
7LET.

[No Picture] % 7 1)
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6 [Options] 7 )V—T 6. [Colors] TORMORY > %2 1) v 7L
T Ry I TS0 ROEEERLET, Y AFHNT =Dy I TS
v R&HT 51, [Colors] % [Single Colors] VA7 72 g3 /12
HEL, HFORY &7V 97 LT 2BEHOEEERL £,

7 [Apply] . [OK] D7 Vw7 LT &HEXA 7T 2B £,
=PIk TE TI7ANVNEVEL DT A My TRVE L LET,
Flg 2.4 MoKET X2 Ny TDiE

1 XENVDT AT hy T TV Ea—7%4527 U v 27 LT [Configure

Desktop] %EIRL £ 7., ®BRENLFES A 77T, T2 7 by
TOREWKTEET, TR My TOT 74NV NOLHIOEETE F

7.
MNumber of desktops: , Q o 0 0 o . . o a
 Desktop Names
Desktop 1 [Mail ] Desktop 11: [ ]
Desktop 2 | Desktop 12: [ ]
Desktop 3: lDesklcp 3 ] Desktop 13 l ]
Desktop 4 lDeskmp 4 ] Desktop 14 I ]
Desktop 5: lDesktop 5 ] Desktop 15 I ]
Desktop 6: [ ] Desktop 16 [ ]
Desktop 7 [ ] Desktop 17: [ ]
Desktop 8 [ ] Desktop 18: [ ]
Desktop 9 [ ] Desktop 19: [ ]
Desktop 10: [ ] Desktop 20: [ ]

[] Mouse wheel over desktop background switches desktop

o) (v e ] (% gora |
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> [Desktop Name] DIEIZERL F 9,
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1 YaST# {5 T, compiz-kde, xgl., xgl-hardware-list, B IV
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Zh—=ILLET,

3DT AT by TR EFINCT H12i3 LITOFIHICiE-> TS0,

1 XA VA= —P6YaSTEECENT 50, At+FR2F —%2 ML Tyast & A
HLET.
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2 YaSTTC., [ X7 4] > [letc/sysconfig Editor] DOIEICZ Vv 7 L7,

3 Eflov A bhe. [FRI by T] > [FHRTLAwF—2r] T
YhUEREET,
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5 [E7] %2 Vy LT, EEXZEHLET.
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KT LT A7 by THROER, F—R—Kva—bhy hoi%E B
FOMDT A7 b v TR OBIEZ 179 121%. gnome-xgl-settings = —
FTAUTFT RHHLET, ¥—=3IF T4 RS, i [ R
DFEIT] 7T R 6, gnome-xgl-settingsZFKITL ET,

Firhoty v a yTTF AT by TR EBENCT 212F DIToFIAICHE -
TLIZE,

1 KDE2 > ha—) )bt ¥ —%F\TC, [KDE Components] > [Session
Manager] OIAIZEIRL 7,

2 [Advanced] 7' )V—7C. [Preferred Window Manager] % [kwin] (2%
E L/ i vg‘c

3 L] ZERNL CEEAREZRL, EVa—VEKTLET,
T AT Ny TR R K AIHEINCT Z12E, IToFIHICHE > TS0,

1 YaST#%#EEIL £ 7,

2 [ RFA] > [letc/sysconfig Editor] DIEIZIERL £,

3 EfloU ARG, [FRI by T] > [Fr AT R—Pr] T
YU EBEET.

4 DISPLAYMANAGER_XSERVERT > b U ZEHR L T, % Xorglli%EL
EJCI

5 [5Z7] 27Uy LT, TEEZBHNAL T,
6 I b a— X ZHEHLET,

2.4 /NRIVDEE

NEVCE, 77U =Ygy, 77y MR =7ar5h), BLUOH N
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FJ. NRNVEZELMO N IVE, JOGMCHEIL 720, HIfRT 52 &M
TEET,

FlE 2.5 NRIFEFZDIENE HIFR
1 NEXNVDZEDONy Foe 7)) 7 LET,
2 LW T U — g o83 )UCiEMT 5121%

2 AT XANR=Z =6, [TV —2 g9 N IUICIEN]
IRl £,

2b YT A=a—DhrT) oIy HIENTs7 ) =gy
PEIRLET, 770 — a0 07 A2y AINRE
7,

2c 77U = arHIicTrAarEEETLICNE. Ry R
2LTC, [PV g RNy RFRE] BEIRL 7, For&
NFZA 7Ry 2 ATy IV r—arrAavezrsYy s g
L, L VROBNKRRENT, WorvAarzERexF
7.

2d NS TA AL ERBRT LT TAarEEZY 9 2 LT
[Remove Button] #3i#IRL £7°,
3 LWLy hEARVICIEINT 51T

3a AT XANR=Z2=M6, [TT Ly FEARIVICIEN] % %R
L¥7,

3b BRINAFATHRT Ry 7 AMET T Ly NEEIRL, [N
1CiEM] #2720y 7 LET., 77 Ly MEIARMITHTEASRET,
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¥ Add Applet= KDE Panel -_

| Show [all [~

Konqueror Profiles

Menu for accessing the Kongueror D

profiles

Add Applet to Panel 4 Lock/Logout Buttons
plication to Panel et

Remove From Panel

Add New Panel

Add to Panel H@ Close l

[E] Lock Panels
Configure Panel
e >

@ s » Q5 U3l

3c AT T Ly MEHIRTSICIE. 77 Vy hEHEZ Yy L
T[] 28RLET, 77y hOayFF AR A= 2 —I(C
[AT] A=a—RRENBWEEIE. <7 20— VL& o
AR FICEWT, RRENL/NSRBREDRAIZH27 ) v 7 L
T, [HIRE] Z8ERL £9,

4 WO ONRNXINVEBINT A2 b TEET, AR EIEMT 51T
ININDIEDEN 57 V) v 7 LT, [NpADiB] %8R L £9,
BT RXA =2 —=61EINT 5 8% )V oFE 28R L £9°,

5 M ARV EYIET HI1C1E. ARV DZEOTN G2 Uy 7 LT [N%
INDMIBE] ZEIRL., T2~y IO HIMT 580 V2 ER L 9,

FIE 2.6 NwINHDELEDFE]

1 XX NV EFEOT7 TV r— a7 AaryofiEw2XET LI, 7143y
PHE7 Vw2 LT (B 2ERLET. T2 — VLD,
FAUCEDV ET, VA2 EHINT 25— YNV e RT v I LT
MmE, ITADIERE VEMLET, FELLGATICT A 2 o 35Hi) L
E3c

2 [iffic, A2 by I T ba— Z2AIN— BV AFLNLA
REDNIIVONIRE TSNS A2 e b TE £, HBOmAITH— VL
ERENL T, FREINDNSBEWKAIZ 7 ) 9 7 LTS, FoR
ENLZaAVTFHRAL A=ma—=n6, [HE)] 28R £3, X2, H
W OFENE DT E 7V v 7 LET,
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AA VNFNVRMOIEBIN N RN D EFE EERAELEETLZ MW T ET,
e ZE RNV A X, BE fUEEEELLZY, BHMEEZEAT 5
CUYMTEET, F AN —DENEERET AL LT ET,

FIF 2.7 NFINDOGEEENEOEE

1 NNV DZEDEN 42 ) » 7 LT, [Configure Panel] % i#E{R L %
T, NRNVDOSEEERMEFRTE TS LA TRIBFRRENET,
Mohs AV 2Formd 51203, EfloXA b o 74 arer Uy
JLET, T 74NN TIE [Arrangement] 1T IV DL T g v
MRS NET,

You can configure the arrangement of the panel here
4

—Puosition —Sacreen

| —() -

Arrangement
5 J O
iy B 0
[t 0 0
Menus S .
E — Length
Rppsarence 0

@ [%] Expand as required to fit contents
Taskbar

~ Size

|Gustom M

5 s 3

[V oK H HX Gancel l

2 Mo NFINVEIBINL T A5G, 71 v Koo FERCHIHTE 5 8%
WD ARNPTIREINE T, RET DN EIERL TLES 0,

3 LEICIELC. T2V by T FOMOEZRERLIZY, SR EE
BIRL 720, NV A REEEL, [Apply] 27 V) v 0T L%
EHNENXIR S E T,

4 NENVOHEPFOREREL LY, T 74V MDA T a v %

EHETLHI10E, EflloxA > 6 [Hiding] %27V vy 27 L £, @bt
ATy arkFEELT, [Apply] 27V v 7 LTS,
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5 NXNVOEEEHLIZY, AR )VOMEERE BT 285513,
[Appearance] %7V v 7 L £,

6 [Button Backgrounds] Tl&, N3OS F I F 0T 055 %2 %R
TLZEMTEET, N2V O—FItEZ2ffiF5i12iE. YA RS
[Custom Color] % iEIRL . Hlowt)mAR»2 &7 1)y 7 L%
EIRL £9°,

7 NIV EBICT H15E51%,. [Enable transparency] %8R L £,

JEFICHT ORI 2 WS E THEM SOV O BEEHE 2 [0] |9 51213,

[Advanced Options] %7 V) v 7 L TRV OERELEFEL £,
[Apply] 27 V) v 7 §5HE, ZHNEMNXIREINET,

8 Y AU N—DFT T 4 )V hOEWEEEET LIGEIEL. EflloxXA e
[Taskbar] %7V v 7 L ¥7,

9 A NI RCOT TV — arCldkl, BET Y254 7%
FAT Ny TOT TV —3 g 0ReFRRT HI2iE,. [Showwindows
Sfrom all desktops] DIEIR% AR L F 77,

10 LEIIEC D Z AT N—F T a v HEH L, [Apply] 27 Uy
Z7LTLEEN,

M NNV DOF Ty g v EBENGEREL&D-726, [OK] 27V v 7
LCHFA 77 2B 7.

FIE2.8 A 1> RAR=2—DFRE
AL VA2 —RFETLHIUE. DITOFIEICHE S TLEE N,

1 AV A=Za—P5KDEZ Y ha— )bt > — %kl 570, Alt+ F2
X — %L Ckcontrol & AJJL £9,

2 [F2xohyF] > [ANA] DIEIZZY w7 LET,
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File View Settings Help

&l Appearance & Themes
© 4 Desktop
4 Behavior
KDE Resources
A Multiple Desktops
B Panels
) Taskbar
1 Window Behavior
7 Window-Specific Settings
& Internet & Network
& KDE Components
) Peripherals
3 Regional & Accessibility

F23 XA>RXZ2—DHGE

Panels
T
[ Arangement Hiding Menus Appearance
~K Menu

Menu item format:

() Name only

(@ Name (Description)
() Description only

) Description (Name)

%] Show side image

Edit K Menu

‘Optmr\a\ Menus

O +rBookmarks

O c)Find

[ ¥ Konqueror Profiles
[ =My System

[0 & Network Folders
[ = Frint System

O < Quick Browser

O [JRecent Documents

P L Settinas

RS L )

I*] @

f\ Security & Privacy

'  QuickBrowser Menu
& Sound & Multimedia N

|| Show hidden files

Maximum number of entries E g
\) Help || Defaults v Apply

@ System Administration
%, YaST2 Modules

3 [X=a2—]5T7%0Uv L%,

4 A A==, 7TV —v g VEERLITERAND 5 WIEZ oM
NERRTLEMEDDPEIEFRTEET, [Nameonly] . [Name
(Description) ] . [Descriptiononly] 35 £ O [Description (name)] 7 & 15
RLUET,

5 X —JHHZZEET L5, [EditKMenu] #7279V v 7L %73, K
AZa—IF 4 AT, A=a—JHHO Y A N EANCERENE T,

Sa VANHNDIEHZZ7 Vw2 L, HlloA Ty g v 2EHEL $£79,

S5b [T AN] Ama— = A= FHL T, LA 2 —IH
H., %I A= —FEXYY CFEEENTEET,

5 AV AZa—DF TV =7 "EUDIY ., B0 A0 £ 72138
HIClE. 8] A=a—M, V=N N—D7 A a2 %L
9,

5d TENEEKA= 2 —TF ¢ Z AT 51213
7] OIEICEIRL £7°,

[77 4] > [#
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6 [Menus] # 7 CIXRNTOEENFZHEH L, KDEa> ha— )Lt
— "R TILIE [EH] 22Dy 2 LET,

25 VAFLETEX YT EHIEDK
E

SUSE Linux Enterpriseld, 5722 7 7 A VIZA(Ey < v 7, TrueType’s &)
THIRICHATCE2 8 ESER 74 b 2T 74 0 P TIMEL Tk, =
NnNox, X774 heEINET, a—WE, SESERaLr g
VIS HBDOT A b EA VARV L TCENTEET, L2L., Z0LD
2=, VA NNV LT 4 b ERHTELDIE, 202 —H721)T
R

FIE2.9 #HLTx>hDA A=

BUER ] 5EZe 7 + > N W9 5121E. Konquerorz v ¥ a3 > D7 KL &
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2 [ ANEFEA] T4 2 RUT, [CellStles] £7-1%.  [PageStyles]
TAALEI Yy I LET,
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3EFELIEWARZANDOGHEIZHZ )y 2 L. [EE] 27097 L F
9,

4 SR ERANEA T g v 2EHLET,
5 [OK] #227 Vv 27 L%,

3.3.2 CalclcF T L— b A2FERT S

SESERHEHOAT Uy Ry — MIBR A2 A NVEMNHT 556, 7>
TU—hr2FHLTEAT Ly Ry — b@@ﬁ@zﬁ%»%ﬁf?é e
TEEYT, 27 by Ry — h2ERTLBCE. Z2oIcIbCzs 7L —
~ Z BT, LX&4U&&§ft7ﬁ4./bﬁﬁwg W22 A VAL £
R

T/7V MCBT 2 laSINE, ok sy a yTilEfithEtA, 272

CAFLWEIIEAIL T Y 27 AMCECER S . G722 (400 7513 OpenOfice.org
0) K& a2 X2 hX—=Y(http://documentation.openoffice.org/HOW
_TO/index.html)IZEHIA STV E T,

> 7L — bDOYERK

Cm7/7v M, 205707V —= b TERLIZTAXRTORAT Ly Ky —
ICRIR LT AZ A IV E NNy IR Z DD IVAH A )V &Y e G A

71//1\/ KCT, 77— 2L TCERZENR. /230 &%,

FUT V= DRAFAINPBHENINCFDAT Ly Ry — MIWEHENET,

T 7 U= MEfERT 5121 RO FIEICEN T,

1 [TZr 0] > [FHEK] > [R7 Ly Fe— ] OIHIZZ ) v 7 L
EJ

2 TEDAT VY Ry —KRTCiLIznZAZ A IV WREERL., 207
VI UV—hEHFHL £,

3 [rAn] > [7>TL—K~] > [RFE] OIEICZ ) v 7 LET,
4 5771 —hroGHIE ATIL 7.,
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5 [#H] Ry 72 26, o720 T V= Nefj{FT5h7aVEI 0y
7LET.

HFaAVE, T T V— e RETLTIHINVETT,
6 [OK] #27VUv 7 L¥7,

34 ImpressCILEVT—Y 3 v%af®
9 %

OpenOffice.org ImpressZ (i L C. ZF 4 K 3 —x,OHPY — b &7 L ¥
Y=Y a R BEICFRRLZZVHIM L 720 TE £9. Impressidfiiio
TV T—=var V7 by =7 ERERREEN TS 20, o T LY
VF—varI I =7 EHHL WY T, fHICImpressiC FH1T
TLHLZEMTEET,

Impressl&. Microsoft PowerPoint” L' ¥ > 5 — 3 g > %[ /2 )| PowerPointff%
RNTHRIFLIZY TEE T, PowerPointlo N T 7 7 A W ERIFTE 57280,
PowerPoint—# & F L ¥ 5 —3 g VEHRICPVIND THZ &8 TEFE
-gAO

31 L EYF—2 3 VOVERK

1 [ZrAn] > [FHEL] > [TLEr7—232] ORICZ U v 7
LE9.

2 TV YT a VofERRICHT A4 Ty g v EEIRL £,
FVLY¥ T — gy RERT AICE. Koo HENH 0 £9.
s o7 v¥ o5 —v a3 v E2EKRT 5
ImpressiCZED AT A REFRRLET, oA TvarE/HL T,
FHNCEARESNTZATA R LT, &P TLEYT— 3
v EHTERR L 9,

c FUTVU— RIS T LY T — g v EERT A
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WRL /7 > 7 L — K Clmpress B £ 9., ZoA 7T arid &
570 U HE STy 5 0penOffice.org7 > 7 L — b, S HIC/ERK
Lz o7 V= hrEHHAT T V= ) effio T LE YT —
Voa Y EAFRT A5 EICEIRL £, ImpressTld. fio>OpenOffice.org
EVa—VEEIL LIS, RIANRT T U NERHTHZ L
MTEET, 77— hoiFlid, 324H o7V —Meflio
J2REXa XY hoFRNFE] 97 X—D)eBIHL TS0,

3.2 TAIANR—UD{FH

RAANR=VUEFIAL T, AT A4 KoM, T2 74> b, BLUY

DTS5 T 4y P EFERERL., —EHUOHL T LY F— 3 v E2EKRT D

ZEMMTEET, ImpressiCld, 2O A XU DHEShTHE T,

¢« AT A N A%
TRTDATA RICKREINLEZ R EHRTET, I rlE AT K<
BEM 5T, §ATA4 RO UGN ED T2 KRT 52 M TE T
9, Floo AT R 2 21203 A LOYFEAARATIANLEATA R
DTIRTAL 2, BEONYy X7 9 2IFRTHEROERSINET,

« AETAH

T YT = gy HDORAETOER A EREL T,

254 KT A9 DVERR

ImpressiClE, HOENLDERINIZT A X=URNLOPHESIN T E
T, £ MHOASG A RR2AX 2ffkT 228 b TEET,

1 ImpressZf2E L T, FfloHMO T L ¥y F—v a2k L £7.

2 [Kp] > [wR5] > [R50 F~X2] OISV 7 LET,
[Master View] THBUED A S A R~ A2 RS £ T,

3 kon"x Vi) vy LT, [NewMaster] 7V v 7 LET,

OpenOffice.org 7 4 A A A — b 105



106

4 FHITLINBUCR D ETCATA R A X L £7°,

5 [wREKREFHCE] 22V 7350, Fd [For] > [FEE
DI Yy 7T 5hE, [EELRNIRY £7,

TaAvT

TV T =Y a v THHTAATA RYAY — & T XTER L 7RI
b EImpressT > 7 U — MIRFETAHZ LMW TEET, DI K{FL
A5 R AH = "o T T VYT —> g v 2ERT A25GI1CE. 20
FTUT U NEHETET,

254 A DEHA

AL RLAZFENL 22T A R, $EFTLE YT —va v ichi TR
THOATA RICHEHATE£7,

1 7VEYT—varEunT [FKr] > [vX4] > [XF714 <X
L] OEICZ ) v 7 LET,

2 (AT aNATA RIALZEZTRTDATA RTIHRLSER D AT A
RICEHT 250, TOATA RIAZEZMHHLIZWAT A REIERL
9,

BRDOAT A FeBRT 103, HHT L2254 KE27 Y v 7 Ladts
Ctrlie X Z+4 KN 2 CIL £7,

32 XA 0TI, WHLEWSZAIX=UEHEI )y 7 LET,

BRI NA INFTRENTOIRWES. [#on] > [Task Pane] DIE
W27y 7 LET,

4 KOF T arno1lo27 0w 7 L TASA RAZ2 WL $£7°,
o« INTDXZ A NICiEHH

WIRL AT, R AZ 2T LE YT =2 a LICHATRTDOARS
A4 RICHEHL 7,

o FEIRL =X Z 4 NICiEH
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WIRL/IZATA K22 &, BIEOATA R, £7213AF7 14 K< A
& OWHARNCEHRT 2T ED AT A RicwfL £9, e xiE 7
V¥ T =3 a VHORIID AT A RIZHD AT A K< A% % i
TLHEE. TOATA REBRLIET YR AN B,
FTDATA RICATA R~2A7 WAL 7,

3.5 Base - F— 9 RXR—2ADFH

OpenOffice.orgllld, T —HF X—ZAFY 2 — )VDBaseNNEF N T E T, Base
ZFHL T, BH7 KU ARSPEFEL C EEN S, BHA R a2 XAV NVE
My 27 LET, SESELRAPFPOEREBMNT L7 —F X AL TS
£,

F—=TN, THx—h, 7Y, BIOUVKR—= NI FTEICTEKRT L. /2
VSR o = REMHAL TEKRTEET, L2AE 75—V ¥ —
NiZid, eVx 2B LOCEAHBROZO O —HoHii7 4 — )V K2RH Y £7,
Base CER S N/zFT — 2 RXR—= 2T, T4 —L V¥ —2FKT 5550 DT —
A=A L THHTEET,

BaseZ {1 [ L /¥l 7 — ¥ RX— 2EHI DWW L, 2o~ == 7 )L ClEfil

NEHA, FFMlE. 3.81H [OpenOffice.orglZ B9 2~V 7 & MO ME
A2 R=NNIH L EHEER ZSIHL T{ES 0,

3.5.1 ERIEEIN ATV a VvEEskT—
& R — 2 DVERK,

Baselll:, & — ¥ RX— AT D 7= 7>, FRIEFR SN T —F N—
AT 4 = )VRPHEINTHWET, 22Tl ZoOFEAIERINTWHDLT £ —
W RZEM S T7 RUVAREZERT 2FIEICOWTHIFL THEETA, Zh
50FIEZICHTHE thoTF —2X—24 FH/FkTcE £,

F = RXR=2DER T at AL, WO T Tak AT NET,

F—HR—ZADVERK
BN T — 2 XN— 2% ER L £,

OpenOffice.org 7 4 A A A — b

107



108

[Z7An] > [FHEK] > [F—rxX—=2] DlEICZ7Y v 7 L%

2 [F— X=X HEK] > [Next] %KL £7,

3 [Yes, register the database forme] % 7 V) v 7 L THN DT —Z X— A
WA o OpenOffice.org® Y = — Vi L THENMC L, #A 7R 7Ry
D AD TS B F =y Ry 7 A% WITHNCLT, [GET] &7
Dy 27 LET,

4 T—AR=ZARFELIZOTF 4 L7 MY 2Bl CF— ¥ X— 2D 4l
ZANL. [OK] #2727 LET,

F=AR—=—AF—T)IVOty b7y T
T IR AT =TT LW T ¢ =V REERLET,
1 5—TNV I 4 — KT, [Personal] 27 Vv 7 LET,

[Sample tables] V) A N WM AN DEFFHT — T IICEDL Y £7°,
[Business] %27 Vv 7 Lltma. UAMIIETRFAE Y R AT —
TIVREENT T,

[Sample tables] V) A ~C. [Addresses] %7V v 7 L £7,

EFGFADOT KU AR GE% 7 4 — )V KD, [Availablefields ]
AZa—IlRRENFET,

[Availablefields] * == —"7T, HADO7 KV AMRICHH L 727 1 —
NWRZZVwy 7 LET,

1OoFOJHEZIERL TR 52 &b, HNOIEHZ#R L TEMN
T2 TEEY, HIOEHZ SR 25518, -2 2n
SIHHZERL £,

R L 2HH 2> DERENT7 4 — IV R] X == —(ICH#Id 5IC
(E, 1Ry 2 LET,

i BEZ 7 4 — )V K& §XT [Selectedfields] A== —ZFHEIT %
Wik, BRAIZ Y IV ) v 7 LET,
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5 BINL 727 ¢ =)V ROFORAF2LET 55513, 1F—& | F— 2%
WET

F—TNRT F—LIlE. T4 IV RN ISR SN TV ABIEFT
FoRENFET,

6 [Next}%# 7 Vw7 LET,

7 &7 4= VEBELLERIN TS Z 2L $79,
T4 =)V RE, FfH., = NUDBRENEID,. T4 — IV RDIRKE
(ATTRER I AT RO EECEET, 2o Tk, REFZToE
FEFELRNTLEE N,

8 /Next}%# 7 Vw7 LET,

9 [FoA/~VF—DIFK] #2Vw 2 LT, [Fo04~UF—ZHE)
HICiEm] 220y 27 L, [HEEEEM] %227 v 7 LT, Ki
[KN] 220y 7 LET,

10 5—INVEDT T4V Mz ZoEEMHL£I., [CoFm—TniC
HONWT T =2 Fk] Z3RLC. [E7] 27V 2L ¥,

I 4 — LDVERR
KIS, 7 RUVAMRICT =2 2 AJ1T2 8 ST 5 74 — L 21FRL £ 7,
1 74— 4% —=RT, GRAIZA a7 TNr Yy 7 L CHERANAE
77 4 — )V R%EJXTC [Fieldsintheform] V A NMIHENIL. [[K~N] %
27V w7 LET,

2 T —LBEDEIICHEIL R, [AN] 227V 7L E
7.

3 I RTCOF =R RTLT74—LEBFHTLIA TS g0 2R,
F v PRy 7 AT RTZEMICL T, [KN] 2209y LET,

4 27 AN T4 = )VROPEREFEH L, [(KN] 270y 7 LET,
CoflClE, F7 AN bOERERZFHL £9.
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5 74 —LIZHHIRMT. [Modify the form] 7> a v #$RL. [
7]l %7Vy 7 LET,

I+ —LDEE
TA—BEEHLED, WEICEI £ T4~ LOMBELEL £,
1 EEFEAET LS, BOT02 74— LML ET.

2 T—HAR=ADAA VT4V RIT, BELIZWT A —L2H7U v
LA Ty a 3207207, [ME] #2277 LET,

3 74— D74 = IV RERT LT, 74— L% NG FE ¢
EJESC I

7=& Z1%. [FirstName] 74 —J)V R%. [LastName] 7 ¢ —J) RDf
WCRREND EOMENIL £7, Z2hhns, FHECEY oo 4 — L
R oA % i L %9,

4 74— LDBIEMNTET LIS, RELT 74—L2BCET,
IRISAT S 1E3R?
T AN=ADT =T NE T —LEFRLIZE, T—F 2 A/JTEET,
Flo. JZURVR—-bE2FRLTT 4% —RFL7ZORRLIZVT S
EHTEET,
Base DAl D T, OpenOffice.orgZ > 7 A »~ L7 & 38IH

lOpenOffice.orglC B9~ 2 ~ )V 7 & FBEROMFT] (112 X—=I)IEEk SN T b
BRI ZBIHL TS0,

3.6 Draw - 'S5 7 4 v U DYERK

OpenOffice.org Draw % {fi > T, 7T 7 1 v 7 RN EFk T £9, fFakL 7z[X
T 2TEATIREFTE £, RELETZ v AV, o7 TV r—2 g
YA YAR—=KML720, fhoOpenOffice.org® Y = — )L CHHTE £ 9, il
DFlash/N—¥ a Y IR TCE £ 7,
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OpenOffice.org~ = = 7 )V ClIDraw D /RIS DWW TEFNCERIH L TuvE
9, FRIC DWW TE, 3.8/H [OpenOffice.orgll B9 5 ~ )L 7 & RO ME )
112 R=)Z B L TLZ S0,

R¥ a2 N CDrawZ 7 7 4 v 7 2ffi§ 21213, ROFIIIEET,

1 Draw2 =, 7974 v 7 2{EkL £7,
2 TR T4y I ERELET,

37974y r2EECaA—-L UGV E0, EPSERES T T 4y
7 EHAL T,

Drawl|Z 3, i OpenOffice.org® Y = — VN THHTE L L WO FRBH O £
97, fthaoOpenOffice.org® Y = — LM SDrawZCHi L TZ' 5 7 4w 7 ZAFAk L
It R¥Fa A MCHIISA YR—FTE X,

1 OpenOffice.org® ¥ = — )L (fil:Writer) &,  [{FA] > [ 72 =2 ]
> [OLE7 72 =2 ] > [OpenOffice.org 2.xD[X[JFA ] > [OK] @
227Uy 27 LET,

Zhic kY. DrawhStcEfL £9°,

2 iz Fk L £,

3 KXo XMNAT. DrawDO A0 EIEREZ 7 ) v 7 LE T,
S HEANSCEICHA SN E T,

3.7 Mathz{#H L T2 /Exd %

NS, R¥a Xy MOEMARRERILT 2 2 2id, @S2 FnET,
OpenOffice.org Math® N7 + ¥ Tl WE. BB B LOFAHERGELR
fio>T, ZOEIBBAZIERTEET. LR Z2AF TV =7 heL
THRIFL, Mo R¥ 2 X2 MIA YR— M TEE T, Math TR L 72805
HEUE. o o749 24 T7Y =7 K efakkic. fthoOpenOffice.org K ¥ =
AV MTHATEET.
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X ==
A=

MathldGt B TIEH U £ A, MathdMER T 28U, 7971 v o7
Vel hTY, QladlA YAR- R TEETA Zho oBlUTIH S EE
s

3.8 OpenOffice.orgllB I 5N T &
EHRDIRER

OpenOffice.orglITifill7eAd > T4 VANV TWREENTHET, Fi-,
OpenOffice.orglI Z D 2 —HF B L UOHAEHIC L > THR— SN THET,
Z D72, OpenOffice.orglZ BT 25k, ZEZER P L ONEHIE, HUILHfE 5
WCFICAND ZETEET, 20 &) EWRCER 2 AFTE 5K 2%
Bt % . IROFRITTRL £3(Web¥ 1 M, BIBICABEWEE SN, B
SNDLZEBH LD, KEFEBAMIL > T DR TIINESE < 2 -
TWRuEEE S H 0 £9),

OpenOffice.orgZ > T A NIV T A =2 —
OpenOffice.org® ¥ A 7 FATICE T S 3FMl e~ L 7

OpenOffice.org® NI\ V7R — h X— (http://support .openoffice.org/
index.html)
Y=a7 ), Fa—hNI TN, 2—YEIRET A —TF L, A=V T
2 N, FAQ. B LU ER}

OpenOffice.org Migration Guide (http://documentation.openoffice.org/
manuals/oooauthors2/0600MG-MigrationGuide.pdf)
Microsoft Office & Lo fhod 747 + A A A — K 7> 5 OpenOffice.org N D11
9 5 M

Taming OpenOffice.org (http://www.taming—openoffice-org.com/)
i, —a—RA, vy bh T =w Y

OpenOffice.org Macros (http://www.pitonyak.org/oo.php)
~ 7 OVEk & RIS 2 g
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Kontactt EFX—J)LEAL VS
>

Immmi HILOKDEY 7V r—3 a Y OREEZ 1D DT A 7 T = —
ZHE L AEREHY — L TT, cheo7 7Y r—3 3 i,
KMail (&&§ A — V), KOrganizer (/] L > %), KAddressbook (i#4&cE ),
L UKNotes (/ — M) BEENF T, 57— # ZPalmPilot° oo N> KL l\ va
INA I T AL 2 LAl ¥ 5 2 &b T& £, KontactlZKDET A
7 Ny TDZENTWHLHIRICEZICHIE CE £9, F/-. KontactlF & F &F
BT N—T 7 2T —= Nl 9, AL T4 IVADT 4 VA Y T,
RSSV — #72 & OIBMKSHES i A TV E T,

Kontactld A A ' A= — 6L £9, Kbz, a~ryRoA kT
[a< > REFET] 574’7137 [kontact]&ﬂﬂb“(t%f]'@ué YL TEE
T, —GBOREREZ MR EICE, HEo T T = a & LTTIE
&<\@e@:yﬁ*%yb%%<:abféi?o

4.1 KontactD#E

TIAINVENDT 4 v R a—id, M X141 TSR RSN
Kontact™” 4 > K7 (114 X—=)NIRT LD I2, WS hEzT, floar
K= N7 7 ®ZATHICE Efllov sy a icdsbRy D=L %
B

[FHI] 2lE, LW TSI HRTo-Do. K. BEUOHHDO A =)L Xy
= VW EORNERVTREINET, =2 —A8 I 3 Tld RSSTV 1 —
RIC7 72 AL CTHKOH HiEH = o — Akl 2 e N TEET, FoRsh
LIEREFET DT, [RE] > [MERFOFRE] OIEIERL £7°,
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X 4.1 WEPFRRSIH/=Kontact”V + > K

File Seftings Help
= O e

ﬂ Summary for Tester Wednesday 14 Mar 2007
Summary B}
2 © c
Mail - i .
Today Documentation Team. 4 .44 . 1300 Novell in the News
Status Meeting

Ty
[ Qutlook Vs. the Others: Business Email Clients
Gontacts Whither the SUSE Exodus? Novell's Linux
Business Soars

[#80% Finish Kontact Documentation ends today | Novell, Honeywell Get Physical

t\i)z Novell: Word, Meet Open Source
2 . .
To-do List Novell Linux Desktop Cool Solutions
— Install Mon-RPM Applications
Mo special dates pending within the next 7 days
Get Published by Movell
Journal
%ﬁ — ©penoffice.org 2.0: Creating a Table of Contents
I\icte‘s ":) Creating Bevels in the GIMP
S Local Folders/MBOX 7338/ 7345
[F=3
Feeds

%

Synchronization

4.1.1 X—=J)b

FERD 7 4 )V ZHIRICIE, HAD R =)V T IV F (A= )VRy 7 )0 5%5 U
ZRBHY, Ay - VOB KD FoREhE T, HEDT 4L
BaBEIRT LI, TOTANETEI ) v I TLH20TT, TOTHINVEN
DAy 2=V, FEOTLU—LICFERENET, 74NV THOAy -
OHRE, 7TV =y a v VRO TICH D AT —F AN—IZH 5K
RENFET,

BFERA vV, EH. BLOZEHRD, HHlO~Ny ZHEIRICERR
INFET, NEDRAy =27V I The, ZOXy—-IMERS N,
Ayt —=IY 74 KNI RENET, o R LS., %EE, HE:R
DONWTNEI )y I THE, Ayvk—ThkY—NTEET, BUEERS
NTHLEAvE—=VDORFIE T4V RIDORAy -V T L —-LIIHKREN
FI. MET7 7 AV TR T 7 AIVIEH L T HSMIMEY A 128D
T A —YORRICHLTA AL LT, A T4 THRREN
7,
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SFESFERAT A ZATITEMHH LT, Avk—=JII—2 2[5 &
MTEET, AT —F2A2LETHICNE., [Xvve—2] > [Xyb—-2%
2] BERL T, ZOMREERFAIE. Avv—iC THEE] © 2.
L] REDAT—H ALBDYTCHLZ N TEET, LezlE HATEE
TFOHEER Ay =V AT RT LI e NTE LT, MFT - [REE]
PAHT 5. FEDKED A vy -V BT 2RoRTtEET,

4.1.2 BRI

CoaYyR—2x O o7V —LI21E, BUEEMR 7 KL AIRICERR S
NTHLTRCOT7 RLABNRRENET, ETo7L—AIE, 7RLA
Mo, SADBUET Z T4 T EIDMNY A MNREanET, HAlloo L —
L, BUFEIR SN TS FoREnNE T, Fch o —2ff
HL T, IFEDHREEMTTEET,

413 hL 4

ALV A Ea—E BlRoOT7 L —-LIHhHENTHhET, 574V b Tl
SHONSI AV B EEL TV —Le, SHEOBRETEESL T L — L0
RENFE T, To-DoV A~ BEDA Xk F/=1dTo-DoDifflldrw. BLO
TNZHOREZ RT AL FUZ R bH Y £T, YloFrEERT 21213
V= WN—F 20T K] Ama—FHHL £,

4.1.4 To-Do List

[To-doV Z ] 12iE. Z A7 DY ARNBFRRENET, URRNIHLWE R
7 ERBMT5I1I2F. RCHLb 74—V ERE227Vy 7L ET, BEOY 27D
a7 ) w7358, ZONOHA2EETCEET, ¥ AT 2N OPDH
THRADICRETCEET, YT X AT EAERT BT, A7 2HI Y v
LT [#HHY 7To-Do] %#ERLET, ¥ A7 MDA LICEHY Y THZ LY
TEFET,

4.1.5 H:EE

[Tv—F ] TlE FAHE HkFE FRIMHBRE2RET 2521
MLET, AV F TV —LDOHTHICHZER L,  [Add Journal Entry
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(Fy—F N NIDIEN] 7 Vv 7L, LY MY ZIBNL £,
R ZHICHISHT Ay —F IV MU BT CIHFET A8, Ho
TUV—LNTTNEZWELET,

4.1.6 X¥E

CHOAVKR—F NI, HAESCLTUEHL Y., KDEZ{FHL T4
Bl AT LR LUV ADKNote7 A 2> #if{T5L. FAZ by FITHFKRE
N5 k512720 £9,

417 24— F

[Feeds] *7 4 >~ R3320 7 L—LcHE s ThEd, EHIORSST 4 —
Rov ) —ta— 4 EoERoilHE) AL, BLOG FOEroilHe 2 —
THREINTWET, Y —-Ea—T74—FR&7 )9 7L TZThERRL
¥, 74— ROEH, fE. £23HBEITIICE W07 — Reh
2V 7 LET, YU —Ea—HNOTANWEELEI ) v 7 TDHE, HTLn
74— Roibfil, $723207 2 VIHOIHED 7 4 — ROBEH DO A =2 —
MEHE £,

4.2 X—)b

Kontactld, W A — )T iR—3% > bh& L TKMailZ AL £9. KMail% 3%
ET AT [KE] > [KMailiZE] OIFIERL £9. KMaillIbEEE =
BREFA—NIIAT7RTHY, ZloTabha)VkdR—FLTHET,
[ =] 12iE, AR A= )L 2 E T 5 DICHET DN DDy — Uy
HYFET, [MFE] ZHEHTLE. Aok —VEFLIMETEET, [7
SFANALT f = N VIANERREHET A =NV E 7 4 IV F T 5D D
B — VT, [T FO R = K] ITEFA=IVT 4 IVAAT ¥
FEERLET, 202207 4 F— Rtk DO ANRLBE LT 4 LA
VI hr =7 eHEILET, Chood Ty g VEEMMCTLHEEE. AN
L7 4 W ANTIT B 20 i Ny r =% 4 VAR =)L L TL 72
T,
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X14.2 Kontact?d X —)L 22— 3>k

File Edit View Go Folder Message Tools Settings Help
ud=whm9008@w
=) |Folder ~ | unread| Total | B Ssearch: | status: | € any status [-|
summary | © -L‘"a‘ Folders Subject [Receiver |
£ inbox -
. =Hey Tux Penguin
Mail ent-m
oo |& trash
C(;) / drafts
Contacts L searches
Calendar Meeting today?
@ 0 |From:Tux <tux@example.com>
To-do List To: Geeko Lizard <geeko@example.com>
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KPilotd T2 HH X, N RV RayVa—2o7 7V r—v gy Zhic
ST BKDEY 7Y r— g Vo5 —4% oG T9, KPiloticl:, A EE a2 —
7. 7TRUVAE2—7, BEOT77ANA VA= BPAEFNTHET
N, NS IFKPilotRIELMNACIEHTE EA, L2L 77 AV A VA b —
FRMOT, TXRTOMREE., W7 L/ZKDEY 7V r —3 g » CHEBT
xET,

KPilotid, N> R~V REHOFT A7 by TF7ar s LEoifezar Yy b
&> TIHEL T 9, KPilotH KL, 2202 Ea—F TN, Al DT —
MRS 5T a5 T, Ny R RO EOKN4N5cE 7 A 7
Ny 7arbEa—2THHATLINE WIETEa2 Yy MEFMCL THE
TLLERHY T, 1FeALOEG, a0V y MIFFEDKDET B 7T L
EDWE L AR SN TWDLD T, %, thoF 27 by 777V r—
Yary Tl TEERA,

A2 > Yy ME, 22— PDINB\NSORTE L T VT LR 00T
kg, ZHBEIERED =Ny 2 75y RTCT7 254 T{bsh £
T Ry T —=T ALY —=NEHHL R oIThEZEBETsarta—
S ETCLHEMLTEEEA,

KPilotic L5/ R~V Ra v ¥ a—& ola) i
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EIZBIGET 2. oYy "R LT 7T 4 Tfbsh, F— 2k z R
TLET, EHARCE 2B H U £, HotSynci®fElL, 2>y MY
HHLENTWETF—=F DR ZEIEELDITH L. Ny 77w THEEEA
YRR EICKR SN TR TOT =2 D58y 77 v T2 FATL &
R

HVE AR ERRIC —ED 7 v A VRIS 20V y b H LD T, RIERRIC
HIET 57075 L%/ 7 L THBLRENSH Y £9, FFIC. KOrganizer! L[]
HHE ST AT L 2T Z S0,

6.1 KPilothMEAHT 52T v b

KPilot Cil CE 5 a Yy b &ALl TRET S, [E] > [KPilot
ZiE] OIISERL £, LITTIE W oroFEEZRa Yy &M
LE7,

7 KL Ak
ZoayYy ME. N RNVROT RV ANRE OF — 2 ARz WL L F
9, Z ORI EE T LZKDEDTILY 7 - — 3 a3 > I1ZKAddressBook
T9, ZhiE. AA v A=a—F7zldkaddressbook A~ K&EHH L
T L 7,

KNotes/Memos
ZoarYy ML KNotesTIEIX L/ AEEZNY RNV RDRAET TV
= a ICinELET, ZOKDEY T —3v g ld, AL A= a—
¥ /zldknotesa~ >y RZMH L CEEEL £7°,

Calendar (KOrganizer)
ZoarYy bME. N RNV ROVINSCEA RNy MEEIIL 7., =
MUTHHET AKDEY 7V /r — ¥ 3 > 1dKOrganizer €9,

ToDos (KOrganizer)
ZoarYy ME. XAV (to-do)7 A T L EEML T, 2T S
KDE7 7'V /7 — 3 3 »1FKOrganizer ¢ 7,

REAEhGE
Zoaryyy NEHUET 2 &, BIIRERRCANY RNV R 78y 7798
TAY Ny TaAyEa—Foray ZiIlGbtCHBINET, Zhld
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F2AZ My TavEa—2 D7 Oy 7HS, B A LY — N2 ko THE
ICEIESINTWAIEEORBEIOL £,

X 6.1 FAHajgELR >y NPEKIRS W ES 1 7

= General Setup Conduils
Device
HotSync
Backup
Viewers
Startup and Exit
T
F KNotes/ Memos
O NotePad
O Time Synchronization
E Calendar (KQrganizer)

[0 MemoFile Conduits are external (possibly third-party) programs that perform synchronization
D Palm DOC actions. They may have individual configurations. Select a conduit to cenfigure it,
E Addressbook and enable it by clicking on its checkbox.

E TeDos (KOrganizer)
E System Information
B MAL (AvantGo) Conduit
O mail
Fl instail Files
About

Vv oK X Cancel

6.2 /\ R~V REEFE DERTE

KPilotZ ffi 9 2121%, 1ZL®IC. Ny RNV RavbEa—F L ofHie .y
7y 7 LET, HEEZ N RAVRTHEHATLZL—-RIW(Ry X7
=y MDY A TICE->THERY £9, 7 L— RIUIZIE USBZ L— RK)W(r —
TINE T TIVY L — R)V(r — IO H Y £,

6.2.1 KPilot T DIE#t DEXE

Pz y b7 v 7T LR OHGITERL RHEVA V- FElfTLZ e
Ty, UT&FITL£7,

1 [R&E] > [Configuration Assistant (;RE 7 «+ ¥ — F)] DIAIZEIRL T
T4 = REREIL £,

KPilotlc L5/ KAV Ry ¥a—2 ofa)if
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2 A—PLEBILUONY RNV RSN TO L7, 2D %HTZ ATJL
EJCIR

3ROA T ardrboloEERL 79,

o U4 Y= RIINAY RV R Z g S 720551,
[Automatically Detect Handheld & Username (/> > /\ L /\ Laz—H
g2 HEMeH)] 28R £9, BEmEICKRIL 25513, 6.2.20H
ww@muyﬁwﬁﬁjam&%VvaLT<téw

« FEEET HICE, [AN] 22Uy 2 LET,

4 EINCHAT 277 ) r—y a v FEL £7. [General KDE-PIM
suite] (& 7 4V ). [Evolution] . [Nosync,justbackup] O 176 58
NeEEd, 77U r—varez@®ElLes, [Z7] 270y 7L<
U4 RUEBFCET,

6.2.2 /dev/pilotV) > & DYER

YUTINY RNV RT L— RV Dt v 87w 7 ik USBZ L —
FW®i GLELVET, EHE507 V= RKUVEHFHL WAL
T\ARWpumawi%m@yyﬁUvﬁUVﬁ@W&ﬁ%?K&é:k
WHY £,

USB
iHE,. USBZ L — RIVITHEME ShE 720, Fidov v RYyw 2y
EAERRT BT H D FHA.

v U?Ub
U7 L= RIVoGEE. BERICED T Y 7R — MIdEimE T
é@b%ﬁﬂ/\é DB V) F9. YUTINTNA AL, /dev/ttyS? e
W) LRI O NTHET, KBAOR—NE2HHL TWbL TN, 2D
AL, /dev/ttySOTY, H1T VU T7IVAR— MIfgmehTnb 27 L—R
Wty N7y TT5HI0E, Koa<wy Re ATJLET,

In -s /dev/ttyS0 /dev/pilot

KDE == —#J7 A R



6.3 KAddressBooka > v M DRE

AIE. T 7 4V N XIE R AL HE T IIKAddressBook 2 > ¥y M EHINIT 5
ZOTHATT, JIRNcT — 7 ZEIMEL 726, RICGGEEZZREL £, §if
GREDEIE, Ny 727y TTF =2 RX=2ZDRIFEH T N2 RV RICRE &
NTnb7 4 —)L K%, KAddressBook?d 7 4 — )L RKICED L HICH Y YT
M REDNEREFEL T,

6.4 52V (to-do)7 A T LAV
NEE

KDET A7 kv 7Tl to-do(¥ A27)& A X2 h(\97\'5¢#])A KOrganizerlZ k-
TEHENET, o777V r—v a2 id, AL A=a—F 20T
korganizer 2 ¥ R&MH L TRENT 57, £ 72lFKontactd —if & L Citd
fiL£7, KPilotdH L > ¥ Lto-dod 2>y MBS LR, A7 g
ZHRELTHSMHL £,

X 6.2 KPilotDiE

[ ToDo File l Conflict Resolution | About |

Calendar file: | Browse...
Sync Action

&) Fast sync if possible
O Always do a full sync (may take some time)
\CJ Sync only Pilot items to PC (next sync only)

) sync only PC items to Pilot (next sync only)

|®| Sync archived entries to the PC

) (% _cancel

KOrganizerlZ, 7 7 f V% ~/.kde/share/apps/korganizer7 4 L7 K1
WAL 9. LA L. .kdeT 1 LZ MUIREU A RTHBE > TH5HDT,
Ty AINERTA 7R TIKRINBZNZ B 7, ZoEG. Ten
2% FENTANTEN, £2ET7 7 ANVERY A 77 TRLT 7 A WKy

KPilotic LB /N> R~V Ra v ¥ a—& ola)il
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N7 7AWV eForT 5 LIRSV B T, Z0720DFT 7 4 )V b
DY a—bhy MI<F8>F—TT,

~/ kde/share/apps/korganizer7 4 L' 7 kU ZBHu /2 6, KOrganizerWSh L >4
Tr7ANVELTHHTEL 7y ANV EERLET., ZoOflTlE palm.ics
Ty ANTY, 2—=F D tuxDy G, 5T/ SA %l /home/tux/ . kde/
share/apps/korganizer/palm.icsiZZ V) ¥ 9(X 6.3. [KOrganizer®d 7
VBT 7 AIANDNA RS A 707 ] (154 N— D) BH),

X1 6.3 KOrganizerDA L > 57 7 £ WNDNZZRT I A 7ar

EGeneralsetup | Conduits-ToDos (KOrganizer)

To-do Destination

Startup and Exit (®) Standard calendar

() Calendarfile:

[ Time Synchronization [%] Store archived records in the KDE calendar
E calendar (kCrganizer)
O memoFile
O paimDoC
E Addressbook
2l eoce rorganeen
F system Information
FF MAL (AvaniGio) Conduit
O mail
E instail Files

About

NV RNV R E DT — & B ZKOrganizerl 3 FR(T L 72V T L 28wy, F47T
% & KPilotlZ[aHFAFITRIL £7,

6.5 KPilot{fFH

KDEY 7V /r—yaryor—421% RN RNV RayEa—42075 —
Z LA cE £9. KPilotxLEIL., 7 L — R)LDHotSyncR % > 2 L T[d]
JAIRE R B3 2 7200 T,

KDE = —#J7 A K



X1 6.4 KPilotD XA >4 > RN

Version: KPilot 4.6.0 (blivit)
Version: pilot-ink 0.12.0-pre4
Version: KDE 2.5.0 Level "a"
Version: 0t335

' HolSync Log

08:29:23 Starting the KPilot dasmon
08:29:23 Daemon status is "not running'
08:29:23 Pilot device /dev/pilot does not exist. Frobably it is a USE device and will appear during a HotSync.

g
g
:

Fa

File Installer

o
I

Generic DB Viewer syncprogress | 0% |

6.5.1 NRANIKRDF—HDINy I Ty T

RNy Ty TERITICNE [ZrAu] > [Ny 277y 7] DIRICIER
LET, N2 7y TEROEIIREFOBRCFEITSNE T, ZTDR. A=a—
e [Z77A0] > [HotSync] DIFIZEIRL CEEOEINCRL 9., Z£9
Ledhud, RoEHHEEORRIC, R OMM L5784y 7 7 v T LR
ITEhET,

TN I Ty TERATIE NYRNVROTRTOTAT T LE T —H N~
A3~/ . kde/share/apps/kpilot/DBBackup/USERNAMEICHHN S E T,
Z Z°C. USERNAMElE., NY RNV RICERINTWL2—PHTT,

KPilotlCIZHNKE =2 —7AR22H ), 7 KL AL AT 2 MHICIHELT 572012
HHTEEFTMN, BRICZoT -2 2HENTLHZLITTEEREA, BN
JZKDE7 7V /r—3 a0, X562 k) 2 FIcillL CnET,

KPilotlc L5/ KAV Ry ¥a—2 ofa)if
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6.5.2 N KRNI RADTOISLDA VA
N—JL

[Z7ANA A —=F] TV 2a—)VIE. N RNV KT ILE 4R
N =T B =R TERIKZENY — )L TT, Ny RNV RTar s Lodl
RTIE IS .prc . N RANIVRICTY w 7 — KR35 ¢ SISiKfL $
T, oL KA yITarI LEMHT LA, BT AL
B2 38 L T 72 &0y,
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KopetelC k514 AH VK
Ayt—I00

KopetelI > I A4 v Aw =20 77 IV r—2a T, A2 —%y MC
Hft S T B EMDO N - R F e HEWBCF vy b T2 CEET, Bl
=i CKopeteld., AOL* Instant Messenger (AIM), GroupWise® Messenger, 1CQ.
IRC. Jabber*, Lotus* Sametime, MSN. SMS. 3 J U'Yahoo!*7% &, —fi%h] 7%
TRTCDAy Yy =T h Ve R-FLTOET, *

7.1 KopeteDixE
RANeF ¥y NTLHANS, TAD Y NeXHET HLENHY 7,

1 Alt+F2%f L. kopete& AJJL T. KopeteZfC#/|L %7, KopeteH i
FIL e GlE, 2Ny 77— Ykdenetwork3-InstantMessenger/iA
VAR ENTNDE Z L ERERL T ZE 0,

2 KopeteZ {1 TN T 235 51%, BRE T 1+ ¥ — K FRSh, 2—H7
07 7 AINVOVERE XEL £9, £721% [Settings] > [Configure]
DR L £,

3 [Accounts] ZiERL T, VARNDPOSEHRL TV A v N2 ZET H,
F721% [New] 227V v 27 LTHLOT o MEERLET.

4 Aot —Y Y- 2 ERL T, IS SHUIKADMERAL T
WA —E 2RIk THRED FT,

KopetelC Kb AV AZ VN Ay =TT
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5 Xy —V U —EATERNERSh, 2o —v207H 72k
ME AL, [Register New Account] % 71 v 7 L £79, B/
TIUH T4 RYT, BT L5 —2% AL ET,

6 KopetelC (R, Xwt—Y IV —LRADERTELILT —F% AJ]
LEY, 2—YF5—FIdEE. =v 7 x—LFLTEFA-NVT RV R
ENAT— RTCHKSNTWET,  [Finish] %7V vy 27 LT, ThY
VhOFEETTLET,

THAD Y NeFEL TR, Fv v MIFoWEIZIBENT 2080850 £7,
WOPCICT D > Nk L THL5EE. ToT -2 %4 AFR—KFL, i
WD 2 MICHENGENT 2 2 W TE 9, g lcoTy MY 2 FE#)T
VERR T 5121E,. [ZrAn] > [>227 N&iEN] 2270y 27 LET, #
LWP Y RAE VY RDFIRENDL DT, ZHITHE- CHlifglezElk L £9. L
L. WAt E U A MIIEMT 51Cid. 4> 7 A T, Kopete CIERL 7= X v
-V Y- T A LENDH ) T,

7.2 RAEDF+ v b

oz NELF v v N2TDHIE, A 07—y M T 2 LERH D £
I, Hiwl =6, [Z7A4] > [SetStatus] > [Online] DIEIZZ Vv 7 L
TAT = A%FELET, ZHITED. Kopetek, ERL/ZAy -
TYH— R OMOIF L SNET, ar A I T6 e, thoa—
YIRS RADL IR £7,

AL DT TV — a0 2 RCiE, Wi ) 2 8 3H Y £9, i
DaA—H & F vy hTHIE, HELDLETT, oI D~ — 703
WTWBHIEEE 7 ) v 7358, Ama—0RE. A7 3 UFoRSE
NEJT, Zoa—P IR —VEEETLHIN. Fyrv by v arzflh
L¥ET., Fvv boGElE. tosinEz v 7V 4 LoER AL
FT. Fryyv by arolfkENtyyare&7dsL, TRXTHS
& & ORI T L £,
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X71 Fyvhor 2 RNo

Eile Edit Settings Help
@ ] 4
AT —

[ Geekos 2i4)
g=6mupt1ﬂ) Chat Edit Format Tabs Settings Help

Q@Pengums (811 & e ok L” 3 / @ o
. g vv g

J Frank &

{0,
JKarl & L

=
',13 Klara @ ul &
r« ) Toms &)
|‘gScmt@
) Tux 10:17:38 am
Hi Karll
) Karl 10:18:08 am
Hi Tux!
% g
how are you?|
One other person in the chat

PIRIOF v v by > arzfond 5icld, Mgz R ¢, [(fWE] >
[View History] DIFIIERL £7, ZOXA=a—THHZERTL L, ¥4 7
O MFEREN, TOANEDF vy by Y gy oMBTEFRTIMTAET,

ot 7y g v B2#FoRTLHICE,. 2=V LE2HEZ )y 2 LET, Ry T7 vy
TAZa—PRE T, EERA T aiE Fryv T4 Ty arEk
AT 5729 D [Start Chat] T, [Rename Contact (1EAELD ZHIZE)] &
[Remove Contact (,@fgff@ﬁ/fﬁ?)] PRI E, TN ThoOREEITA F
T, Ry T7y T RXA=a—1FFEk, 22—V ELOFXKREINLIY T A=a—Y
Hy, 2— %@7m/ﬁ%J PREWMOMEZTAFET .

F4w T LEIOFY v b3 vyoRIO-L

EDOF vy 2y gy THAVBMZENZDHY G EE, H8T
VUL TE) —EF vy b g VRS, Alt+ —F 721FAIL+ —
LRy yarveArsa—- VL ET, £20E VU AN—=DKHIT A
ayEMHL T, AlRICAZa—= VL7,

7.3 KopeteD AR TA X

Kopete Cld, =— RICEGDOETHAIA R TCELEEEE ATy g 0W
HVET, Ko7y arTIEWLD2PMNL £T,

KopetelC kb A VA7V N Ay =TT
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7.3.1 Z)L—TDiBH0

VA N oiifgdeh 70V —T1T 5 e WMEPDNY R £9.  [File]
> [CreateNewGroup] %7 V) v 7 LEd, ZV)V—AICHIEZIFEEL. [OK]
27Uy LTCHEEL £, #AELY A MIH LW T 2V EDRORES N, 2
NEMHL CEELE/MNTEET, BELE. K977 Ry 7T
Moo )V ZICHEICE £,

7.2 KopeteXA >0 > RN

File Edit Settings Help

3 2. &%
B Search:| |

5= Docu (7/10)
i2)Berthold ®
2 Frank @

2 Jana ®

2 Klara @

{2 Scott ®

i Toms @
faKarl@

) Jakub @

) Rebecca ®

2 Tom® @

=S ®

DN —TL, [FE] > [ZEp I — FoIER ] OIEICERT NS
AN CE$9,

7.3.2 7 O—/N)LEBRIISERDE

KopetelZ & D7 7 > b %a%if% RAMEESE A Vv —T
OhaVzHHLTOHLEEICHERTT, 71 ka1 E@OBNER
PVERT A DTl L, rﬁﬂ*AWﬁ%ﬁﬁJ% LETXET,

1 Kopete C. [Settings] > [Configure] % SR £,

KDE = —#J7 A K



2 WET 1 v RUT, akflltg#R%e R L C [Enable global identity] % %]
ICLET,

3 [NewIdentity] %7V v 7 L TrZa—)ViRIERO GHIEZ ATIL £
ER

4 =y 73 —LRXFHEL L, HAO@IEROFMEZEEL 7.

4a [Nickname] % 7C, HRAZ L=y 7 3 —LEMHHT LN, Yo
Kopete 7 717 > N THREFH D= 7 2 —LE T L0, f5EL
£7,

4b FHZIBEMT 512lE.  [Photo] B T DF T a1 o%E#ERNL £
7,

4c KAddressbook CIEEL 727 — ¥ 2 H T 51C1%.  [Address Book
Link] # 7\ &7 27 ALEY. [Change..] 27 Vv 7 LTV
ARMHT Y N EEIRLTC, [OK] #7 Vv 7 LET. ZOk
[Nickname] ¥7-1% [Photo] # 7\2RV. ZZT7 KL AMWA T
varvEAMMILET,

7.33 HEOEE

Kopete ClE, HTLWT—<DA VA R—)b, F¥yv hT 4 VY RTDAT A )V
DEH, NT—eTr 2y hOEEMNTEET, HEEZEET LI

[Settings] > [Configure] %R L T, [Appearance] %7V v 7 L £,
PITMi22oofilzxL £7.

WLnwr7Aarys—<DAf A=)
[Emoticons] % 7C. [GetNewThemes...] 27 Vw27 L. 4% —%v
EPOHHTELT YDV ANERRLET, 1DFREFEROT—~
A a—RTHICE VANPSZ Y N ZEIRL C [Install] % 27
Yo 27 LET. [Emoticons] 7 7DV ANMIF LT —<EM&NF
T, 22T HNoFT—<%2EIRLT [Apply] #27 Vv 7 LET,

Fyvvw b4V RTIDAE A NDEFH
[Chat Window] % 77> 5§ T & HKopete A % A )V 51EIRT 57, F
72T L WA Z A V% [GetNew..] TH 7 >a— KL £,

KopetelC Kb AV AZ VN Ay =TT
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7.3.4 BRIDKRE

Kopete Cld, AR v T4 VichholzZ e, AT7TA VIl sTzZ k.
FLFAyE—UNEE LI, AXYMOTTLHMEZNETEE
v;‘o

FFEDHEIEIDSTA T4 Vo & & Tl 512d. DI ToFIEIC
EWNET,

1 T RTCOIES A Kopete™ 1 > RUICHRREN TV D Z & Zhfid L £9
(TRTIDBFTIREN TR WIGEIEL. [Settings] > [Show offline users ]
gL £ 9),

2 AT LSRG ) v 7 LC,  [Properties] % i#{RL £7,

3 [Custom Notification] % 7\ZF4#L C. [A contact has gone online] %
ERL 97,

4 ZDOAXRYMIFLTHEITT ST 7> ar%, [PlayaSound] .
[Display a Message] . [Start a Chat] ¥ 7-1% [Suppress Standard
Notifications] MOIEEL £,

5 [OK] #7 Vv 7 L CHERIEREL £,

T AN NOWMA T g v EEETHIIE, [Settings] > [Configure
Notifications] % #IRL £, HELA XY M 2Rl T, WHFKEEELEL
F9, e AL HRIEOWTNDNT VT4 VIl FICY T U RT
WSS & D12 T 5ICiE,  [A contact has come online] %R L T [Play a
sound] ZHEIMILET., vV Re@ERLT [OK] 27Uy 7 L TREY A
TarsEEHCET,

7.3.5 Kopete 75 51 VDHRE

Kopete Tl T v v M v ¥ g > OERZLRISEED ® V. [Settings] >
[Configure Plugins] /&7 7 A TEE T, /e AE. TF A NOHIE
i, RERAyE—YoE5l Ay —VICHLOH LN LEDT
FARDONATA N, LaTex7 # — < v hADZER Xy — TV OFERR & T

KR
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= =E
;’.zl Eqéﬁﬂﬂl|ﬁgg§§
Kopete & F+ v b DFEMIICDWTE, LI T OWeb¥ A N TAFA]EETT,

Kopete D7k — L X — ¥
http://kopete.kde.org/

Fxv bty yarTILMHINLIEE
http://www.webopedia.com/quick_ref/
textmessageabbreviations.asp

KDE [f % =%y &y NT—=0] Tr—F L
http://www.kde-forum.org/board.php?boardid=34
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Ekiga T M Voice over IPD{E A

BT Vala=r—ygd, BICEH 2T R0 2EN%T LD
CIEHVERA, TRARN A=Y 2L, FRHIET L ELEEZ T
CELEENET. n—-3I 0PIk T 10 OEHE S TR IS T
X ¥, EkigaTlE, 25 OREELZ LinuxT A7 v 7L T 71— KA
VROV =3y NTHETELLDICLET,

B AR, LITOEM 2L CnbEZ &Rl L T E &,
s U R RENCRESN TV D,

e Ny Rty hFERIIAZ A —h—Na L a—F|TiEmIN T
%)O

« W OBEEEERRIC Y A Y IVT HICE SIPTH T Y RAWETTY,
SIP(Signaling protocol for Internet Telephony)l3, Er=H LT L EXFEFE /2
Fa— VRO y ¥a VREICH SN, T ha Ty, Ty
DY APMIDOTWIE  Thttp://www.voipproviderslist.com/] %
ZHL T &, BED b T A 7I)VIE, http://www.voipbuster
.comMH AFTEET,

« FLELAKDEE. WebI AT a L Ea—21THamL £7,

EkigaC ™ Voice over IPOffi ]
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http://www.voipbuster.com
http://www.voipbuster.com

° E}'L
8.1 EkigadDixE
EANCHCENT 5 & Ekiga®D % E T ¥ A% > NSHE. Ekigadd { VA X AD
EICDE R TN TOT — BRI NE T, EBkigak XET HI12lE. BLTo
FIICHENE T,

1 IV —UL(&AIE %2 ATIL £7,

2 ekiga.net 7 AU T =2 % AT 50, Fildekiga.netilE
Lz 2Rl £97,

Worhyy N2 TiENT 5121, [Edit] > [Accounts] % {JiJH
LCHELET,

3 Y A TRIEEL £,

4 EkigaCIHEECED LT 277 A7 I — VDI A THIFEL £
7.

5 T LA T4 A=V EEIRLET, T 74V bk
[ALSA] ZfFHAL £9. Zhick-> Ui SEPRIES N E T,
0SS7%: & D Z DidH 7 > K2 A5 LIFESUSE Linux Enterprise T (i
HTEEHA.

6 A —T 4 ADANTNA AL MNTNA ZZERL T EET A B
LET,

7 BT ARV OFERE LT, [VAL] ML £7.

8 BT T DASITNAALRERL T, EELTANLET,

9 KEDHEZMEAL T L £,

10 FXEL LT L RICEBRIVKIL 7215513, EkigaZz FIiCE)L £,

Ekiga ClZEB o7 Hh 7 " EEHTE LT, 7hU Y b2iBML GYET S
WiE DIToFIFEICEC £,

1 [Edit] > [Accounts] Z#B=. [Add] #&RL 9,
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ekiga.net

2 [Account Name] % EIRL £

3MHATLETHhY Y by A AU, bt e b a2 EEER0 £
9, Wl [SIP] IR £9,

4 BifSc% [Registrar] \C AL 9, ZhidEE., 1> ¥—%v hT L
T ==Y —ERATaNA, FPEET HIPT RVAE IR ANET
T TanNAEIFELIET 21> T, 2—HEe NI T — N& AS]
LET,

5 [OK] #2797 L TEEIATOTEZRT L, 7hoy NEH

L 9. EkigarA{ >4 ¥ RNFIRENDL T H 7> b OIREEN
[Registered] \CEHEH S NFE T,

8.2 Ekiga®d 1—H A V4T 1—2R

Ekiga® T N T OWEEIE. A=a—N—o I TE 9, EERMEEL.
oY —=NN=12H by a— Ny MR — ol AEbeIc L > TE
FAcE£7,
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X 8.1 Ekiga®D=2—H4 >4 7 x—2X

Call Edit View Tools Help

Standby

Registered accounts: 2

l L 2anc 3 get

l 4 ghi 5kl 6 mno

l 7 pars 8y 9 wxyz l
| : sl
Dialpad | Audio ‘ Video | Statistics ‘

A—YPA U F T2 — AT EESERE-RDBHVET, La—20EL
5I12lE. [View] > [ViewMode] B 3O [View] > [Z2> ha— i xgL]
AT L. £REGUIOEICH 22 —F— R7 A a0 NIChH D&
BT %R £, [Full View] #[X8.1. [Ekigad) 21—+ A >4 72— A
(168 X—=NIRLET, VY= NAN=DTRXTDOT A ULV — IV TF v T
HY, ~OARA v ETA Ay FICEL EFRORENET,

2—WA U HE T 2= 2D ENS, XA YNy K =T 14, E5F, i
FIOKSBER T2 IDH 0 £ 3. [Audio] FHER ED—TFDPEIL, WG
ICOBREHETEET,

Ekigad ¥$RED %2 {12, ¥ —R—Kya—bhy CHHTEET, K81
Ekiga®d ¥ —HR—R¥a—hhy b (169 X—NIELE R a— My b &
FLOTHY ET,
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# 8.1 Ekiga®F—FHK—F>a—rJv b

Culy—4o VR Bk

Ctrl+0 HEOESTTCa—VEKBL £7.

Ctrl+ D WEhZ KT L %97,

Ctrl+G BEoa— VveREICL£7.,

Ctrl+T BlEoa— V&2 oMFIcizxEL £7.

Ctrl+5 BiEoWfgz N— K574 27 1R FL T,

Ctrl + W Ekigat—% A % 7= — 2% £7,

Ctrl + Q EkigaZ & | L £79,

Ctrl+E THY b3 =Y % 2R L ET.,

Ctrl+P [Ekiga Preferences] OWIE#FHS £¢, 2o ¥ A
717 T, Ekiga® X Ex i cE £,

Ctrl+ + Web) X 706 DEIRICA—LA L ET,

Ctrl + - Web1 X F7/0 6 DEFICA—L7 T R LET,

Ctrl+= WebH) 2 T OFFHEY A XD Y £,

Ctrl+F Web) A Z DLHEMFREZITVET.

Ctrl+H a— VL2 FRRL £7,

8.3 {|EiEaMmIT B

Vo 7o ABkigak I L < BET UL, EEHEE RIS T L S N TEE T,
1 A=a—FkiFa~ry R4 0 SEkigaz i L £,
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2 [SIP7 RL ] Juary7 NI, WEiFoSIPY KL A% AL £,
7 RV ZIFRD LD ez Nice ) £97,

« TPRRE O EEREE D G sip:username@domainname ¥ 7213
username@hostname

+ sip:username@Rdomainname ¥ /zlfuserid@sipserver

SIP 7 T NA FINFERRDEEE X B 008, sip: <@ >D k9
WCES 2 ANTAERET TN ET,

3 [Call] 27V v 27T 50, FlECrl+0% AL T, MFAvESEICH
LFTCHLET,

4 HREEAX TSIV [Hangup] %7 V) v 7§50, EdCrl+ D&
AL ET,

HaEHICY 7 > RONRT X =5 (B 5 0N E U EI1lE, [View]
> [View Mode] > [FullView] %7V v 27 35&, E6ICEL DL T g
M@ L4>DF TNFREINE T, 28H D [Audio] % 7121%.  [Playback
level] & [Recordinglevel] OF 7 a3 7, LEICHGDOETLIL
BATAFTHEL TS0,

8.4 EiFlC LS

Ekiga CTlI22o 0 i CERGICH 6N ET, 9, 2—W|LEEsip:userfhost
TIFOH I ET, T3, SIPTan A ¥R CHEZEL £9., 2L 0SSP
ONA F G, WE OEEOE S VoIP Y H1 7 > MG 22T 6 d kD
ICL TV E T, BkigaWEfT SN T b — NI T, HEa— ol
FIEEH Y 7,

WHEOT TV Ir—vay
FH1E1E, Ekigah’ T CICEIT SN TV DI EICO R, T ULET S
SEMTEET, HEEE Ny Ry 32—l xas
T, Ekigak FATL COine 323, Eifiez<5 2 LI T3 A,

INAINVT T Ly b

%, Ekigadd N )V7 7Ly MMEL A LV R TEIELTHBY, H b
FHA, SNFEEPAL LT SITRDEDITEDY £, Ekigad A A
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YU Y RUMHE Ny Ry FEREFAE- ST LESH 2
AET.

FHREICTDMI W26, [Accept] 27V w7 LT, GBI TREL T, &
SR 72 < T BIClE, [Reject] 227 ) w7 LET, a— L& foSIPY
RUZICHRE T2 8 TEET,

85 7RLAWRZFERT 3

EkigalZld, SIPIC L&A BT H2REEH D £, 7 R L ZAMRZRI<IC
\X. [Tools] > [Addressbook] DIEICZ Vv 7 LET., ZBHD YU A NDFER
SNhFET, WS EIEINT 512lE. ¥ AT [Personal] %R L £9, 7K
VAT 4 Y Ro%E4527 1)y 27 LT, [NewContact] Z##IRL £9. £/
Crl>N%ZifL £7,

Haedigdeicix, IToxTy MU BSRETT,

EEl|
WSSO ARIZ AL ET, FUr—L b ASJTCEETN, Fhli=w
F—LbMHHTEET,

SIP” KL A
WSS HNRSIPY KL A% AL £9,

EF A=)
M, HECOETFA—IVT R 2AZ AL 7,

i & A v v
T A Y Vel T2 e, KSHMTL2EFICHEICT 782 TEE
T, ZOF TV a roIERIFIEETT,

Rt
LR ORI D LA, LIS THE DA 7= U 28T &
T,

a—hLo7 KL Ak
F 7 )V KT, Personal& > LEIOT —HIVOTN VAR Z g T £,
VLl o7 RV AW PERLE.  [File] > [New Address Book] T
YERRT 2, £33 —R—Kya—rhy hCrl+BEZHL £,
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7 RV ABRD & AT EEE T A1, S ol XTIV )y J LET,
1) NCEETTYARYARYAR I S

8.6 FHIEHR

Ekiga® ANAR —LX—Vld, http://www.ekiga.org/TY, 2OV Ak
Tl KL HLHMANOEZDIZN, LV~ =a 7 VEFHTE £,

Linux COH323E ik 7 b 2 )oY R— ~k0ifflllE, http://www
.voip-info.org/wiki/view/H.323% B L T 72 &y, VoIP%Z Y iR—
NTb7aycl NeMzT 505, £ 222K L TS,

TIAN—= NREH Ry NT =7 B ET HICIE PBXY 7 T =27 D
Asteriskhttp://www.asterisk.org/Z M CE£9, FMlE. http://
www.voip-info.org/wiki-AsteriskZ ZBI{L T2 & W,
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2y bOD—=D Y —=ZANDT YD
X

TAT Ny T, 774074 V7 MY, BEOYUE—FMRZAN FLOFF
EDOY—LRZT 7 ALY, BADT 7 ANRT 4 LI M) &Fy hT—
7 oo 2 —HICHIH S5 Z £V CZ $£9, SUSE Linux Enterprise®{ 2 [ %,

Sy D=2 HFY 210722 A L0, VY —ARERT B2 D,

SFESERFEVBHESNTOHET,

Foy b — 27 BH
Konquerorx 7 7 A V< =Yy & L CHIT L2 icky, HFHY Y-
ZRY - 2AEBIHTEET, FMlIic>NTUE 92H Ty hu—2HK
HANDT7 7 A] (175 N—=NEBIHL TLEE0,

BRI CO 7 4 VH oA
KonquerorZ ffi 5 T, ®v U= Foioa—H 77 AT 4 )V EF
EHATEET, FEOWindowsF 7z 1FLinuxV — 7 A5 — 3 3 Y Offio
A—YPRT—F 2B, HIARLLZYTELEOICLET. sl
ICoWTE, 93 TRERITO 7 4 V¥ oA (176 X— )2 B L
TLZEWn,

Windows~ 7 A )L OEFY
SUSE Linux Enterpriseld. FE{fF®»Windows v b7 —27 &5 T 5 & D1
HETEET, ZoE. Linuxk2 B2 —%EIWindows” 94 7 > b D
FOWCHEIFL £9. Windows” A 7 > bk &[dffi, I RXTo7HD > K
¥ % Active Directory’) 5 X5 L 97, affllc oW TiE, 9.4JH Windows
Ty AINVOEH]] (179 X—=)eBHHL T2 &0,
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Windows % v NI —27 T X DFEE T VA
KDEZ > ka2 — )Lk 216, Windowstky N —2 7V 2 RETE
¥, HETEOGFMIIOWTIE 95H Windowsty kT —27 71 >
BDFKELT 7 A] (183 X—=NESIHL T EEN,

Py NT=D T FNTNDY a—bhy b0
JE—h%y NT—2 75 )LH(FTP, WebDAV, Windows*t v 7 —7
FA47, BLXUSSHNDOY a— " hy NE{EkT A 2212k, 2hb
DT FIHIFHHICT 7R ATEL L1200 £9, FHEHFOFMD
WTCE, 960H Ty hT—=Z T 5 NEANDY a—Fhy hDFE]
(185 N—=NZZBH L TLZ S,

¥ 7o WebH — N % E
o 2 —3 & R E BB T 2 080D 555, iR R WebY — "%
HELET, HEHTOFMIOWTE, 9.7H Tk E 2 WebW — %
B (187 XN—=)EBIHL TLE& W,

9.1 J7AIEFERY bD—HBH
ICRET %5 — k) GEE

BivoarbEa—23ry hT—=2T, 77 A NVEERCRy b U — 2B
VEEEO R el BERIIE. Ry hU— e a2 B a— 2 OFIEIC L - TR
HDFET, Ry NT— VS EIIa 2 — Y REETARIC. Ry NT—
IHETT 7 A VHER Ry b U — 7 BIBEEN R — L ShTna e
M oFe, ORIV FT 4R =T ENTHDLENEI D, VAT
LEHEICHRL T2 a0,

Windows =G H OSMBH IR U € — M —EZHDSLPB /& D%y b U —
BT, A a— MRy NT—=7 FOTRTDI 547 MIRAyt—
VT —REPY ARNTELINEIMDICKELKELTWET, a2 a—
AL, TOd—=KREFx 3y AR Xy =7 I5344 7 M6 DINEICK ST, H)
HTc&Esry hu—2Hg -2 2B LET., 78— RKE v A M23)
RANATO I2012lE, Bfivoarva—208 ioda— K3y 2 Mifg
AEa—FLECY Ty N ECEETLILERHYET, Xy hT—2
IR TE R 0gE, £t sz EG0— 20 HTED Y
DB LG, A a—ZNEY Y T Ry MRS Thb e
M VAT LEMEICHERL T E &0,
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oy MU= BEERHT LI, *y b =20, £3EEBLT
Y-t 2o MRS L 2y RT—7 XAyt — /%Lzhf%éi5ﬁ
WLONDFRy T =T KR—=KERWTEBLILERDH Y £9, EHEDSUSE
Linux Enterprise Cld., MW X a5 4 VXV EHMEFT 2 LD ICRESNTE
D, A=y "6 Ea—22RETLT 747 74— IVDEIEL
TWET., 774774 = NVXERFET H101F, AT LEHEICFED
Py NT—=Z7HAR—=bM2ET 5 EOICKIET 20, o Fa T 1R

—WICC T T 7 A 7 U 4 — VRO (ZIE T 5 0ERH Y T, 77
AT T A—=IVDEHWEL TWBIRRET Ry N =2 BIHETHOHE. X2
TARECED Ry b= BB LEShT0L ) 28 2RA 5
Konqueror X v 2 — UMW FKoRr S E T,

92 vy bD—OHEFADT7IEX

Fy NT—2 L DT— I 25— 3 DT A NTEETALIICHETE
F9, HE., Ty ANETANAINFVE— R a—PRT I A TCXLHT L

ERTILTBHIOTHET, Zhold, Ty b= =700, LT

nFEJ, zﬁw@/zrbmz/bv PHFICT IR ATEDL LHICHE
INTHB H—h)ara—4 FlHLT7 7 AN T7 4NV E L[ET
i5K\774»7%*V¥%ﬁ91#ﬁ774»@7%»9K79ﬂ2b
720, BHHLEYTEET, HET7 A VXIS L TaAY 772 2 Lo
WA, F 720 iﬁ%w&JfYﬁJzz%ﬂ%ZofJ\é: IME, HH T IV F O HE D
55zl 77r782a3—-3I vy g vt Aﬁ@i7

2y NI HFICT VAT BICUE, TAZ Ny TD [y hT—2BH]
TAAYEI Yy 7T LM, FziFKonqueror & BV THATY — )L N—"TC
remote:/ & AJJL £, KonquerorlZfH 7 4 )V ¥ DSoRSNET, 2D 77
WAL, 77 A BER Ry U — 7 oMENFORENET, Ry b
D=2 U —ADffE IV L, TV RATL 2y NU—IHFEI )
JLET, 2—HF—FZENZAT = R&E AJJL TV VY —ANDOEGEIRD 61
LGENHY £7,
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9.1 *v ho—2oZ0

Location Edit View Go Bookmarks Tools Settings Window Help

L0000 AaEHmm &
E Location: [ij remote:f "l o
#Home Folder

a = ]
= [Ekin r ]

e ADesktop " T:‘?_".;:

[CIpocuments SLP Services  SMB Shares tux Zeroconf
@ Fun Services
[sapublic_html

7]

3 \

2 )

w

u Add a

:IE: Network Folder

M

v

=]

¢

@5 Items - One File (0 B Total) - 4 Folders

9.3 JBRERIETHO I+ I DIEH

MERIFETIE. Fxa X2 Mot aE L ORIV HADEEEET T, Konqueror
TlE, SambaZffi->C7 v AN EILHFTEE T, SambaZ FJHT5H 2 & T,
Linux> — ¥ & Windows — "fF'EJ’C 7 7 AN T AINF WA TEFE T, Samba
RS 72T 7y ANVHBFLEZETHICE. LITOFHICHE S T 2S00,

1 ALT>F2% LT, 5% A~ 7 4 —)V RiZ~% AJJL CTKonqueror & [ &
£,

2 U4 Y RUDONy I TS REL7 ) w7 LT, FoRdhbar X
A~ A= a—/»6 [Properties] %R L £,

3 [Properties] A7V, [Share] # TV LET, 77 A
NEEIWHEICR > TR WSS, CoF TIctoZ e ot s
Ay —=VNFoRENET., 7y ANVEFEEIMCT L, 3T
57 7 ANEERT 51218, [Configure File Sharing] % 7V v 7 L C,
root/NAT — Rz AJJL 7,
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4 7 7 A NVHEFEEHIIT 5121, [Enable Local Network File Sharing |
EIRL £9, HEZHNCT 25813 204 7Y a > oERz ik

L TL7EE0,
X9.2 77 ANHEGOHEE

~ |%| Enable Local Netwoerk File Sharing

Simple sharing
Enable simple shanng to ailow users to share folders from their HOME folder, without knowing the root

password.
® Advanced sharing
Enable advanced sharing to allow users to share any folders, as long as they have write access to the
needed configuration files, or they know the root password.
| Use Samba (Microsoft(R) Windows(R))
% Use NFS (Linux/UNIX)

Allowed Users

~Shared Folders
Path Samba |NFS Add..
[E5thome/groups/ v b4 Change.

[E5ihome/SBS-TEST/janal v b 4
Remove

ﬁihcmeiSBSrTESTﬂana!Funi x
x
x

@ivar{l\bfsambafdnvers! v
[Eivaritmp! v

@ Help ¥ oK # Cancel

5 it/ HHa 7T g9 > [Simple sharing] (FAiHEA)E 7213 [Advanced
sharing] (=27 A 2R L 9.

6 HFEDITN—FIH L TORT A NV E 2 HHTHEEE. [Allowed

Users] %7 1) v 7 LC. [Onlyusersofa certain group are allowed to share

folders] %R L 7=1%. [Choose Group] %7V v 7 LT, FoRr&hbd

4 Y RS 7N — TR 9,

7 BET27 4078477 TERCh L EHEEHOY 2 MIBNT
HIClE. [Add] 27V w2 L. ZANTDIEMELRANARIEEL T,
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X19.3 it 79>

Folder: |thome/SBS-TEST/janalFun/ [

Share with NFS {Linux/UMNIX)

® Share with Samba (Microsoft(R) Windows (R))
—Samba Options

Mame: |profiles
%| Public % Writable

More Samba Options

A& Cancel

8 Samba® 7 7 A NWHEFEZHIYNCT HITIE.  [SharewithSamba] % iEIR L
F9, F£7-. LEIZOU TSambad A 7Y a v #NEL. G FER2F
AMCRETEET,

D
7 7 )V MEDSA D BRI EIEET 2SI L £7°,
Public/Writable
Mo 2= d 27 7 v ADOMEEIFEL £9., 7TLeiimAlix
D eHZIAROMGOT 72 AZH]TLHZ b, HHOHRAIND
DHRIZT VR AZHIRTHZ b TEET,

More Samba Options
2T AL aRX YN BEXOTZ AR, 2B LU®
FalT4iE. BIROEFET A VI HOFFEDT 7 A VYT
TANERIFFRORCT A Ty a v e, HARMNRFES TV a v

MEFNTHET,
9 THEZWEMTHICIE. [OK] 27V 7 LT Ty ANEHEYAL 7y
ZEC £,

Konqueror® 7 # VA7 A AT T VRS NE T,
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9.4 Moz

Location Edit View Go Bookmarks Tools Seftings Window Help

,0.0.0/0 292N 6 jaafeol
B Location !IhumelSBS TEST/jana [~)
“/\ 2 #MFTP Archives
. % KDE Official FTP

i @ () Local Network \? \} |j

i;gWeb Sites) bin Desktop Documents Fun
(&) \/é
,;\ A
. public_html
M
%
=
z
)
3
L1

@5 Items - No Files - 5 Folders
o 2 e JE T AR T eRoRL, HAEHE Y

X%#b?é767ﬁwﬁéw%bi707%»?7437#675ﬁ
ARVARGALI = B

HHELIETZ 7 AN T4 NVFIC, 2y NT—7 Fotioa—3n7 72 2
LEEIE. ZEHDO 3 VB 2 —# b6 Konqueror DY — )UN—{Tsmb: /& A
JiL, Wt — 2 I N—=T 7 A AR A NG E 7Yy 7 LET,

EEIFH: SambaK X4 VB

Samba R A A VBIE, AT LD T 7 AT 75— LIBIELLSHESNT
WOLIEBICOBRMMATEET, T A7 U+ — VR EMNCT o0 F
TPEBHA V7 T 2= A NI 7 AT T4 =V —HFELET., &
EHEOFHICOWTUE, Y AT AEHFICBEWEDEL LS, 2o
FlEIX. THE TConfiguring a Linux Client for Active Directory] (5512 Active
Directory Support, 1Deployment Guide)lZiF L < FH ST £,

9.4 Windows? 7 1 LD E1IE

512 Active Directory Support (1Deployment Guide) TaitiH S T2 L9 1
SUSE Linux Enterprise @ > & = — % % Active Directory”Z 7 4 7 > b & L T{fi
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T5Z 21k, WindowsV— N FDF —4% 2B, Kor, BIOIEETE
F9., DIMSRENZ2MZRL £7.,

Kongqueror % i 5 7=Windows 7 7 1 L D% i
Windows | ® 5 — % % B IH9 % 121%. Konqueror®smb: /7 7 g » & A{f
HLET.

Konqueror % i > 7z Windows 7 — # O 3Kk
Konqueror® fiJH L C, Linux7 1 L' 7 b BT L1585 & [AFRIC,
Windows 7 # )V ¥ O NE & ZI{TE £, Windowst —/— FIZ7 7 A )V
RTFNVTHAFRT HZEHTEET,

KDE7 7'V /r —3 g > %l 5 72Windows T — % OI#{E
Kate7T ¥ A N LT 4 X7 ¥ ODKDEY 7V r —3 3 > %{fi5 . Windows
P—NEDT 7 AINEFHCTHRIELZY, EHEL /27 v A )L % Windows
Y= NIRIFEL 2D TEET,

SN A T
Konqueror’ & ODKDE7 7 ) r— g U, Y IV A U F kY iR—
FLTWET, Webt—N, X V— N 7NV —T T =27 % —
N(fi):MS Exchange)7e & ®Windows ) ¥V — AIZ7 7 ¥ AT 556G, O
AEET VTS Y FRA, BV VIR R e XA T — Rk
AT 2720 7T, DIRBoEEtd Ny 7 750 v RTHEINIThbIE T,

Kongqueror# i > CWindows 7 — # 127 7 ¥ A9 5121, LI NoFIHICHE S T
LTZEwy,

1 At+FR2F—ZH LT, smb:/// & ATJLET,

Konqueror™” 4 >~ RwiZ, v b7 —2 LiZH HSambaV — 27 V)L —T &
RAXA UFRRENET,

2 ADV— RO = TN —TETI R AL o742y 22y LE
7,
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9.5 ADH—/N|FDF— % DB

Location Edit View Go Bookmarks Tools Seftings Window Help

Qo 0leol=aalns
B Location: [ # smbi//sbs2003 sbsdestsite/ [+] 24

@ #Home Folder

[=Fn
i »Desktop \ "\ \ {

[CIpocument i3 Address c$ ClientApps. clients
@ [EFun

{3public_html \? \? \? \’?
b \ \ \ \
x
& E$ NETLOGON Resources$  SBS2003L0G
<] { { { {
= { { § {
(2]

sles SYSVOL tsclient tsweb
M
v 2
= Users
#
@13 ltems - No Files - 13 Folders

3 [2—¥—] I3V EE7Y)y 7 LT, HADZ—F T4 N T T AL
ZEIRLET, [T FFa2xX>b] 73 VEFONENFRENET,

Kongqueror % fff 5 CWindows . — %7 7 )L X HI T 4 )V ¥ = AFR T 25513,
Linux 7 # )V ¥ Z{FK T 5855 LA CFIH TR Z TV E 7.

1 Konqueror7 A VA Ea—DNy 2 7500 REGH7 ) v 7 LT, A
—a—%FKRLET,

2 [FHER] > [Z7404] OIEICERL £7,
3 Jur 7 NofERICEYy., LW T VLR AL ET.

ADY =S L2 T 7 A VEFRT 5 P, DL FOKateT ¥ A b 25 1 5 %
M7 fleBHITL T RE Y,

1 Alt+FR2F¥F — %23 L Ckfind& ASJL £7°,
2 TEoTF XA M2 ASL £,

$ NI =T U =ANDT I A
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9.6 KateZ(#io/=5F 2 N7 7 A ILDHGFE

File Edit Document View Bookmarks Tools Sessions Seftings Window Help

200 Ed - 0+ FEIf SIS

Untitled This is a test file located on the Windows server. Isn't that
awesome?|

Text File (2)

[§ Filesystem Browser %] Documents

Line: 1 Col: 71 ||| INS | NORM | Untitled

-4, Find in Files &8 Terminal

3 L CIFRL =7 % 2 b &Y 5ICHE,  [SAIE AT TR %8R

L7,

4 FNCHD [y NTO—=2 T3 N05] 7Aark )y LT,

Shares] %R L £7,

9.7 UE— Windows 7 4L %D 7 5 4 I DIRIF

QO O = = [Eremaey [] [ufs
= @& SLP Services
hﬂpubhcihtml B SMB Shares
> Desktop @ tux
™ Zeroconf Services
DDGCU’“ENS i, Add a Network Folder

"? Home Folder

E_JSlurage Media Location: lText File "] lﬂ Save l

Filter: IAII Files "] [ # cancel ]

5 Windows 7 # )V XIS HENL £ 9.

6 77y ANEEASILT, [RFE] 220y 27 LET,

7 7 A IV D3WindowsV — NIRES N E T,
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Konqueror® ¥ > 7' )WvH A 7 URSREO W 2 LI MR L £9. ZoflT
l&. MS Exchange X —)V7Rvy 7 ZITWeb7 7 2 AL £,

1 BifF ®Windows = — ¥ %I H#72MS Exchange 7 717 > "3 5 Z & %
MR L £,

2 VAT LE M EICExchange — ND Y KL 2 ZnWGby¥ £,

3 At+R2F—%#H L T, konqueror
http://address_exchange_server& AJJL £7,

INT, WA RS Z &<, Exchange7 h v hica /A o T&
FL.

[X19.8 Konqueror % 7> L /=MS Exchange \® 7 7 & X

==
[J & 0 Windows Small Business Server Wel \ & to Windows Small Business  Thu 3/9/2006 2:12 PM 28 KB
Team@SBSTESTstte  Sewver2003

4 HEEECEIICE T A NVERAESL, 77T MLET,

9.5 Windowst~y b —20 T 48D
REETIER

Ty b — 27128 L. Windows Active Directory? — /N D EREE &2 72 6
TV UAREDMHIE) ) — AT VR ATEET, KDECIE. Linux” 5147
Y RS Windowsty b T —2 7D U HICHTE S L HICRETEET,

Linux”7 24 7 > b5 Windowst v b T —27 71 v 2 E2RHTE5 X913
ETHIE PUIToFIHICHE S TLE S0,
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1 A A=Za—/HKDEa Y ha— )Lk o2 —%ZfediL £7,

2 [Peripherals] > [Printers] DIEIZHEIRL £,
x19.9 “U>%DiB

S Printers - Control Center 2 X
Elle View Settings Help

sawer: [ (/=) Printers.

@ %, Add e Printer. ¥ print Server_ 57 printManager. [Jview §7) Documentation
- <, L ¢ Cview, @ .

rint to File (PostScript)

04 Digital Camera e al (pseudo) Printer.
s end to Fax
[l oisiay 2 nplser]_ads
Fime 2 pscido0series
%) Advanced Faxing Tool (ksendfax)

(Eervoors o] hplaseri on wak3dc
() vouse A Mail POF File

Print to File (PDF)
Qoegxnewces & —
YT TR e © e
(@) remotsconrs g
W storage Media 13 Copy.

(4 Remove

£ setasDefautt
©4,  settings

(=)  Test

Print system urretly usec: (CUPS (Common UNIX Pt Sysemy [

Server: localhost:631

Administrator Mode

3 [i8/1] > [Add Special (pseudo) Printer] DIEIZERL £7,
X19.10 7'V > %iEioiB

& configuring hplaserj on w2k3dc - Control Center a1 %
Name: [nplaser; on wak3de |
Description: [a test hp laserjet 4050 printer ]
Location:  [bertin moabit ]

~ Command Settings

[smbciient /w2k3dc/nplaser -k -d 0 -c 'put %in' > /dev/null 2> 81| [Fﬁ Browse... ]

[ Use commana: lEnscrlpt Text Filter "l m

@

~ Output File

[% Enable output file

Eormat: lappl\cat\on/pcslscnpt |']

Filename extension: l ]
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4 7V a2, BRASE, BLOEAE ATILET.

5 [Command Settings] 2. (ROGNIRT LHlcavwry KoA & ATJL
£,

smbclient //domain/printer -k -d 0 -c 'put %in' > /dev/null 2>s&l

domain &printer/C/d, ZHIHDIIEICIE Uzt KX 4 >8 & 71 >
ZELEEIFEL FT,

6 T XCoAIMY a 7 %PostScript 7 7 A WIS 1T 585618, [Enable
output file] % #EIR L. KIZ [application/postscript] % ERL £,

7 [OK] #27V w2 LT, FUVEDOHELKTLET,

8 [Zra] > [KT] OIEISERL T, KDE2> ha— )Lk 4 —%
BT LET,

INTTY 7 O HERNTE T LEL,

ZEL /2Windows % v b7 — 27 7V > 2 ICHIIT 121, KPrinterd> 7 > 4
YUARPOFEUT LT U7 B2EIRL £,

9.6 2y ND—O D4 IAANDY 3 —
NAy bDERE

KNetAttachZ fiJHHL T, 2ot a—IlfLvry NT—=T 74 )V F%EIBINT
£, iB/07 5121E. Konquerordremote:/E = — T, [Add a Network

Folder] %71 v 7 LE7, RKr&Nb4H—~KT, 7782 T5%xvy b

T—0 73NV OMAEZEIRLIZD, *y NT—=T T3V EH =7
RUVAAPY RVAEZIE R AL V), ol A%, R—h BLOT74 057
NDNATLEDFFMEREZ ASJL 720 TEET,

$y NT=T VY =ANDT 7 A 185
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X911 %v h7—2 74 )L XDk

Network Folder Information

Enter a name for this Secure shell connection as well as a server address, port and folder
path to use and press the Save & Connect button.

Name: [SharedFoIder ]

User: [tux ]

Server. [12345.678.910 J

Pot |22 B

Folder: [!h omestux ]

[®| Create an icon for this remote folder

[ < Back ] [ Save & Connect ] [ Cancel l

VEEMWTET LS, TLLERLIEY 22209 27 L Chy hT—2 3
W77 RATEL LI DET, HATY =W NA—ICRWURLE AT 540
TIHY FHA,

X9.12 #HlLi gy NT—2 T3 0%

Location Edit View Go Bookmarks Tools Settings Window Help

10000 o mlal=] g

E» Location: [Q remote:/ |']

| B FAFTP Archives n - |
(@ KDE Official FTP r bod
e @ (y)Local Network — o>y
RAWeb Sites SharedFolder  SLP Services SME Shares Zeroconf
4

@ Name: SharedFolder
a Type:  Link to fish:itux@123.4 5.678.910:22/homeitux (Folder)
M Add a
; Network Folder

ZOHETHRy NT—=7 T3 )V FEIBNL 28&. KDEY FU 7 —32 3 T
T ANERHOZORFELZDTLE XY, Co7 VAT 7,
ATEET, [OpenFile] A 77 F721% [SaveFile] %A 77 Okfllo
N=IZHD [Fy hT—=2 7308 2V 235, iBMLIzry hU—
77 AINVIMFRRENET,

KDE = —#J7 A K



£9.13 #v hU—2HGNE 77 L 2H<

Q O Iiﬁ S, [remoteu’ |-1‘ | utfg vE
|j;'apubllc html » ELCTEED)

@& SLP Services
* Desktop ¥ SMB Shares
= ™| Zeroconf Services
| Decuments + Add a Network Folder

? Home Folder

™ storage Media

'2 Network Folders [IBReCUElH |"SharedFolder i'I [B Open ]

Filter: [AH Files i'! I #K Cancel I

FAwT  TRIMy TRy hO—0HBFBADY VY

WECHIHT 22y b= HFICERLS 77 22T 57012, 2heo
D) =2 DY I BFAY by 7 FICFRCEET, 27 ~hy 72V
v 7 BAVERRT H1CiE. Konqueror» 5 HIND U Y — 228 R L 721k, <7 A
DIERE LB ST 27 by ISR Ty ZFLET, K2, £rsh
53T HANAZ =06, [Link Here] % i#EIRL £7°, *’r“xﬁ N4
WKHLWTZ A BRRINET, ZoT7A4are s )y rd5bhe,
KonqueroriZs « L7 MU ONEFNRRRENFET,

9.7 B2 E 4 WebH—/NDETEEFH

kpf—5 ¢ U 7 ¢ |&. HTTP (Hyper Text Transfer Protocol) 7' =2 h =)Lz /] L
T 7 7 A WHFREGER 1B L 9, Co7a kanid, Weby 1 Forb
Web 72 ST — 4 e Kon T 2IGEICOMIHINE T, KEICS O &, kpf
(ZINTV 277 ANV —=NT, HFT 7 A NNDT I XIHIRENE &
Aom%ﬁﬁbfﬁﬁbk7?4wm\%T%W%?é:kﬁ?%i?o

$y NT=T VY =ANDT 7 A
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EFRR: X274 LOFREFER

kpfe flfio CTT7 v AN —NEZRET LA, BEOEXF2U T 4R U —
T Z OFRFENHIH AT BEM &9 7, %bﬁ‘b@/%*fbﬁﬂ% ChEGR L TL
ZEn, BERFLFTIAR-MEIET, xy U — ﬁé1¢ﬁi7?4’7

4 — VTG S RES N T E D E I ARG EE. 77 AP —
NEXKELZNTLIZE N, 2y M= 71\.:[375%1%. IN Tty
. HER RS Webl IR T 2 GMHENRH Y 9, 6512, WebH—N
uﬂvh~@ﬂ%ﬂﬁmﬁé%@ﬁéwwfwi?oW@#~A%%ém
34 ET% VB 2 v E 97, kpfld, WebY— & L CoRHZRIHE S

an‘l’éhfu\i’@‘A/

kpfld, KA& 77 ANERHTL 2 & 2AHEICKT SN TV E T, Apached
T RTOWEEER T L 7=WebV — N TlEH Y FHA, ZDa—F 41

7 1 13 F 12, IRC (Internet Relay Chat), F v v b L—L)7e & TR AL F+ v b

L2y, BRI v A NEHFTL200FFKe LTHESNTHWET,

W, kpflidl—ALF 1 L7 b Dpublic_html 7 ANVHICHELT 7 A V&
HEHTLEIICHESNTHET, L2l BEA IS4 TFry b
0)7FE% ISILTHL7 7 AINVORHZ] T 5555, kpfeflioTZD7 7 A
JV&public_html 7 # )V AICAE—L, http: ///HOSTNAME 8001/
thefileMHBZD T 7 AT IV VATEL LIz L 2MFITRA
F9, (DEOLIEFRA-NICT 7 A NVEMILTEETL2LETH &
A .

1 KDED NERICH DN X2 NV EtH52 Y v 2 LT [P 7Ly hENRIVICIH
] w2727 L. UKIC [Public File Server] %#iERL £,

TEBAARVIS, NSOHERRDTZZ L 27 A a v FoREnEJ,
2 7AaYEE27 Yy 2 LT, [NewServer] #7271V v 7 LET,

3HATLT77ANNHLT 4 LI NIERIBEL T, [KN] 20Uy
LET,

KDE = —#J7 A K



914 77 AN —NDI— KT 1 L2~ DER

@public_html

> Desktop
D Documents
*‘.é‘ Home Folder
!_| Storage Media

Q Network Folders

[Foldcrs ];]
[Edetc
o [=jhome
© [E4SBS-TEST
o [=jana —
[Edbin
ADesktop
[EFun
[Epublic_html
[Edjanaz
tux
b
[Emedia
[Edmnt
[EFopt =
[Edproc
[Edroot
[Edsbin @
[Fasrv

[!home!SBS-TEST!jana!Documents

N

[E New Folder... HY OK HX Cancel l

FRLTZ 7 AT 7 ANEWENF RTIHREDL T 7 A N)RE, T4V
NOTRTDOT 7 AN, T THNE, BEOEY VR w7 U 2 7hHh

DaA—FIZNFESNET, T, NAT— K,

ETx—. 7RL=A

M, E/RITHADO RE¥ o X by, EEREREZ LT L2 200
WEIIS, FACEELTLEES N, N7 AV DS OEIRICT 7 2
AEINDLZ NI HIT, N7 ANV FHANDT VR vy 7 ) 7

ANz k9

LTL7ZE0,

4 [NewServer] U 4% — Rk O EET T LT, A7 v 73(188X—
ONVCIREL 274 VT HETE5LO1ICLET.

Konqueror®7 1 L7 b 7 A 2 > OAHFHIC,

U ERORENE T,

S Z N7 A NFICT 72 AT HICIE. 7T U Chttp: //
/HOSTNAME: 8001 D & D 72 ICURL%Z AJJT 57200 T3, 79I, 2\l
T AV OMEN TR ENE T,

HiEkE o2 L7 A 2

$ NI =T U =ANDT I A
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£9.15 NFHEhl=z>7>

Location Edit View Go Bookmarks Tools Seftings Window Help

QLA OV =XRALAS
B3 Location: [¢# http//server8001/ |'] ﬂ[ = ‘V]
| B 4AFTP Archives
2 KDE Cfficial FTP Name | size |
browse png 49.0 KB
browse_adserver.png 53.0KB
@ browse_winuser.png 40.2 KB
L) kate_remote.png 31.7 KB
W, kpi_seldir png 359 KB
kpf_seldir1 png 15.2 KB
E kpi_seldir2.png 152 KB
z kpt_seldir3.png 15.2KB
L kpi_seldir4 png 15.2 KB
= save2_network.png 328 KB
P save2_netweork2.png 282 KB
]
\ | &

ARARSYV ETCT 7 AN —=RDRy NI =2 " T T4 v 7 REHTCEE
9, BT A1cid. HEREoEE Licry A a2 452U v 7 L C.  [Monitor]
ZIEIRL 7. Ko &9 LR BEHERVKRSINE T,

19.16 7 7 A NP —NDHFF1EHR

Status |Progress |File Size ]Bytcs Sent IRcsponse IRcsourcc
$] ) 2787 2647 OK /
[ ] 425 204 Net found ffavicon.ico
3 [ ] 432 102 Net implemented /
o) B 62847 45844 oK Jkpf_connectpi
(4] KIDY
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KIEpgﬂA.JtZ5E 51t

KGpgld, Linuxy AT LDOWEFALA V7T AN T 7 F v DH b, HERA Y
A=Y NTY, o7l I nald, LEZTRCOFOAR L FHI T
HLE9, o, o7 FREERH L T7 v A v ol Eak & 51t
ZATOM NRIVRICHL7 Ty heHL T Ry 77 KRRy 7
A CHFALE 3T T bR ro e MTeE T, EFrA—- 7arIn

(Kontact F 7z1FEvolution)® & 9 Zefthod 7va 75 Wi, 5 — 277 AL
T BUFAHERTESOERONET 2L £9, Z o= Tl Wik
BT 7 AN T 28 HFEHET 2 ETREIC 5 BRI 2 HEFEIC D W A
LET,

10.1 {4 L BESAL

Y
B LR, BYELEA—INVERIEY 7 M= 7ITRMITL T, FodKRN
IELWZ EZGEIHT 50T, dEMICEAIZ b T A= V&2 EIND
DOEMIELZZD., B A= NVOREETOM T ERELZY T5H-DI1C
A=)NIELTHVERH Y £7T, FHICL T, ZELLA—IVOXRE
TR HICHERL, MERA N ECEEOH LA N ERMNTONET,

VI M =T7BRETY 7 b= TICELL T, BEMEEITEET,
FENRDY =PV T M =7 E#THEL TWAGETH, Ny lr—2
FELTCMIITEET,

KGpgiZ L 551k

1
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i1k
@%Wgﬁ%?éﬁﬁﬁ%é%%%ﬁéﬁﬁbfwé3&ﬁ%@i?o%
F1tc &L - T, f 2P T ED G IR LD ICT A e TEE
9, 2RI I8 S5 TEHEETT, NEEROIEN., EEBEDOTTA
Ny — T ARiE ’Téﬁ&bf'f

10.2 HT L WER T DARK

HESALGE A A v L= PR fhd 2 — B 2 DRITIART I, ]l H TS ]
DRERT 2R L £, TD1D2TH L LFHEONFF =), @EMFIST L
TRATL200THY, WEMTHET 7 A LE ¥X~wX/ﬂ TEERG
TLOANS, A zEHAL TEhs 2liT{L £9, BEX70b 5 —HiE
Wﬁ%ﬁﬁ??ﬂ??ozm&\%?ﬁﬁ&@WE%Q%ﬁTéﬁmfﬁﬁ
SNET,

ETRE: ER LN

AN, NSNS Z e, BLOTRTomEM IS L Cilfish b
CeEEMLTCHET, ., WEEICT 72T 50T NEMEL T
WHA—PRFTT, WEROT -7 7 v 2T H 2 L ko2 —PiC
Fof LT F a0,

KGpgld A A ¥ XA =2 =T 50, F/2iFAt+R2F— 2L T,
kgpgl AL ET. T 7T hEgCENT 5 &, HETFIHEIRT
L7 YAL Y NS ET, BOFRMNERSNLFHET, 7V AZ U b
DIFRICHE S CilEAE T, ZRIEEFA—-IVT RV A, Z L TREISIEC T,
IARAYNEANLET, 774V RRENE Y TG EIE. oA,
YA X, BEOWHTAHEFA7 VI ZLLHEL 7. Fco>0 T
[%10.1. TKGpgdEdfEak) (193 X—INZBIHL TL 2 &0,

fx@’z v v gV CKGpgZHCH T4 &, INERBEFIT A T DRIY AT L b
WICHRRENE T, KGpgD A A >4 Y RUET AT by TIFoRT 51
i FToOT7Aar )y 7 LET,

KDE = —#J7 A K



X1 10.1 KGpg:#ED1EK

—Generate Key Pair

MName:

[John Doe l

Email:

|jdoe@example.com |

Comment (optional):

l l

Expiration:

‘ [ HNever |vl
Key size:

1024 B
Algorithm:

| DSA & ElGamal -~

[V oK HV Expert Mode HX Cancel l

AU TeRERMR LT, [OK] %227 Vv 7 LET, KiZ, NAT—K%&2
EIATIT D LR EA 7B FEoRrEnEd, BRLEZAAZT— KD
AR ASHE S, [Password strength meter] \ZForEEd, K/
7T I & o TR ER S, MENSRRShE T, KREEIHEZ T <
WCRFEEZIFANT 2 2 2B L £9, 20k HEIL. o/ 2 T —
REeEn-aaicidzminmcd s & X1 E Ty, [0K] 22V v 7 $5
E. KGpgD A A 74 v RuForEhET, Gl X102, T
TE =V ¥] (194 X—=)EBIHL TLZE0,

KGpgic & 2 51l

193
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102 #~r—

File Edit View Keys Groups Settings Help

QY &L 9 Do

Name Email Trust Expiration Size Creation Id

(<] g] ohn Doe jdoe@example.com 1 unlimited 1024 2005-02-28 0x59847CF5
©=FElGamal subkey [ unlimited 1024 2005-02-28 0x76FED0O0OO

g;ahn Doe jdoe@example.cem - Unlimited - 2005-02-28 0x59847CF5

Ready 1 Keys, 0 Groups

10.3 N\ T H AR— b

ﬁ&Yéiﬁbt%f\ﬁ%ﬁ%@@:~$ﬁﬂﬁ?%éiikbi?o%
DfER, o2 —FRE NP ERENC A vy =TV T 7 A IV ERET LHH]
I, TONBIAGH L THSALERITELTEL L9120 9, A\FEt
PO —YPDFIHATEL LOICTHIE. [ > [N\Fgz T 7 25K~
F DIEISERL 7, YA 70 7BRREN, 4204 7Y g UifoRdh
S

X —I
NFAENE, IR 722G ENE ANV TRETEET, _®ﬁ7/a/
R L. [OK] %7V v 27 LTZOERGEREZIET L 21581, KMail
THLWET A= VEERT L2008 4 7a 7 niE 7, 21%*
JiL. [FE] 227097 LET, EEIEL ARSh I BE2ZEL, Z
DEIF, B Sh AT EAERENEET L e TEET,

VAN e
ARG IO N\BIEOIRE 2 i SRS, T ON\BHEZ 7 V) v TR—
RICHEAATBLZEMTEET,

T 7 I Mg — N
Eﬁ@ﬁﬁ%@iﬂ%!ﬁb\n%%ﬁfﬂﬁﬁf%E.)ot5L:ﬂ“éc:ci\ AT =%y
IFET DY — Non Tz o s =7 ZR— K~ L £9, FHi
cov\fi 10.5/H MY — AT A7 7] (196 X—NEBIHL T
Iy,

KDE = —#J7 A K



77 AN
HOoOWZE ANV TEETH2DVIC, 77— AT 47 L7774
CLTCEORZPEHAT LV TCEET, CoFToarver )y 7L,
T 7 ANVDNAL LA T 7 )V MEOF FICTL0EELMA. [OK]
27w LET,

104 EDA VR— bk

Ty ANDIETHz e Z1E, BT A —IVANDORIY & L Otz - 7215
a. [Hrs>A— M AL Tzodx BrodRiciaL. ok
T oM T T LSRR EZIT O LGGICTOMENNL £, ZoFIE.
FRICEREAL 72, 2y 2 R— b T3 FHEICMTCHE T,

10.4.1 BADEL

o7 7 AV eEIRRIC, BICEL L T ToEOIESE e BEM 2 RIET 5
YL TEET, A VAR— MNEROED, FTFE L L THRINTHS{EA
ICATTE L T 5 2 3N RIG G, ToICENEL T L5210k,
ZOEOIFEYHEANDMEEL T DL EERAT LI LN TEET,

ERIRA: EDEHE DY

S LS NIZIBERE X 2 7 (HR)THLHDIE. BHSh TWE N2,
FRE SN2 — IS T A IHEET T, Tho ol
HWZF=w 7L, BELTDHZeld, GHOHSEOME I OM) £7,
CoEOHEICEY,. EARMCHERL ZRICoRE LT L L H1cLTL
728Uy,

U2 Noich b, BEHTLEEZERLET, [#] > [ICEFEHS] olF
ICEERL £ 77, MO TERRENL XA 7a /T, FAIRAT 2 sk %215
TELET, BATLHHIC. TOROIEYMZ2IERT 5 &0 FET 2EENE
TRENET, ZoOMREIT- KT, [fwir] #27 Vv 27 L, ROAT v T
T, ERL 2EEIET A2 — RE2 AL E£T, fhoa—31F, H
ANONREFHT 221k, ToBFEXETF = 7 TEET,

KGpgiZ L 551k
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10.4.2 §ED{EFEL NIV

W, =Y ZOREGIHL THL0E )0, KR ST E BT
FORPHFHL THWLEEEZTNHDLNEIDICONT, [FHL WS Tra )
T LI DS TONE T, ZofnwEbElE, XAy eV EETT 5,
F B RERT ALENH LI ET., chEzfhiicid, #L
{AVHR=bMLIEBOEHLVERELET, 774V ETIE FLL<A
Vik—bhLEITHOWRy 7 2 TRENET, ShiE EHELVLVoEE
SHD Y TEN TN R RLTWET, BE2EHT 21205 D ToF
MEVCHEVE T,

1 LA VA= rLIEEHEZ Yy 2T 58, BEMHO NSy T
FARMRA=Z 277 8ATEET,

2 [#HCEL] #IRL £9, KGpgTH A 7l afE, Bofsiiz i
SRR T B LI IR HNE T,

3 [Continue]zHL T, HOEBXDI-ODTATAT Ry 7 AT 7+
ALY,

4 LV EEIRL £9, 72& XX [1Have Done Very Careful
Checking] % 1EIRL £, ZoX¥ A7 r7%5C T LET,

5 XZAT7 L —X% AL T, BELTawAZE T LET., A VAR—K&
N, Zfihicg TR RSN E T,

L SR E DRI, ENEL Sh B ik iELT 20T E
ZLOGHL COARWI E2ERL T, BELEHEOHGILMTRICOI > T
LHEGLHY ETN. BEEMBICE LT ANCE Gt E R L
TWREWEESLEZONET, LEN-T, BELELELEOREEL T
b, BYHEICLVELIN Mo O TIEWNETHL VR T F
T, EHHLV NI L 5T, KGpgd HENWUWERSFAET L2 2130 FHA.

105 {EH—nN\54 70O

A8 =%y hR—=Z2DEY —NDN L OMIE, L Da—HF /N =1
HLTnEd, ZLloa—HF ol S {bENmELZEET L1201, *
NOEOYF—NEeMHL T, ARFEEEALET, CoHNERLZTITE D

KDE == —#J7 A R



% 2o oV —RondFhirice s 2AR— L7, [AHC. KGpg# fii
LT, WEO2—FITHIET 281 ERIFL T 2h e 0P —"ondh
DEMETTLZ L, LYo Th 02— ONFE A KR — |
TLZEMTEET., [Zrau] > [V — Ny 7ar] OlHICERL
T @Yy —nNFA7arE2lE T,

10.5.1 & — /S DEDA VR— b

Wy — ] A4 7aro [Ff2R—r 2 7%BL T, 4% —%y hX—
ADPEY = XDNT IS N\BMEE A VAR — ML ET, ERFAROREY —
NOWT NP EEIRL, MR SCFIREMFOE T X =7 RV R)E 21T
I LPDOIDEASLET, M 22 )y 2358, fiTDY 25 L0
Lo H =2y MIIEML., fEESNEY — A6, IBEIC—KT o8 % M
FTLET, 2BHHL L&Y, X103, THE A 2 R— T 5720 oM
[ (197 X—2)

103 WzEA A~ T 5728 DfFHEE
Import Export

Key server:

hkp:/fsubkeys.pgp.net -

Text to search or 1D of the key to import:

Y — NI 2 MEBIN L 2 E. I L 72T X TP — " Ny »
525V ARBH LY 4 Y RYNTRIRSNET, HRICED /2% 35
RU., [A>F—=r] 22V 2 LET, B X 104 TRETRITE A >~
A=K (198 X—=). Ay —UNFKRrEN/z6 [0K] 27V v 7 L THERD
L. [BIC&] #2707 L7T -] ¥A47ar%28C£9, 2h T,
A VIR— NEARORIE, [HE~vx—Vr] OXA T4 2 RONICH HHE
DOFTHRIRS N, RIS Y £,

KGpgiZ L 551k
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X104 HEKINE A A — b

Found 42 matching keys

|Key5 - l:'
test <test@example.com>
Test two (no pp) <two@e...
TheLugash <nene@exam...
Thomas TankEngine <tho...

Tux Pinguin <tux@exampl... .

Usenet Poster (Usenet Se... @

vhs m testuser 10 pgp <t...

Key to import: |46E1E549

[V Import HQ Close l

10.5.2 EH —/ANDEDITH AR—

WE. A7 =%y b ECHBICT 7 2 A0[gER i — NonFhric T
AR—=FT 51, -] ¥4 7aro [Z7 K- 7T %ER
LET, 220Ky ITH I A=a—%f->T, =7 AR— Moot —N
&, T AR- NI HHEZIFEL £7. KiZ. [Z2 XA — M Z2EHL T,
T AR— NERBL £,

£ 10.5 $EHV-— NN~\DEDOT 7 ZX— |k

Import | Export

Key server:

[hkp:ﬂsubkeys.pgp.net |vl

Key to be exported:

[0x59847CF5:J0hn Doe <jdee@example.com=> |vl

[%| Export attributes (photo id)
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10.6 XA M ET 74 ILDIEFAL,

KGpgZ M HL T, ¥ A b, £LF27Vy TR—-RNONEEEFILT L &
LCEET, SEHIoOT7A A EH2 Yy 2T he, [2Uy TR— RNelgs
It] BXOG [2Vy TR—=FE2RSE] O&F T ar, WKkLT 1 4%
BTz DF Ty a vFoRENET,

10.6.1 7V v JiR— RDIESAL L E S5t

7y TR=RKAab—L7kT77A 0% Bloorz Yy 7 CRBICKESALT
EFE9, [KGpgl $EHI7 A a2 HI7 Vw7 Tbhbe, A=ma—MWRRahE
T, CDAZa—W6, [ZDVy TR—-RFEIEFS] 28R, [T 55
ZIRELET, BEALoTIEICHETEAT = AR v 2=V MTF AT hy 7
FicForanid, PEICIEL T, ZDRET, ESLFARONEEZ 7Y v
TR=KPSIEL, WEEEDLZ N TXET, 71Uy TR—-RORE
PRAACT DRV TT, MU LH1S. [KGpgl 7AavzH2) v
LTA=a—%KpRlL, [ZVUy TR~ ﬁ%&%ﬁ]%%ﬁb\ﬁﬁ@W%
FCEEf T 5N T 2T — RE2 AJIL£7, ZDORT, flH]REZ
BAALBRDON=T g 00, 7V v TR— KN, BLUOKGpgd T 1 ¥ NI
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Cld. KDE Printing Manager% ffi - 7= 7'V > ¥ OFEITEIC OV TR L £
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5800 £,
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documentation/sled10/1C® % [iPrint User Guidel % ZIAL TL 72 &,

AR NS TN a—Fa 0T

TV H OFRERFICIESRA L G EE. VAT AEHEICBHWED
LS, TV UHDRIEIC E@Téﬁ@%ﬁﬁ’@#{&lﬁiﬁi 20
Printer Operation (1Deployment Guide)Z Z I L T 72 &1y,

121 JU2VEADA VA=)V

TV A A VA RN=I)VTBHITIE root/NAT — KWPETT ., F/z, VE

ANV Iﬂﬁ%b%bﬁ\b&)’ﬁ%u LTSN, T AT 5 I
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KDET 7V V¥ & ET HITIE. A A > A== —7» 5 Printing Manager’&t@h
LES([Y—I] > [HIW] > [Printing Manager] DIEIZIER), F 7213
NH+2#*€ﬁ$Lfkummml%ﬂjﬂﬁffoKDEHV%KPﬁVﬁV5'%D
KL >elr—varnN=n6 [JVEE] > [TV 4] OHIC”
Uy 7 LET,

X1 12.1 Printing Manager

Print management as normal user

Some print management operations may need administrator privileges. Use the
"Administrator Mode" button below to start this print management tool with
administrator privileges

Add [ Printer Print Server #7] Print Manager View Documentation
\ Add g Printer. 3 g ger, [ Tview @9 ,

& Advanced Faxing Tool (ksendfax) ﬁ. Print to File (PDF) | Send to Fax
% Mail PDF File A Print to File (PostScript)

2 Information I [E51Jobs <4, Properties (= Instances

Mail PDF File A

Type: Special (pseudo) printer
State: |dle (accepting jobs)
Location: Attachment for KMail Composer
Description: Creates PDF/Acrobat file as attachment for KMail
URI:

Device:
Model:

Print systemn currently used: | CUPS (Commen UNIX Print System) -

v OK

T4 Y= R2{H5 T, root& LTCTY VEAHETEET, YoFA T ar%
IRL., CoERE AJTTXRENARHZGEIE. AT LEHEICBMWE
HELTZEIn,
Windows v N7 —27 TV X DOKIE. 7V R AFFEITONWTIE 95H
[Windows %y b7 —27 T VY U ZDXRELT 7 VA] (183 X—) B L T
T2&EU,

1 [BHEE—F] #27Vy 27 LT, root X AT—RKZ AL ET,

2 [iBm] %22V w7 L7, [AddPrinter/Class] %#353R L £9. [Add
Printer Wizard] M3 ShFET,

3 [Next}%# 27 Vw27 LET,
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4 7)) IO FEEEIRL £, RoA Ty a v BfRETE£T,

* Local printer(/N=7 L' b, > U 7 )b, USB):NT L)V, U7 ), £z
[FUSBTYU — 27 A7 —¥ a YIS Tns 7Y v 7 TY,

* Remote LPD queue: 7'V > % HS, TCP/IP v hT— 7/1’32:33'(“79 2
o] EZR O UNIX/Linux & A5 MM S N TV A5 EICERL £
(rv b7 =7 FofioLinuxy 25 Al @méhfw%ﬁUy&%
BT 25575 8),

* SMB shared printer (Windows): 7' 1) > % 73575 %) AT DTS
SMB% v k77— 7ﬁﬁﬁf'iﬁé%V(wé uLjQLi@T7U'/5
7’ Microsoft Windows =1 > & = — # [T Hih & i/b'( WAHBER ),

* Network Printer (TCP): 7V > 4 »3, TCP7 1 h A )V %&ffi5CTx v b
DU — 721 S TR EICER L £ 77,

* Remote CUPS server (IPP/HTTP): 7' V) > 4 M3, [6lC %y bhU—27 Lo,
CUPSHMENE L Ty B i Linuxs A7 Il @méhfné%
72V FIPP % ffi 5 /2 oo 0SS 25 M S T 51 Lﬁbi
—g_o

* Network printer w/IPP (IPP/HTTP): 71 > % 73, TPP/HTTPZ 11 K =1 )L
ZMHSTry MU =21 S N T2 EISER L £7,

« Otherprinter type:HIIEDWT DA T2 a9 TN LW ald,
COF Ty arEERLET,

* Class of printers 55 iED YV Z AD TV 7 MEET HIGEIHHL £
—ng

5 [RN] 220Uy 2 LT wURIEREATILET, 74— RDixik
DN=VTlE, [Z7] 22097 L T, v ¥ -FPELCET,

6 [OK] #7271V v 7 L7 [Printing Manager] % A 727 %L £7,
ZNT, KDENDO7 7V r— g 00687 502, Kprinter ¥ A 711 7'
50T AR T, BIMY a 7RI TE 5 591 £ L7z, KDE

2O DOAINY g T OWAZ LEEFICOWTIE, 124/H TKDETOAIY 3 7o
FHEG] (210 XR—=INEBIHL TS0,
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1 AA 2 A== —7) 5 PrintingManager & t2fifi L £9°( [ —/] > [HI]
> [Printing Manager] DIFIZER),

2 [HHHE-F] 27V v 7 LT, root/8AT—R%&ZAJJLET,

3 FIHAIRE T Y 2 DY A RIS, REEEET LTV 2 2 iERNL £
ED

4 57 Vy 7 LT [#E] ZFRL £,

5§ WEFATRTOTuNT 4 ZZHEL, [0K] 27Uy 7 LET,

123 7Y 5 DYk

1 XA 2 A== — 5 Printing Manager % tCfif| L £ 9°( [ —] > [Hli]]
> [Printing Manager] DIHIZIER),

2 [BHEE—RN] 2210927 LT, rootNATU—R&Z AL ET,
3 AIafRER T v 2 D) A RS, BT LT o7 28Rl £,
4 527092 LT [HIFf] 23R £7,

5 [OK] #7V v 27 L7 [Printing Manager] % A4 707 %L £,

12.4 KDETOHIR|Y 3 T DFFtE

T, KDETIEKPrinterZ > THIMIY a 7ZBIKBLET, co7 7V r—
YaviE, KDE7Z 7 U7 —v a vy llild s & i, mol o) s
NFEJ, KPrinter A 77T, 7V 7 OERBLCHNY 3 7o [ 7aN
T ] (N=VDE, V=B OX—=IFL WEAIRZ &) OfmEZ 1T
ESC
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T4y T TITVE—=2a305@ANTICTY BICT7rAINVERET S

KPrinterz FH) CHlE 9 25518, At+R2F — %2 L T, kprinter& AJJ
LEd, ZoHEE 77— g v E2REILZRNWTT 7 A )& AT
LIGEICHE T B E T, KPrinter¥ A 7 C [7rA] #THFrENE
T, 20X To, QT57 7 ANEHETEET, TAZ by TIN5
Ty ANERTy 7L TCYANMIRBYy TTDH0, $EF 77 ANTAT
7ML T 7y A IVEMELET,

ARSI X FEA 7 > g Y RIEET B, ETo [(Hik] #2270y 7 L%
T, U RO, [aE—=F23K%] . [T 7 a>] . BEY
[Additional Tags] D3> DX I FoRSINE T, GO OWTL X122,
[KPrinter CHIHIY a 7% BB T 51 211 N—=I)e B L T Z &0,

[X] 12.2 KPrinter THIli> 5 7% f#: 9 5

~ Printer
wne: (310 ) (2 peres |
State: Idle (accepting jobs)
Type: Lexmark Optra S 2455 Postscript

Location: 3.1.17
Comment: Lexmark Optra S 2455 PS on print.suse.de

[ (i

Files I Copies |gdvanced Options |AgditionaITags l

[

|Name |Type |Path |
“test Plain Text Document /home/tux/Documents/test (%]
Print system currently used: [CUPS (Common UNIX Print System) |vl

Server: localhost:631

[%| Keep this dialog open after printing

[@ Options =< Hf" System Options H@ Help l[,-.| Print l lx Cancel l

[2e—F 2880 & 7Tl N—ERENL = RFa2 A > hTRTD
NP, BHEON—, & IS TR & QN EEEL £7., £1-. %
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RLUZERF a2 XY MO ERETHFHON-V LT 20T L2 b TEE
T, [ZFRAN= FRE] ZERL T HIY g 7oIEMERETEEL £,
WEANZILC T [Billing information (F#215#)] % AJ1T 50, F213X—=TY 0
tEfE FEED N A DAR=T TRV EFIEL £ [Job Priority (3 5 7 £
B)] &, ZZTCHETLHZEHLTEET, RED¥ 7D [Additional Tags]
L AR EDY A, AT a 7E2REL 726, KlobViewerZ f
LTV a 7ol rRiZBHTE £,

12.5 KDETOHIfMY 3 T DELRR

KlobViewerld, A A v A==2—Mm6, Flida~<x >y KT Tkjobviewer
ZASILCGEEFILET, IOR-TLO7T 40V ROME»N, AL TS
VU DOF 2= ASNTNToORY 2 73 —5forsh 9, X123
[KJobViewer CO RIS g 7 DB QI2X— Ay a5 I 7 254 7T
RONE, ZToYa T EEETSET, YademET LI [P 7]

AZa—DTY MU EMHLET,

X1 12.3 KJobViewer TOHIFY a 7 D&

File Jobs Filter Settings Help

) o=y =3 & »
Job ID |Owner |Mame State Size (KB) |Page(s) |Prioril®
51 tux Test Page Completed 203 1
52 tux mozilla.ps Completed 2341 1
53 tux mozilla.ps Completed 2341 1
w4 tux mozilla.ps Completed 2341 1
w5 tux mozilla.ps Completed 2341 1 -
=] tux mozilla.ps Completed 2341 1 ke
] a[r
Keep window permanent Max.: Unlimited

e ZE TUUAITEELZODE LW SCEE S R ERT 215813,
VadkELELT, HTAERELThOHETALIZ ENTEET, B
DAY a 7. [HIF] 28Rl T a—olipptxsd, FU %
EETLINE, [TV EeBE] 2709 7 L TholiloTY v F 2% R
L7,

[FER 5 — ] Z23RT 2 &, CEPHEHRShET. ZoRFLITIIC
S [Tt ] > BT LAY a 7R /A 7] 2ERL. HNO R¥a
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77 > [JobIPPReport(>’ =z 7IPPLAN—F)] %27 )y 2 35&, ¥adofy
I R RS E ., CFEOBQKICISL., [Pa 7] > [BLE%E
HWeg] & [PaT] > [HEEERHKST] 2L UEEREHREL £7.

[Z2 %] Z2FRTLHE, HEOT) o205 TV a7/ N0 BxoNE
T, o [2—H2 g ToARKR] 2FRL T, HAaOHMY g 77200
TREND EDVICHETEET, Blifoa—WE HGLEo7 40—V RIZERRE
N,

[FE&] > [KJobViewer i ] 2R T L5 & HEX A 7 IR EN
£9, ZoF¥A7ar T, FoRTLOHRY a TORKRZFHEL £,
T4 IV RICBUEZ AT 50 ATA4 X2 HICHIIL TEZREL £,
[OK] %7V v 7 L CGRERRET LM, [Frvi] 27Uy 7 LTE
FEFICTAL 7R T LET,

V=N NR=DT7 A AL, A=a—0T7 7 A TELERTEL £7,
TAALD R TRARA Y EREINT D8, TOT A 22 OR%HER fHHIC
ST NNV TTF XA RBRORSINET,

Ta AN 82DWHY £9, ¥ a JIDIE. HIY AT AL ST
HENCH D B Toh, Ya7&2@ilL£9., ROl Yadx%kiEL
lca—YoalZ A4 ERNPAD, KICLEDOT 7 ANVENRAD T, 25—
Z2HNE, TaTdNERX 2 —1CH 5. BUFHIRIE Lo, F2139 Tl
ST L2 RLET, KIS, LEOV A X a/NAf NEfTEeX—VH
i CFRRENET, T 7 4V b OEFEIFS0TT A, LEICIEC TEET
TET, BRI a2 b ARMOMERFONERTHL I EHY
F9, VANTYade2G7 Vv rdhe, SURAKRAUHFDNT [Pg 7]
AZa—=MRREN, 77V arE2ERTEL LIV ET, 5CT LY
L T CELWEETIZADY L TT, [y > ROz EAMICEKRN] %
HINCT L&, Kalow 7 A »IICKIobViewerS HEIf IR S £ 7,

T A OE

213






N—HMIL. A5 =2y b






v b= #FimDEIE

AV =%y NEBIH LD, BT AV ERZET HICIE YaSTZf > T
AU H =y MEMERET 52 LENRDH Y £, ZHHOREICEDE T,
YaST CNetworkManager % {1 FH 92 72 & 5 2% IR L £9°, KDETIZ,
NetworkManager % 7= [ ZKlInternet% ffi > C A > % — % v Mtk g5 2 &
MMTEET,

NetworkManager % (i 3" 2 2> & 5 O Jr 4B 2D Tid, JH  [Managing
Network Connections with NetworkManager] (55307 Basic Networking, 1 Deployment
Guide) ¥ JH TlIntegration in Changing Operating Environments] (5525 Mobile
Computing with Linux, tDeployment Guide) % ZH{ L T { 72 &y,

13.1 KNetworkManager®{#

NetworkManager” 7 L v hAS, T A7 N v TIRIGCHEIRNSKEIL £9, £
DR, ZOT7 Ty NIVATLARNVARNICTA AV TRRENET, 77
Ly N2 L T, WOTUIPRIICHEHT 3y N =7 ZERTE £,
SZTHRLzry b =21k HEIFICERENS xy hT—27 L0 L&
FeshET, FHoTEETH T, EIRL 72y b =22 hET, 2
Dy NT—=2I127 72 ATER L - 12158, NetworkManager! & H Efjif]1C
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Manipulating Graphics with
The GIMP

The GIMP (The GNU Image Manipulation Program) is a program for creating and
editing raster graphics. In most aspects, its features are comparable to those of Adobe
Photoshop and other commercial programs. Use it to resize and retouch photographs,
design graphics for Web pages, create covers for your custom CDs, or almost any other
graphics project. It meets the needs of both amateurs and professionals.

Like many other Linux programs, The GIMP is developed as a cooperative effort of
developers worldwide who volunteer their time and code to the project. The program
is under constant development, so the version included in your system may vary slightly
from the version discussed here. The layout of the individual windows and window
sections is especially likely to vary.

The GIMP is an extremely complex program. Only a small range of features, tools, and
menu items are discussed in this chapter. See 18.7/H [For More Information |
(276 ~~— ) for ideas of where to find more information about the program.

18.1 Graphics Formats

There are two main types of graphics—raster and vector. The GIMP is intended for
working with raster graphics, which is the normal format for photographs and scanned
images. Raster graphics consist of pixels—small blocks of color that together create
the entire image. The files can easily become quite large because of this. It is also not
possible to increase the size of a pixel image without losing quality. The GIMP supports
most common formats of raster graphics.
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Unlike raster graphics, vector graphics do not store information for all individual pixels.
Instead, it uses geometrical primitives such as points, lines, curves, and polygons. Vector
images can be scaled very easily. There are many specialized applications for vector
graphics, for example Inkscape. The GIMP has only a very limited support for vector
graphics. For example, the GIMP can open and rasterize vector graphics in SVG format
or work with vector paths.

18.2 Starting The GIMP

Start The GIMP from the main menu. Alternatively, enter gimp & in a command line.

18.2.1 Initial Configuration

When starting The GIMP for the first time, a configuration wizard opens for preparatory
configuration. The default settings are acceptable for most purposes. Press Continue in
each dialog unless you are familiar with the settings and prefer another setup.

18.2.2 The Default Windows

Three windows appear by default. They can be arranged on the screen and, except the
toolbox, closed if no longer needed. Closing the toolbox closes the application. In the
default configuration, The GIMP saves your window layout when you exit. Dialogs
left open reappear when you next start the program.

The Toolbox

The main window of The GIMP, shown in [X] 18.1. [The Main Window] (263 “X—
), contains the main controls of the application. Closing it exits the application. At
the very top, the menu bar offers access to file functions, extensions, and help. Below
that, find icons for the various tools. Hover the mouse over an icon to display information
about it.
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X1 18.1 The Main Window

Eile Xins Help

Paintbrush @ =

Opadily: = 1[100.0 |5

-

Mode: |Norma\ >
Brush: | [ ||Circ\e )
P Pressure sensitivity
[[] Fade out

[] Incremental

[] Use color from gradier

The current foreground and background color are shown in two overlapping boxes. The
default colors are black for the foreground and white for the background. Click the box
to open a color selection dialog. Swap the foreground and background color with the

bent arrow symbol to the upper right of the boxes. Use the black and white symbol to

the lower left to reset the colors to the default.

To the right, the current brush, pattern, and gradient are shown. Click the displayed one
to access the selection dialog. The lower portion of the window allows configuration

of various options for the current tool.

Under the toolbox, a dialog shows options for the currently selected tool. If it is not
visible, open it by double-clicking the tool's icon in the toolbox.
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Layers, Channels, Paths, Undo

In the first section, use the drop-down box to select the image to which the tabs refer.
By clicking Auto, control whether the active image is chosen automatically. By default,
Auto is enabled.

Layers shows the different layers in the current images and can be used to manipulate
the layers. Information is available in 18.5.6JH [Layers] (274 ~X— ). Channels
shows and can manipulate the color channels of the image.

Paths are a vector-based method of selecting parts of an image. They can also be used
for drawing. Paths shows the paths available for an image and provides access to path
functions. Undo shows a limited history of modifications made to the current image.
Its use is described in 18.5.5/H [Undoing Mistakes] (274 ~X— ).

18.3 Getting Started

Although The GIMP can be a bit overwhelming for new users, most quickly find it
easy to use once they work out a few basics. Crucial basic functions are creating,
opening, and saving images.

18.3.1 Creating a New Image

To create a new image, select File > New or press Ctrl+ N. This opens a dialog in which
to make settings for the new image. If desired, select a predefined setting called a
Template. To create a custom template, select File > Dialogs > Templates and use the
controls offered by the window that opens.

In the Image Size section, set the size of the image to create in pixels or another unit.
Click the unit to select another unit from the list of available units. The ratio between
pixels and a unit is set in Resolution, which appears when the Advanced Options section
is opened. A resolution of 72 pixels per inch corresponds to common screen display.
It is sufficient for Web page graphics. A higher resolution should be used for images
to print. For most printers, a resolution of 300 pixels per inch results in an acceptable
quality.
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In Colorspace, select whether the image should be in color (RGB) or Grayscale. For
detailed information about image types, see 18.5.7JH [Tmage Modes] (275 “X— ).
In Fill With select the color the image is filled with. You can choose between Foreground
Color and Background Color set in the toolbox, White or Transparency for a transparent
image. Transparency is represented by a gray checkerboard pattern. Enter a comment
for the new image in Comment.

When the settings meet your needs, press OK. To restore the default settings, press
Reset. Pressing Cancel aborts creation of a new image.

18.3.2 Opening an Existing Image

To open an existing image, select File > Open or press Ctrl+ O. In the dialog that opens,
select the desired file. You can also press Ctrl + L and type directly the path to the
desired image. Then click Open to open the selected image or press Cancel to skip
opening an image.

18.3.3 Scanning an Image

Instead of opening an existing image or creating a new one, you can scan one. To scan
directly from The GIMP, make sure that the package xsane is installed. To open the
scanning dialog, select File > Acquire > XSane: Device dialog.

Create a preview when the object to scan is smaller than the total scanning area. Press
Acquire preview in the Preview dialog to create a preview. If you want to scan only
part of the area, select the desired rectangular part with the mouse.

In the xsane dialog, select whether to scan a binary (black and white without shades of
gray), grayscale, or color image and the required scan resolution. The higher the
resolution you choose, the better the quality of the scanned image. However, this also
results in a correspondingly larger file and longer scanning process, due to a higher
resolution. The size of the final image (both in pixels and bytes) is shown in the lower
part of the dialog.

In the xsane dialog, use the sliders to set desired gamma, brightness, and contrast values.
These sliders are not available in binary mode. Changes are visible in the preview
immediately. Once all settings have been made, click Scan to scan the image.
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18.3.4 The Image Window

The new, opened, or scanned image appears in its own window. The menu bar in the
top of the window provides access to all image functions. Alternatively, access the
menu by right-clicking the image or clicking the small arrow button in the left corner
of the rulers.

File offers the standard file options, such as Save and Print. Close closes the current
image. Quit closes the entire application.

With the items in the View menu, control the display of the image and the image window.
New View opens a second display window of the current image. Changes made in one
view are reflected in all other views of that image. Alternate views are useful for
magnifying a part of an image for manipulation while seeing the complete image in
another view. Adjust the magnification level of the current window with Zoom. When
Shrink Wrap is selected, the image window is resized to fit the current image display
exactly.

18.4 Saving Images

No image function is as important as File > Save. It is better to save too often than too
rarely. Use File > Save as to save the image with a new filename. It is a good idea to
save image stages under different names or make backups in another directory so you
can easily restore a previous state.

When saving for the first time or using Save as, a dialog opens in which to specify the
filename and type. Enter the filename in the field at the top. For Save in folder, select
the directory in which to save the file from a list of commonly used directories. To use
a different directory or create a new one, open Browse for other folders. 1t is
recommended to leave Select File Type set to By Extension. With that setting, The
GIMP determines the file type based on the extension appended to the filename. The
following file types are frequently useful:

XCF
This is the native format of the application. It saves all layer and path information
along with the image itself. Even if you need an image in another format, it is
usually a good idea to save a copy as XCF to simplify future modifications.
Information about layers is available in 18.5.6JH [Layers] (274 ~X— 7).
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PAT
This is the format used for The GIMP patterns. Saving an image in this format
enables using the image as a fill pattern in The GIMP.

JPEG
JPG or JPEG is a common format for photographs and Web page graphics without
transparency. Its compression method enables reduction of file sizes, but information
is lost when compressing. It may be a good idea to use the preview option when
adjusting the compression level. Levels of 85% to 75% often result in an acceptable
image quality with reasonable compression. Saving a backup in a lossless format,
like XCEF, is also recommended. If editing an image, save only the finished image
as JPG. Repeatedly loading a JPG then saving can quickly result in poor image
quality.

GIF
Although very popular in the past for graphics with transparency, GIF is less often
used now because of license issues. GIF is also used for animated images. The
format can only save indexed images. See 18.5.7JH [Image Modes] (275 ~X—
) for information about indexed images. The file size can often be quite small if
only a few colors are used.

PNG
With its support for transparency, lossless compression, free availability, and
increasing browser support, PNG is replacing GIF as the preferred format for Web
graphics with transparency. An added advantage is that PNG offers partial
transparency, which is not offered by GIF. This enables smoother transitions from
colored areas to transparent areas (antialiasing).

To save the image in the chosen format, press Save. To abort, press Cancel. If the image
has features that cannot be saved in the chosen format, a dialog appears with choices
for resolving the situation. Choosing Export, if offered, normally gives the desired
results. A window then opens with the options of the format. Reasonable default values
are provided.

18.5 Editing Images

The GIMP provides a number of tools for making changes to images. The functions
described here are those most interesting for home users.
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18.5.1 Changing the Image Size

Once an image is scanned or a digital photograph is loaded from the camera, it is often
necessary to modify the size for display on a Web page or for printing. Images can
easily be made smaller either by scaling them down or by cutting off parts of them.
Making an image larger is much more problematic. Because of the nature of raster
graphics, quality is lost when an image is made larger. It is recommended to keep a
copy of your original image before scaling or cropping.

Cropping an Image

Cropping an image works like cutting the edges off a piece of paper. Select the crop
tool from the toolbox (it resembles a scalpel) or with Tools > Transform Tools > Crop
& Resize. Click a starting corner and drag to outline the area to keep.

A small window opens with information about the starting point and the size of the
selected area. Adjust these values by clicking and dragging a corner of the crop box or
by adjusting the values in the window. From Selection adjusts the crop to fit the current
selection (selections are explained in 18.5.2/H [ Selecting Parts of Images] (269 X —
). Auto Shrink makes the crop smaller based on color changes in the image.

Press Cancel to abort the crop. Press Crop to crop the image. The results of Resize are
identical to those of Change Canvas Size, described in Changing the Canvas Size/H
(269 ~—).

Scaling an Image

Select Image > Scale Image to change the overall size of an image. Select the new size
by entering it in Width or Height. To change the proportions of the image when scaling
(this distorts the image), click the chain icon to the right of the fields to break the link
between them. When those fields are linked, all values are changed proportionately
when the value in one of the fields is changed. Adjust the resolution with X resolution
and Y resolution.

Interpolation is an expert option that controls the scale method. When finished adjusting
the size, press Scale to scale the image. Reset restores the original values. Cancel aborts
the procedure.
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Changing the Canvas Size

Changing the canvas size is like putting a mat around an image. Even if the mat is
smaller, the rest of the image is there, but you can only see part of it. If the mat is larger,
you see the original image with extra space around it. To do this, select Image > Canvas
Size.

In the dialog that opens, enter the new size. By default, the width and height maintain
the same proportions as the current image. To change this, click the chain icon.

After adjusting the size, determine how the existing image should be positioned in
comparison to the new size. Use the offset values or drag the box inside the frame at
the bottom. When satisfied with the changes, click Resize to change the canvas size.
Click Reset to restore the original values or Cancel to cancel the canvas resize.

18.5.2 Selecting Parts of Images

It is often useful to perform an image operation on only part of an image. To do this,
the part of the image with which to work must be selected. Areas can be selected using
the select tools available in the toolbox, using the quick mask, or combining different
options. Selections can also be modified with the items under Select. The selection is
outlined with a dashed line, called marching ants.

Using the Selection Tools

The main select tools are rather easy to use. The paths tool, which can also be used for
more than selecting, is more complicated so is not described here. In the tool options
for the other select tools, use one of the icons in the Mode row to determine whether
the selection should replace, be added to, be subtracted from, or intersect with an existing
selection.

Rect Select
This tool can be used to select rectangular or square areas. In the tool options, select
among Free Select, Fixed Size, and Fixed Aspect Ratio to control the shape and
size of the selection. To make a square selection in the free select mode, hold Shift
while selecting a region.
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Ellipse Select
Use this to select elliptical or circular areas. The same options are available as with
rectangular selection. Holding Shift during selection produces a circle.

Free Select (Lasso)
Draw a selection area freehand with this tool by dragging the mouse over the image
with the left mouse button pressed. The end points will be connected with a straight
line when you release the tool. The area inside is then selected.

Fuzzy Select (Magic Wand)
This tools selects a continuous region based on color similarities. Set the maximum
difference between colors in the tool options dialog in Threshold.

By Color Select
With this, select all the pixels in the image with the same or similar color as the
clicked pixel. The maximum difference between colors can be set in the tool options
dialog in Threshold.

Intelligent Scissors
Click a series of points in the image. As you click, the points are connected based
on color differences. Click on the first point to close the area. Convert it to a regular
selection by clicking inside it.

Using the Quick Mask

The quick mask is a way of selecting parts of an image using the paint tools. A good
way to use it is to make a rough selection using the intelligent scissors or the lasso
(freehand selection tool). Then activate the quick mask by pressing the small icon with
the dashed box in the lower left corner.

The quick mask displays the selection using an overlay of red. Areas shaded with red
are not selected. Areas appearing as they did before the mask was activated are selected.
To modify the selection, use the paint tools. Painting with white selects the painted
pixels. Painting with black deselects pixels. Shades of gray (colors are treated as shades
of gray) are a partial selection. Partial selection allows smooth transitions between
selected and unselected areas.

To use a different color for displaying the quick mask, right-click the quick mask button
then select Configure Color and Opacity from the menu. Click the colored box in the
dialog that opens to select a new color.
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After using the paint tools to adjust the selection as desired, convert from the quick
mask view back to the normal selection view by clicking the icon in the lower left
corner of the image window (currently displaying a red box). The selection is again
displayed with the marching ants.

18.5.3 Applying and Removing Color

Most image editing involves applying or removing color. By selecting a part of the
image, limit where color can be applied or removed. When you select a tool and move
the cursor onto an image, the cursor's appearance changes to reflect the chosen tool.
With many tools, an icon of the current tool is shown along with the arrow. For paint
tools, an outline of the current brush is shown, allowing you to see exactly where you
will be painting in the image and how large an area will be painted.

Selecting Colors

Paint tools use the foreground color. To select the color, first click the display box of
the foreground color. A dialog with four tabs opens. These tabs provide different color
selection methods. Only the first tab, shown in [¥] 18.2. [The Basic Color Selector
Dialog| (271 ~X—7Y), is described here. The new color is shown in Current. The
previous color is shown in Old.

[X] 18.2 The Basic Color Selector Dialog

E.“_@@j ® H E—————— (0 ||

Os e— 0[]
v — e
O B — 0[]
O 5 E— 0 [*]
HTML Nofaton- (000000 |
i || e e e e

oo e JC IO I

| @.Hem | ‘ EReset H X Gancel H Fox ]

The easiest way to select a color is using the colored areas in the boxes to the left. In
the narrow vertical bar, click a color similar to the desired color. The larger box to the
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left then shows available nuances. Click the desired color. It is then shown in Current.
If that color is not what you want, try again.

The arrow button to the right of Current enables saving a number of possible colors.
Click the arrow to copy the current color to the history. A color can then be selected
by clicking it in the history. A color can also be selected by directly entering its
hexadecimal color code in HTML Notation.

The color selector defaults to selecting a color by hue, which is usually easiest for a
new user. To select by saturation, value, red, green, or blue, select the corresponding
radio button to the right. The sliders and number fields can also be used to modify the
currently selected color. Experiment a bit to find out what works best for you.

When the desired color is shown in Current, click OK. To restore the original values
shown when the dialog was opened, click Reset. To abort changing the color, click
Cancel.

To select a color that already exists in your image, use the color picker tool, the icon
for which resembles an eye dropper. With the tool options, set whether the foreground
or background color should be selected. Then click a point in the image that shows the
desired color. When the color is right, click Close to close the tool's dialog.

Painting and Erasing

To paint and erase, use the tools from the toolbox. There are a number of options
available to fine-tune each tool. Pressure sensitivity options apply only when a pressure-
sensitive graphics tablet is used.

The pencil, brush, airbrush, and eraser work much like their real-life equivalents. The
ink tool works like a calligraphy pen. Paint by clicking and dragging. The bucket fill
is a method of coloring areas of an image. It fills based on color boundaries in the image.
Adjusting the threshold modifies its sensitivity to color changes.

Adding Text

With the text tool, easily add text to an image. With the tool options, select the desired
font, font size, color, justification, indent, and line spacing. Then click a starting point
in the image. A small dialog opens in which to enter your text. Enter single or multiple
lines of text then press Close.
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The text tool creates text on a special layer. To work with the image after adding text,
read 18.5.6JH [Layers] (274 ~X—3’). When the text layer is active, it is possible to
modify the text by clicking in the image to reopen the entry dialog. Change the settings
by modifying the tool options.

Retouching Images—The Clone Tool

The clone tool is ideal for retouching images. It enables you to paint in an image using
information from another part of the image. If desired, it can instead take information
from a pattern.

When retouching, it is usually a good idea to use a small brush with soft edges. In this
way, the modifications can blend better with the original image.

To select the source point in the image, press and hold Ctrl while clicking the desired
source point. Then paint with the tool as usual. When you move the cursor while
painting, the source point, marked by a cross, moves as well. If the Alignment is set to
Non Aligned (the default setting), the source resets to the original when you release the
left mouse button.

18.5.4 Adjusting Color Levels

Images often need a little adjusting to get ideal print or display results. In many programs
designed for inexperienced users, the brightness and contrast levels are modified. This
can work and is also available in The GIMP, but better results can be obtained by
adjusting the color levels.

To do this, select Layer > Colors > Levels. A dialog opens for controlling the levels in
the image. Good results can usually be obtained by clicking Auto. To make manual
adjustments to all channels, use the dropper tools in All Channels to pick areas in the
image that should be black, neutral gray, and white.

To modify a channel individually, select the desired channel in Channel. Then drag the
black, white, and middle markers in the slider in /nput Levels. Alternatively, use the
dropper tools to select points in the image that should serve as the white, black, and
gray points for that channel.

If Preview is checked, the image window shows a preview of how the image would
look with the modifications applied. When the desired result is achieved, press OK to
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apply the changes. With Reset, restore the original settings. Cancel aborts level
adjustment.

18.5.5 Undoing Mistakes

Most modifications made in The GIMP can be undone. To view a history of
modifications, use the undo dialog included in the default window layout or open one
from the toolbox menu with File > Dialogs > Undo History.

The dialog shows a base image and a series of editing changes that can be undone. Use
the buttons to undo and redo changes. In this way, you can work back to the base image.
If you undo a modification then make a new one, the undone modification cannot be
redone.

Changes can also be undone and redone with the Edit menu. Alternatively, use the
shortcuts Ctrl +Z and Ctrl + .

18.5.6 Layers

Layers are a very important aspect of The GIMP. By drawing parts of your image on
separate layers, change, move, or delete those parts without damaging the rest of the
image. To understand how layers work, imagine an image created from a stack of
transparent sheets. Different parts of the image are drawn on different sheets. The stack
can be rearranged, changing which parts are on top. Individual layers or groups of layers
can shift position, moving sections of the image to other locations. New sheets can be
added and others set aside.

Use the Layers dialog to view the available layers of an image. The text tool
automatically creates special text layers when used. The active layer is highlighted. The
buttons at the bottom of the dialog offer a number of functions. More are available in
the menu opened when a layer is right-clicked in the dialog. The two icon spaces before
the image name are used for toggling image visibility (eye icon when visible) and for
linking layers. Linked layers are marked with the chain icon and moved as a group.

Only layers with transparency (an alpha channel) can be placed above other layers in
a stack. To add this to a layer, right-click and select it from the menu.
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18.5.7 Image Modes

The GIMP has three image modes—RGB, Grayscale, and Indexed. RGB is a normal

color mode and is the best mode for editing most images. Grayscale is used for black-
and-white images. Indexed limits the colors in the image to a set number. It is mainly
used for GIF images. If you need an indexed image, it is normally best to edit the image
in RGB then convert to indexed right before saving. If you save to a format that requires
an indexed image, The GIMP offers to index the image when saving.

18.5.8 Special Effects

The GIMP includes a wide range of filters and scripts for enhancing images, adding
special effects to them or making artistic manipulations. They are available in Filters
and Script-fu. Experimenting is the best way to find out what is available. X¢ns in the
toolbox includes a number of items for creating buttons, logos, and other things.

18.6 Printing Images

To print an image, select File > Print from the image menu. If your printer is configured
in the system, it should appear in the list. In some cases, it may be necessary to select
an appropriate driver with Setup Printer. Select the appropriate paper size with Media
Size and the type in Media Type. Other settings are available in the Image / Output
Settings tab.
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[X] 18.3 The Print Dialog

Printer Settings I Image / Output Settings |

Printer name: [‘File B

Printer model. PostScript Level 2

[ Setup printer... ] { New printer... ]
Media size |‘Leﬂer |LJ
Dimensions:  wigtn: [0.00 | Heign: [0.00 |

Media type: Standard

Media source: | Standard

Ink type Standard
Resolution: Standard
Position
Qrientation: ‘ Landscape = |
Let: (050 | Top (050 |
Right 1050 | Botiom |8.00 |
Right Border: [0.50 | Botiom Border: [0.50 |
Center [ Vertically l [ Both I [Honzomal\yl
Size

Scaling 0 [000 [

Scale by: @ Percent Width |1D 00 ‘ Units: @

e Use Original
O em Image Size

O PPI Height: |7.50

Save
Settings

l @ nep

=

Print and
Save Seftings

X Cancel

In the bottom portion of the window, adjust the image size. Press Use Original Image
Size to take these settings from the image itself. This is recommended if you set an
appropriate print size and resolution in the image. Adjust the image's position on the
page with the fields in Position or by dragging the image in Preview.

When satisfied with the settings, press Print. To save the settings for future use, instead

use Print and Save Settings. Cancel aborts printing.

18.7 For More Information

The following resources are useful for users of The GIMP, even if some of them apply

to older versions.
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Help provides access to the internal help system. This documentation is also
available in HTML and PDF formats at http://docs.gimp.org.

Find many tutorials explaining basic or advanced image manipulation techniques
with The GIMP at http://gimp.org/tutorials/.

The GIMP User Group offers an informative Web siteat http://gug.sunsite
.dk.

http://www.gimp.orgq is the official home page of The GIMP.

Grokking the GIMP by Carey Bunks is an excellent book based on an older version
of The GIMP. Although some aspects of the program have changed, it can provide
excellent guidance for image manipulation. An online version is available at
http://gug.sunsite.dk/docs/Grokking-the-GIMP-v1.0/.
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LET,

3 A OMZFILELERL £9, 2 ol Tl
DG T 51012,

KD

4 [Add/Delete Option] 7 > 2 > T,
Vw27 LET. BHFEOMZFIL—ILo TIC,

EJ

5 205 H OMEIEELRIRL £9. Z 04,

T NI XN TOEIE 2T 272912,
[Tag+Equals+Filters] Zi#ERL 7,

[Add New Advanced Search] % 3%

#1Hilh(Rating)7)%5 > 5 (5 Stars)
[Rating+Equals+5 Stars] Zi={RL £

[or] Z@RL T,
HLWMEIL— uasBEfnsh

[Add] % 7

[Filters) TS5 %HIOZ 7

6 LIEIIIE L CHIOMAIEEZBML 720, HEHEZ 7))L —T(LL 720, Hl
FRLTLIZ S0, MR, MY 4+~ RIS E T,

7 SERUMEHT 2 7-0ICMELZRFET HICUE, GRHIZ ATIL THh 6,
[OK] %27 1V) v 7 LT [Advanced Search] % A4 77 %L £,

X1 19.4 itk = « L5 DIFEK

Search Rules

[ Rating ;vi |Equals

o] ek

Or

{Tag :vi {Equa\s

-1
& i Filters

Add/Delete Option
[t

Group/Ungroup Options
Coon |

Save search as: [Lasl Search

(@ Help |
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19.7 BfaL o3 vDIT o AR— P

digiKamiZ X, fADOEHEIL 7> 50D 7 —hA4 T NBICHE D, 1D
MOLY AR—=KNATarBHYEd, CDXDVDAND T — 1A 7 (k3b%
7). HTIMLAND LY AR =K, VE—FX ¥ T UANDLY AR — MDTAE
B

W{g 2L 7 v g 2 CDE/ZIIDVDICRIET H1cid. DL FoFIEICEN £ T,

1 [Album] > [Export] > [Archive to CD/DVD (CD/DVD D 7 — 774
7)1 2Rl £9,

2 [Create CD/DVDArchive] % A 7T DN DNDHY T X =2 —"T, W
BRI TNET, Thns, [OK] 27V v 7 LT, FEIART
a2 %xMEL 7,

2a VIVNLB LU 7 2ERL T( [Selection] )., 2V 7 ardHb
DEDTN T —NA T T LT ROFET,

2b [HTMLInterface] Tl¥. H{$a L 7> 5 v ZHTMLIEA TR TS
HEICTTHEMNEID, £7-CD/DVDT —H A 71 HEfF THEEER
BINTENEIDERELET, aLZ gAML, A A—
V. 74 b BEOWEOTONRT 4 ZREL T EE N,

2c VEIZIL L T, [Media Volume Descriptor] DRV = — LERIHDRE
EEHELET,

2d VLEICIDC C.  [Media Burning] O&EZART T qa v HEHL F
—gAO
BV Y q Y OHTMLT 7 2R — b &2 FRT 51213, LI T oFIEIC e
7.

1 [Album] > [Export] > [HTML Export] %R L £ 7,
2 [Create Image Galleries] D\ D DH T A =2 —T, LERFE%

TOET, 5E7Lkes. [OK] #2V v 7 LT Fx 7 UofEkzh
mLEd.
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2a VIWNRLBLOZ 72 EIRLT, a7y a o) boXobiinsk
T—=NATT 0L RDFET,

2b [Look] #ffi-><C. HIML¥ ¥ S5V —D#% A MVEANEZFEEL £
7.,

2c [Album] TlX. T4 A7 FOX v TV DOETe., A A=YV A
X, FEfi, 74—~y b, BEOFEKRENLX Yy T U RICFKREHh
HAAT—HADEERDET,

2d [Thumbnails] TlX. ¥¥ T VU —IEKRT LV LA INVDOY A X,
Hhii. BEOTyANI A TEEELET,

avrvarkEA =%y b FOWNEA A=V F I VI AR— T
5121, DToFEICENE T,
1 Xv IV Z2ELINBWebY A4 hOT7Hh o ME2IEL £7,

2 [Album] > [Export] > [Exportto Remote Gallery] %R T, 71
Y=l MK ESRS NG EE. MY A BOURL, =%, N2
77— R% AJJL £, Digikamid, TEE S N7V A b ANDfEhnk b7 L
C. [Gallery Export] x5 %7 4 v REFoRrL £7,

3 X v TUNDOH LT ANRLOEAT & RO ET.

4 [NewAlbum] %7 V) v 7 LT, digiKam»* 53K 657z SHE#RE AL
i@‘o

5 [Add Photos] T. ILWWTFAUNLIIA A=V % Ty Ta—RLET,

19.8 BEDOFRTERE

digiKamiZld, S ESET T 7 A 2 ak v 37D 17 WG o /Am b HED
HEESNTHE T, digiKamZ R/t — NIST 21213 HEOT Lx AL
EETNIV w2 LET, T4 EMHATSHICIE. digikamplugins
Ny lr =L VAN NVTL0ENRHY £,
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HAGEZ KA N L T2, B2 NI " MAT LIS [View] ZHHL £
9, [Histogram] &7 a > &>, HFOENICEHT HEREFRKRT 5
ZEMTEET,

X 19.5 b XK ILDER

File Edit Image Fix Transform View Filters Settings Help

GROe EH~~v{H &5 @

JJI_4484 JPG (46 of 75) Zoom: 17.48% 3872x2592 pixels

HGEDTANT 1, WA F BEOY 7 EimE L2y, ML GNR %z
ALY, ERISCFI 2 AT 21213, [Image] A ==2— 2L
ER

T 7 AF ¥ DI
BRI 55 7 2F v O E BN T 77 2F v OMEEIREL
$9( [Relief] ). 77 AF ¥ hSEA & h, EERNEDEEOA ) P F )12
E—ICRkEFESNET,

Peig BN
PHROFEZ IR £9, #IRL PR ofHICIEC ¢ PHiofEx1o
F2F20 R L, MHEolEZFEL 3, PHEMER S, EEHNED
GO ) VF N a— iR FEINET,

FUXZINEGE LYY g v OEH
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T % 2 kD A
HBHRICFRT BT XA NE AL, 74 b, AT AN, BIOYV A X%
ERL £79., 7% A NOLARIAEREERL, XA MRz 50
I, BLOMEERT 57T ollRAEZIEEL 9, LIEIIOT TR
MO BIAEZIFEL 3., AV YFLVEBEOTF A NERH LA YVICT T A
MANEIEET,

19.8.1 B DEIE & T

[Fix] *=a—%FHL T, M{RICBET L3 E S EFRMEIEILE. T2
CEMTEET,

Colors

ISR T2 S S EREZ ML £7,

Blur/Sharpen(IX/> L/ ¥ — )
5% v =Lz, 138LFET,

Unsharp Mask(7 >3 ¥ — 7 < A7)
ERD T » — T2k L 7.

U4 —HA
TA—NAEFHEL T, H{gEE2T vy —7ICLET,

7 H DR
77y v affifiic L ARHEMIEL £7.

Inpainting(§ V) [E. L)
5N DAL IR 2 IBIEL £7,

Hot Pixel Correction(7s v b & 27 ZJVIZ1IE)
NATR Y DOAREZ VIVICL D, BHENOYE Y 2IVICE T 2 R % i

. BIEL 7,

(CHIN
J)ARRAY Sy Fy, &FSERMHEOT Y ZIOVEHRICE T 5 K%
BIET 2 FREREML TnET,
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Noise Reduction(/ A X1 ik)
v/z%t/ﬁwfnU@aﬁF@@K% [EIEL 9. ISORE % & <
NELIzZelickder v ) A XL, i E ATy 1k D A
Z’f’ﬂ?ﬂ’&ﬁdﬁ?b E

Lens Distortion Correction( L > XEJ%?@E)

WL AR L~ ZDfFIC {5 DB TE 220 S e S UE 22 % il
IELET,

S UAHIE
FAL A L > ZoHIC L A, BHER R E 7230w 7 T V(O ER) &
HWEL £,

[Fix] OFSRER IS 272012, 72 & XL [Inpainting] OFSREZR LT E
Lr9. VYADGRHNI KD EHRICRIENVE L G2 5 THET,
ZDH A T ORI EEIET 512l DIToFIEICENE T,
H§ %S £,
2 YURAN = IIVEMS T BEIET IR E IR L 7.

3 [Fix] > [Inpainting] OIFEITERT 57>, F7213Shift + 1F — 24 L £
ER

4 FXENEBIET LI EEIREL £7,
s WINhDT Yy N T g3 2 ( [Remove Small Artifact,  [Remove
Medium Artifact] . F 7213 [Remove Large Artifact] Y% 1#IR L., =X
T w7 6] WERET,
© TANWINTGA=FEFELET., IXt-> THEZEDE T, 2T v
75

5 77Uty b7 4 vEZOMHEZIERL 25 ( [Preset] % 7).
[Smoothing] & [Advanced Settings] % 7% fi-> T, XENZ ML
TLIEE W,

6 [OK] 27 Vvy /T 2e, HENEIJLL THEMEEShET,
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T4y T HEBDT 4 W REDERE B

[G U AEZ MO o T 205 5 k9 2ig&idi- e 21E vy
ZDOFIC L0 B OEGIC]E U RS FRAEL T 5 Lo 2tEd). i
HO7 4 WVERELFRLET., MBDO T 4 VZ 2 R{FT 51T
[SaveAs] %7 V) v 7 L TGRENEEZT X AR 7 7 A VICIRIEL %
9, DIBoE{§ % EET 2551, [Image Inpainting] % A 712
ZHHNT [Lload] 27V 7 L. T 57 4 )V EFEHIET 27
XA Ty ANESTRLT [OK] #227 VU v 7 LET,

X119.6  [Inpainting] % > /=175 DfpS:

File Edit Image Fix Transform View Filters Setings Help

Q00O v~a ek

¥

¥ Photograph Inpainting - digiKam <@K4> -9
‘ =§%ag:“ Photograph Inpainting @DQHK@UJﬁff

Preset [ Smoothing | Advanced Seftings

N pomereaty

= Yakis 10" Filtering type: |[Remove fiiedium Arefaci

[ e ]

[ﬁ Help~ H Defaults ] [ Load... H Save As... ”V OK HX Cancel l

19.8.2 BEEEIEDEA

WA LKA N L 720, [Blfizd 5121%,  [Transform] A == —7%HL £
ER

Rotate. Flip. Free Rotation
5% —EofEEfi L £9.  [Rotate] 1%, WAE %905 AT Tz L F
9. [Free Rotation] Z{fif¥ i, (EEoRfizfELIFETEET,
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Crop. Aspect Ratio Crop
Efg%E 27y 7LEYd. [Crop] V& EEORGZOMEIKZ]Y XY £
9. [Aspect Ratio Crop] Z il THIE, SEIERGETHGEDO Y ay
YT RITIZEMTEET,

Perspective Adjustment
HR O 2L £, /2o A3, EEAME IR E ZTEG O
JEMBMNLWHEHFIC, 2OV = Veffio TENZBEIETL2enTEE
T, HEOMICH LNV RV EM ST, BljL TLES0, %@f%ab
TAEU BB O A EZ AR L 72D HfZ2 b I 7951
[Crop] YV —)VEMHAL T,

Shear
{5 D —uB% & % JI, 7 L CRIoEN %2 O T /il U £ 3 (Rl
F 7213k, HEEE 2K EAROfEEREL T [Crop] Z{fi->
THEROEGEZ NI V7L ET,

Resize, Blowup

u@%ﬁkﬁﬂbiﬁ; [Resize] TlE. EZ VNN FF N A—k 2 %
o CTHGY A ZERICEET L2 eMTEET, 7AXT MR
THMWE DM EIRL TLZEW, [Blowup] V3RS, [6) L & 9 2|
By A4 ZEFENIE 2 F L £9°, 72720, IKAMENT 5720 T, %
DFGRIBERIC 7 4 VA WAL T, EM%%E%E&(%T%) ZEMTEET,
AR 2 QI3 2 DD 5551, [Resize] D\ VIZ [Blowup]
EIERL CTL 7280, ”@74»&&Ei\%¢xh7?4wmﬁﬁ?
HZEMTEFET, RIFERFELLHELZ AAA T, BRI H
HIEMTEET,

BEIENEIIANERH 5 G, —E0NCEGhbE (HiEE 7 ay 73 5.0
D LD RGNS LG EEATHEL L9, 2D LI
[Aspect Ratio Crop] % i CLLFNOVEEERITWVE T,

H g E2E £,
2 [Transform] > [Aspect Ratio Crop] DNAIZIERL £ 7,

3 MELTANY MEETRTEL £7.,

L
[X] . [Width] . BE [Y] . [Height] A5 A X %&ffio> T, [
Booz)—ray JEIEELET,
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YA
Ty MEDICOVICHHT 2 Hh 2% LolEe F S oz R L
EC

[X:Y Ratio |
6oL, FEOAIRIC —#ENHbhn 2 Y 1 XoKH
ICEaWET, HIC—B G747y a v 2EIRL T &0,

[Golden Ratio]
FERMD S ERMEREEFIHH SN TS, mRROFMEZEGHE
(W 4H1:1.618) 9,

THE L 2R Cr]gER I K A A0 7 1y Tz 3 ET 512lE. [Max.
Ratio] #MHL £7,

4 7y THEIBERELZS, LEILE TERNV—VEEHL £9, A&
RADWOHEREE L 72D DFIEICIE.  [Composition Guide] 731%7. 5
F9, LVRVWHE{GZEL7-DD0HA K LT, SigBforanEd,

74 v 7 EMER

INEDOF TV g oML, http://docs.kde.org/
development/en/extragear—graphics/digikam/
using-kapp-imageeditor.htmlZZIHL T Z Sy,

5 7y T GV —ILEGhnEEE. ML T Z S0,

6 XENFICEHLECEEEZ NIV T5IE. [OK] 2270927 L
EC N
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F19.7 FRANZ NEZ Ty TEflS 2 X802y TDIEK

Aspect ratio: ‘TGnIdenrﬁam —

X
..........
Width:
b ¢
Height:
Composition guide (éﬁéﬁé’a? i )

% Golden sections
[%| Golden spiral sections

[% Golden spiral

= | 7] Golden tiiangles
(] Elip horizontally
| Flip vertically

—
T=]

Color and width: 1’_____“___25 F____,'ﬁ

g I [ ] [ |
| @ Help | | Max Aspect || ResetValues | v OK \i)‘( Cancel |

19.8.3 7 4 LA LR DEH

S IEBRIARMRL T 4 V5 2 LT IR0 RARA D]
BElERT L2 TEET,

Black & White
N7 — WG % HEREGICEIR L £, Bl 7 L — 27 — VG E R
LY5&lE.  [Neutral Black & White] % 1EiRL £, H{EHN OIFED %
WMIHT LN T —T 4 VEE ALY, R FREEOHEYI 2
L — NTBI121E. WINrD [Black & White with ... Filter] 7> a2 %
HHRL £9, MR P2EBT 5121, IO [Black & Whitewith ...
Tone] ¥ 7 g v EERL £,

Raindrops
EGICERZ WA L £9. WHOY A ZEWEIFEL 2Kic, Wi
L LOMBDE G % [Fisheyes] \THHEL £7.

Infrared Film
JEBLEIN AR M 72012, FIMET 4 L LofifE Y 32— b LE
T AGRITCOEN G & RIFICE R Y £97., FRRPISOBL 2 L T,
KOT7 =54 AT 1 v I RMREHRDL L L TEET,
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Qil Paint
HWAAY I 2 b—bMLET, HIFICTHEHT L7700 A X AL—-V 0T
DEGWEIFEL TLES 0,

Emboss

H§% TR AGEESREVYINT L £9, Wt)7amS 2iERL T E &0,

Solarize Image

M EIREZ Y I 2V - LT,

Distortion Effects
ARV v X, SESERERNREZEHHAL 9. M. L1, B
FOPCHEEZIEEL TLE S0,

Add Film Grain
E{E 20T 2012, 74 VAOFRERZ FITET,

Blur Effects
W52 1E L T, ELOGDRWIREET DI, T YDl %
?\/ i = 8 l/v— I\ 1\/ jivg‘o

Charcoal Drawing
5% HROARRENCAIRL $97, Wty 4 X 28R L, Bi{f2iE
AT 2AL—Y v 7TOEEVEIFEL £,
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X119.8 FMREHD> I 2L — |

‘ tt%‘it " Simulate Infrared Film to Phatograph @ﬁgﬁﬁ:@uﬁff

) ] ] 0% |

| Senmbuwuso;;Q ———— ‘Eu”u”
. (%] Add film grain

P aTar ——

19.9 {EH|75Y —IU

digiKamiZ &, H{E =2 L2 ¥ a > 28RO, WO >3 F & F
ﬁ%%#%eéhfwiT 2 ORSEENE [EMJXf:*WK%%é
ncnEd,

Find Duplicate Images(ZE & |H] {5 D ##%7)
ALy Y a YWICEREL TOLEIENS 5 LD RIGEICE. 2ot Ty .
VRS CEENGE M, HIRToZenTEEd, T METRIC
FTELTNWNANLRE TG ELET. [OK] 7y 7?6 &, MR
mEhEd, avrzari Eﬁiéu@@%ot (e 7 2 /3 D
HEPTRORSNET, ZZ2n06. HIFRT 5 @%LTR’?%) EMMTEE

ER

H LA —DVERK
AT LG e YA X, 742 M2EIRT L7200 T, EED LA 77
Neffo 2 il h Lo ¥ —2FRT 52 e TEET,
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254 Ky g—
Mg L7y a2 A7 Ry a—EATHRRLET, AT KV a—D
HPH, T 250R, BX OB IR T A2 EREEEL £, M
B MREEREL T, A594 Ry a—%@EBEL 7.

RAWIH{5 7t > /S — 4 (H—)

digiKam Tld, & F A2 ¥ —[EHORAWHI{E & JPEGXPNGZ:
EOARM AN ICH G E IR T2 2 e NTEET, ZoFTvarvk
ffioT, DM EEIT 52 M TEET, EN MG % ZET 50
B L EIE. Ny FEREZMH L TL 728 [Tools] > [Batch
Processes] > [RAW Images Converter (Batch)] ), B D X T DRAW
HEEA & digiKam= 2 N—=F T 574 VI3 R— KL T E %
Wil d 512l http://www.cybercom.net/~dcoffin/dcraw/% %
LTS 2SS,

Ny FTat A
DT 7 A I L TREDEREEZ —E L TITwWE 9, Peigoibn, &
DR, R T 4 Vv Z O, WO LRIV A AOKEHE, HIENE £
72 IIRAWH G DAL & DIERIT A 7.

e 21 BRoOEE 2 BENCEZIRREC 1L CEMT 22 WX T,
H{5 2 Ny FUFEE o — 1T L 720 . FERERIC Sy FIUE 2 RITT 51213,
PIToFNEICHE S TL 72 &0,

1 [Tools] > [Batch Processes] > [Image Effects] DIEIZEIRT 57>,
FATT WAL EFH Y Y v 7 LC [BatchProcesses] > [Image Effects ]
DR L 7,

2 [Solarize] TR %ZEL T, [Options] %27V v 7 L, MEEEHT
LEGVEHRELIZY, Jea—%FfoRLET,

3 SLOMEEIC LEXT L0, The b UAE T TRET 202 BIRL £
T oEo. BRRICEGEZAIRT 22 b TEET,

4 B oG 2 RET L7 AN T RFHELET, B olE§E 4 Y
FOVIEAGE D 7 5 )V FIARIE L 72 < I Eld. [New] 28R L THT L
WT A NVFFEINIH T 74 NV E BNl TSN, frilLnwr v ¥ %
EHRL £7,

5 ZRx o —ICRET HHEBY A N2 oL EHEMT L0, EITREIC
JGCTIEIEL TS 280y,
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6 [Start] 20V v 795 e, HEOEEMFHBESNET,

ETRRZ R Ay 2—-Y B RRENET,

TRTCOIEENTE [T %

C. TORERAOSEL Ay E-IUNKRENTET,

X 19.9 /N FHFE: [#1R % iZA 2127 5

‘:: d’ ::- Batch Image Effects

~Image Effect Options File Operations —————————
Effect: lSn\anze ‘v] [ Options l Overwrite mode: n
% Small preview "] Remave original
~Target Folder
Folder ‘ [ New... ]

© [EMy Albums
© [EHerbst2006

~Image File List (4 items)

Source Abum | Source Image Target Image Result Add...
Herbst2006 JJI_4527 PG JJI_4527.JPG
— — -Bemuve
Herbst2006 JJ1 4528.0PG  JJI_4528.JPG -
Herbst2006 JJI_4529.JPG JJI_4529.JPG
Herbst2006 JJI 4531.JPG  JJI_4531.JPG
[ 0%

l

19.10 S TN a—F4 5

SUSE Linux Enterprise, 5 & OMdigiKam!l3 & F S E N AT E2HHR— KL T
¥ 9%, SUSE Linux Enterprise C7 ¥ # )V X T i T 55512, (RO LD

R RETLZ 0BV £,

NAZTS oGO F 7 a— RICKd %
o7k a)PTPE ZIFUSB) &2 i - T b,

H{§ D »7 7 vma— RIS AL

THEEE, digiKamD b VICa~ s R4 U RGHLTLZ S0,
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gphoto2 ——PaAX Y REFTT L &, W ATWHIIHLE N THEHIER Z
v — R&NFE T (gphoto2n’h X T VR~ K LTV LEHE).

B D H X T & digiKamDARISH R — b LTz
gphoto2 —-list-camerasa <Y RZFITL7ZD, http://www
.gphoto.org/%ZZIHL C, Linux2VR—NT25H X7 ICHT L HERE
ffEaE L T2 &0y,

BHWOHATGHZN S OFNHRIFISGCE SN THZRWEEIE. XI5
RERAT 4 7RO LT, = KU = —NET A AR NEBT N A
AL TLEES N, ATy P s hizs, HEIfiC< Y > R &
hET. Eff%digiKam= L7 ¥ a 1S YiR— T 51CiE, [Albums]
> [Import] > [AddImages] ONAIZIEIRT 20 £721% [Albums] >
[Import] > [Import Folders] DIAIZEIRL £9°,

19.11 :FHHI53R

Linux & 2T 7 NV h X 2T 5 7EIC D0 TUE,. (ROWebY A k%5
L TL &0,

* http://docs.kde.org/development/en/extragear—graphics/
digikam/index.html—digiKam/ XA\ K7y 7

* http://docs.kde.org/development/en/extragear—graphics/
digikamimageplugins/index.html—digiKam~” <> 7' 4 > < =27 )V

* http://www.gphoto.org—gPhoto2|l B9 5 1

* http://www.gphoto.org/proj/libgphoto2/support .php—4H—
FLTWDEHRATLD ) AR
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=ET,
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IVENTORWIGEICIE, YaSTEZ o TREL TWAE Ny Fr—I% A VA
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N lr =T FEOF T &N,

20.1 < ¥H—

IEY L SR VUV REAE A Ea— D ATDONART AL R
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T —3 a oML FNZFNKDEL GNOMEIC T 252 BIHL TL 2
Uy,
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Lk I XV B OMELSICE, 2P A ¥ T2 —20MBLEE T
¥9. L WEON— R =7HICEE SN EIZT—-0HV ET, &
& A%, envy24controlldEnvy 2447 > R v TEHHO I XH—TF, 91D
D)X, RME Hammerfall 7 — KELH Ohdspmixer T3, {fHJAERI FH—D
H G, =— RiRIER I ¥ — %2R L £,

F4 v T XY —DEEA

*& XY -7 IV = avid oY K7 T - gk
Y AL WNT£< CEBHOLET, IXFH—2HHLT By Rh—
RoAje i ioay va— VRERFEL £,

20.2 XTI AINVOFAE

LinuxiClX, OGGRWAV T 7 A VI EDEET» ANV HET LD, &
FEFELT TV =y a UBHAEESNTWET, -2 %1%, KDEIZIZamaroK
RJuKZ EVHE SN TWET,

20.2.1 amaroKX5 4 77 L —¥—

amaroK &S 7 L —Y —Tld, S 8EhA—FT 1A 2H4EL, LAY
A MEER L, R—=%2 TNAMP3T L —¥ —F 23NN — KT 4 27708 D
D= NTNWRAT 4 T EEE A ViR— MELITY L=NTIVRAT 4 TN
TrANETyTa—-RKNL, £ 27—y NLEOTIFROARNY —I 7
=T 4 A 7a—-RKxy AMEHAATEET, VY R—-bbShd 7747 A
T AT oY ks THERY £ 7,

amaroKI3 i #)IC. amaroKZ v b7 v T3 5700 [FlaEcE)r + F— K]
ZEEIL £, amaroKW BT 25K a7 Y a v OyiefRiEL £7.
amaroKIZ D7 A NV E P S BARRER AT 4 72 AFX Yy LET, T 74V
N ClE, amaroKIZIER SN TS 7 4+ )V 2 Flaf (T XToY 754 L7
NZZDOAXY L, T4 VL7 MNVONFOEALZRGL, Z2IC&E
NLZITRTOTVAV AR A VR—= N TDHEIICHESNET, TP —
RTCHERR L 72T X T OREIL. &£ T [Settings] > [Configure AmaroK] % 1%
RLUTCHEF A 7T TEETEET,
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Engage Playlist Mode Tools Seftings Help

[Eivis | G s |

[ E & | B search | ]C]

< || Arriving Somewhere But Not Here - | g RIS ‘A'T‘SI Album ‘Type “j
£ || Porcupine Tree Neverland Marilion 2005 - Marbles Live 0gg
S Deadwing Intension Tool 10.000 Days ogg
T @y The Water Spock's Beard The Light SE ogg
Track played 3 Tribute to Segovia Hackett, Steve Live Archive 05 CD1 o0gg
times CrocoTears Bananafishbones  The Essentials 1999-2000 ogg
5 50 ] Steam - Radio Edit Gabriel, Peter Hit (Disc 1) ogg ||
E Last played Inside Stiltskin The Mind's Eye ogg
8 L trh:‘rlztset The Healing Colors of Sound P... Spock's Beard Day for Night mp3
5] First played: April only Us Gabriel, Peter Us ogg
2007 Pineapple Head Crowded House  Farewell To The World: Live..  ogg
Days Go By Lifehouse Lifehouse mp3
2 Labels for Artiving Somewhere But -l
B ot Here e BUENO.. ForC g ELT T —— 09
o addiabelsto Arriving Somewhere But e Spmt OT Rado G R30 - Disc 1 —
® The Llamb Lies Down on Broad... Genesls] The Lamb Lies Down on Br, o0gg
Saeglépur Sigur R6s Takk ogg
Favorite Tracks by Porcupine Tree ‘Yesterday Wilson, Ray Change ogg
My Ashes Call'You Tomorrow Ezio Diesel Vanilla ogg
a3 Sentimental Peaches & Cream John Butler Trio, Sunrise Over Sea ogg
= K You Never Know Goo Goo Dolls, T... Gutterflower 0gg
Strip The Soul Sick And Tired Stiftskin She 0gg
The Sound Of Muzak Blackest Eyes Parcupine Tree In Absentia 0gg
Sleep Together The Ballet Of The Impact Spock's Beard Gluttens for Punishment - C... ogg
% Way Out Of Here Tom Sawyer Rush R30-Disc 1 0gg
T ||| Fear Of ABlank Planet Goldfish and Clowns Fish Kettle of Fish 0gg
& |f|Heartattack In A Layby Caught a Lite Sneeze (Unedite... Amos, Tori Caught a Lite Sneeze mp3
E E::‘lf‘pse The Light Into At The End Of The Day Spock's Beard \Y ogg
| Hate Everything About You Three Days Grace Alternative Mix ogg ||
Albums by Porcupine Tree Gravity Eyelids Porcupine Tree In Absentia ogg
i Fear Of A Blank 6 Tracks Come Talk To Me Gabriel, Peter Secret World Live CD1 ogg
§ . Planet What Do You Need? Goo Goo Dolls, T... Gutterflower ogg
[a] 2007 50:48 The Healing Sounds of Colors ... Spock's Beard Day for Night mp3 g
7 i 52%
b Oesivins =1 0000 e 2=
‘P\aying‘ Arriving Somewhere But Not Here by Porcupine Tree on Deadwing. ”43 fracks (4:22 haurs)‘ 2148 —(} +9:18 ‘

949X —h

amaroKIZHEEHFFIC, S 2 —Y v 7 77y ANDaAL o ary0—GTH5 7+
NWEEAX Y LET, a2y g2kt ICamaroKZ T4 2 & b
afBETI A, i) TR RRE Y. MifFoa Ly Y g v & o R ] EEL D
T, FkdT oz 2BEOLET,

amaroK X A > 77 4 > K 7id, 22 DH ﬁﬁ‘m'@«‘i?‘ S EF SR
Ca—%RRTLA KN=0HVET, FHFEILIrvary, avTFAL
T, TUAVARN, TyANTIoPey, SEFEha—2HE
ENTHET, o9V EEETLICL. Khilchb 2 T2 70y 7 LET,
*M 7LV A )24 v R, BEROZDTIC i7V*V( WA R
YRUTHRREIND LK EL T RN EENTHET,

EREHAETLIE. ©WITNLOY A RA=T I T80 6 T AU AN
7 A7 L% l\“*ﬁ\y 7Ry 7LEd, EEShiftZ2EHL T7 A

FHR L B — D
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FTLEEROERLET, Al LA VA NHNDT AT LT TN v 7T 5
CHASNET, aUTFFARRA=Z2—T, HERICUZ DL T AT L%
ENEZEYBRTEET, TSV AN T oA a2 HHLT. 7
VAVRNDZ U7, TLAUXNEERIZMNTTIRIA X% TTICR T

FREPOEL, FRINEDNT v I OMFEFITTCEET, HEE-NR
ZIET 21C1E,. amaroK AT — % ZAN—O [Repeat] ¥ 7-1% [Random] 7 A
AEMEENTV v 7 LTE— RE2UDEA L0, £RIFHNOE— F%

amaroK X f ' XA =2 —/P6iEIRL £,

YA RA—T 54

a7 F RN

ZoH T BUERAESIN TS b Ty 71T 2R e fathifor s
nNEd, 14 K= FEo2 T2 797 LT, a>r7FIAMTIT 75N
oMo 2 —I1cOV A £3, 2 X8 [Artist] 2 7% 270 v 77
% &, Wikipedia§ DLEN T I N, 20T F AN T T UPITRRS N
9., thodGilzFoRT 51d. [Lyrics] % 72 FoR L T#E21T-C
&, [Music] # TNWNETNAUNLH N~ (BHHIGEE) (IIN—<3—
VX IH (306 N—IN)EBH) CHED ST v 21T L HEREERS
nEd,

= A

ZoXTE WA MVOAI VI Y g VEEIEL, V95\50RT S 720
WAL ET, 79950l FEICH LY — W A—2fiHT L&, aLy
TavORRHEOREB IO AV Y g v OWERETO 2 EWTEE
9. [GroupBy] LT, 79UV NTY A MR FRIRSINDLIEE %
EFeL £, [Primary (774~ 1)] . [Secondary (tH>4V)] . B
KO [Tertiary (4 —>+ V)] AL T, BANERINEEE 21T
HAOTEKRLEZY — MEEOWT NN EZEIRTEET, KRo4>07 A 2
VT, VY —bEa—, 75y hEa—, iPod*¥ =2 —. [Showdividers] %
VIV EAT, KIS Ear sy g vyoffE xR dLET, A
NFDOT7A 22 L T, amaroK232a L 7 > g VICIBNT 4 53 % X
X¥ T2 74T EIBNEITHIRL £7.

MEDRNT vy P ERIETANLOAL Y S g 0 BB EITZ T4 VT T 5
Wi, A MW(ERIEZ0 8% FEiowEE 7 + — )V KICATIL £,
AN U TELFINC & > TRZEAV AT N, 7T IFHOERNENA
N> TREENE T, PronEldey hL—RFrEDEED A Y
F =2 THMZT HIE. FRTEBOMEA T g v EllAGbESIC
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k. M7 4 — IV RoGHloREY %27 v 7 L. [EdiFilter] % A4
TRTEHEET,

LAz R

7V4Uzh77v%%ﬁmbf BRDLT VA VANIT 7 VA TCEE
T, [FLAUXRM L avrzyary 73 VERNICHLEAT LA
JZMMEENET, 71/4")1}“74 /%Wb\%%ﬁb<7v4 A KN%
VR UARIET 72N, FD U AR IVos\sorEhEd, [FLo
D2KN] THANVEE4HG71) v 7 LT, %ﬁbb\7 VAU ARNEERE 7213 A
VIR—=RNTED, FEY TRV ERIENLET., TLAU RN 4
R SFHFEO T LA U A NMIH LW A T L E2EBNT A1 Fhbo
TATLEToIIE T4 V RITHNOTLUA DV ARNIRNTy 77 RRay
T LT T,

EEEH: MO L—FV—DT LA VRMNDEF

TUAYZME m3uERATREFET S L. ZOEAEHHT Lo~
e s s A i DA GR= = S

[Smart Playlists (A~ —F 7L X R)] 1E, HAEINZZ D70 E

S BHDORNT 7, FREFT Y NI DR Ty IR EDSESE
mAL v aroa—RELET, LeAE avrvarrs sy
TILTVAYAKNEBVERT 51212, [50 random Tracks] %8R T, T
VMUV ETVAVANTY IR T v 7 LET,  [Smart Playlists] 7 +
NEZHIZ Yy 7 LT, BT 74 NVEERENT 50, B2~ —
K7L AU ANEERL £,

[Radio Streams (Z > A4 X h I —24)] Tld, A 7 — v NEHTIA 7
DIIAARNY = LB N TEET, MY 2 b AHtamaroK D H &
ICTTICEENTE T, SHITEMT 5. 23T 7 4V F 2T
LIIFHEZ Vw2 LET,

[Podcastsb (A5 FF+ X ~)] Tid, amaroKICHRy Ry v A N%& A »iR—
FLET, GZ7V w7 T528TA =S, ZORAZ2 =0y
RE¥xy ZRBLOV T T4 NVFDIEN, 2Ry KXy A DY 7Ly,
FRLFAX Y VHRORENTEET,

AN
ZDHTTlE, BEEKDET vy AN 2= ¥ XA 70T 57 7 A
WIS NHEET, FEo7Aar2HL T vy A IV AT L%EF
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=ML, Ca—%2ZTHLEZY Ty 7<= %ERL7z0 L ET, 7%
ZKNASTT7 4 =)V RIZ, URLEIEIAAZEIZALFT, Fordhika
VFUIMBEZETUVAVARNIRTy LT, FL AU ARNMIEMNL
EJc

Magnatune
ZDHTTlE, g5EEA T4 2 THEATE S Magnatune 2 b 7 N\ D%
ZhECEET, [Update] %7V v 7 L C. magnatune.com CH A T &
LTIWNLET AL MNVEFRLET, PTVRLYARNE Dy 2 LTY—h
LT, amaroKT K 7 v 7 2S£ 9, SHEELMAT L121E. [Purchase
Album] %7V v 7 L TALWGEZ ASJL 77,

Devices
R—=H TIWMP3T U —F —E /I RT 4 27 2L Cnb
G DT IV EMHL TCR—=% TILF A 2% FHTEL. amaroK)» 5
TIRALET,

AN—Tp—T%

amaroKZ i35 &, AL 7y a OB TINALIHN—-ZHY B TEHZ &
MCEET, [IN—v3—T %] 2L T, PINLHN— %A
. HURR, B CE £,

[V—=] > [IN—=vF—=2v] ZEIRL THN— 32—V ZHCHIL £
T, U4 v RokEfllovy) —ta—I12idk, a7y aryNoTRTHOY —
T4 A RINSB\NSoRENE T, 74 v RohREMIIE. TRXTDO TN
DI N=DINB\NSoRSNE T, RRSNIZ AN T 4 NV F ZT BT
VY —ba—Nofil e DV =54 A2 2T50 742 RdklE
Wch b AT17 4 =V RICHEEZ AL T, [View(E'=—)] ZfHL T,
DTN, INRN=DBHDLTIVNL, £21F. WA= L 7R LDFRR%E
IS8 3c 8

TV H N =% B0 B THIITE, 320085 F5ERHY £,

AN—DHENEY 4T
amaroKlX, XA 274 > KI\V95\50REND HN—D D BRIF TS
L OBRH T, Amazon/» S HENMICISE L £9°,  [Amazon Locale (Amazon
o —)0)] ZHHL T, £ DAmazon Webt — N—n5 W N—=%NET 5
IWEREL. ZTDIR,  [Fetch Missing Covers (K1 T 5 lp/N—DH{E) ]
IOV LET,
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EFHA: Ba8 IS INLE

amaroKClE., 7—F 17 XA h=FIANLE WD 7 ) TN EHR L T,
Amazon/PH A N—=ZINEGFL 7, ZoERIE. STy ANV y 7
SEBIESNE T, 7O HRRGE . h—% HERET 580
by NEB B £T,

Amazon”’* 5 fF S 2 41 N — DO FHEIR

COEGEMHT L0, BEOros ) T EHAL THh - 25
THN LML ary ha— L LanEEE ALY T4 RYNTY
WKt Uy 7 L, [Fetch from amazon (Amazon) > 5 H{#5) ] % %
IRLUE9. [Next Cover (KD A 3—)] Tik, FJH0EER T X T o4 %
MOIRLFRTEET, [REFE] 2HT2 &, EEONN—DERS
N, ERFLOT NN ZNRE Y B ToENE T, oRShieh -1
W ETERWIGEGE. [New Search (FrHifes)] #{HH L THMEEZKLDIA
HRET, AL T4 Y RIDY =)W= [Amazon Locale (Amazon) 11
=] ZHEAL T, £DAmazon Webt — /N =26 N —ZIET 50
BRELET.

AN—=DFENE Y 4T
HAYD R N—H{E%2 T TIIBEbLOGEIE. 7V LEHT7 ) v 7 L,
[Set Custom Cover] #EHR$T5H 2 & T, TOMGEEI Y Y TLZ &N T
xET,

REAL

amaroKO W EA L 4 > A N =)WV L7256, [Tools] > [Visualizations] TH
ETLERICSESERT T T4 v IR EERTEET, TL—F—7 4
> Roicid, amaroK HIRICEZ EN TS J{EARSEEN O RS NE T, 7= —
varvEI VI The, JRE-REUVERALZ NN TEET,

amaroK b LA 7442

OKDEY 7V r —3 g > &likf. amaroKIZFKDED S ZF L K L AICT A 2
VEEMLET. Co7AaYEHHL T, amaroKD %< OfEER 2> ha—
NWNTEET, 7A4av bicvo AR, Va2 REL &, BEFESRTHWS b
Ty ZICODNTDONERPFTRINET, YTARA —NVEAIO—)VTDH &,
HAESEEEFNCHEBETE ST, B2V v s &1 &, HEIGEVER SR

R L= E— DR
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L2l 7IVr—arya YRUBNELCET, O %2 Vw95
EL U4 YR HEMEET, v R0hRY U E I v 2T 5 e AN
—FHFIE L 9, BT AI1I21E. ARV EBOZ Yy 2 LET, 7y
r7dHE. T—v—arbha—LAD7 7t 2B L PamaroKDOK [ #1795
A FFXFARNAZ a—DHEET,

BLU<ShiftF —%2~ o2 e HIHTL L, LV EERFSREICT 7 A
TEXFET, CriIvT AR, — VB A B — )L S L. Shiftkdh—IL RT52
LiICkoT BEDON Ty I NEMZLET, YT AR, —VE AT —)b
SELE., <CtrbF—%2 K= IV RKTEHZLICk->T. VA UAMNAICHS b
T T AXy T LET,

N ATAACHETATLEZ RSy 77 RRay 7L, BliFo T L
AVAMIBEMTEZbTEET, bTv 22T VUAYZRNITINT S0,
ML CHAET L0, $REBEDO NIy 705 LI AT A EmRb Ry
TV T A= a—EET,

20.3 A—F 4« ZACDDEXY K

EENT v 2 EHAETLICE, ZLoFERHY £, CDEHAET LN, Z
DTFIHINVAN=V arelmELET, Z2ClE CDTL—Y =77V r—
VarvEWOPIY F =T 4 ACDET I NMET L0 T S
IV — g IO THMIHL 9.

JH OCDDOVER T L. $218 CD EDVD D #H X AL (315X — V) BIHL T
&,

EEIHH: CDDAE 7O CDDEAE

I —F 4 ACDEFETLICIE. 220 ERHY T, 7Far/CDEHE
TELCDDVD R T A TE, A—T 4 AT —FeinhfiL T K15
INA ZIZiED £9, PCMCIA, FireWire, £ 7213USBZffi [ L THEm S 1Ty
LW K5 A 715, CDDA (Compact Disk Digital Audio) % {§iffi L T4 —

FAFTF—=F 2B L THhEFIZINUPCME L THAT HXENH D 7,
Z 2T FiFAvL —Y —IICDDAZ U R— KL T\ EH¥ A, CDDADY

R— N e EH L TLHEE. XMMSZMHHL TL 7280,
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20.3.1 KsCD—F—F 4 #CDT L —F¥ —

KsCDIFff W WA —F 4 ACDY I —¥ — 7. kdemultimedia3-extra
Nolr = @LTOhET, £ VAR =L ENTWLIEE. At+RF—%
L CkscdZ ASJLCT7 IV r—v g v &2fEL £9, KsCDZKDE/ /S %)V
cqmﬂ/t(mﬁmwmxéhéaaﬁm CHAETLEOICHKETEET,
REA=a—ICT7 VAT HIE, [Z2 X ~Z] > [Configure KsCD (KsCD
@gﬁajaﬂﬁuLﬂabi?‘lﬁCDﬁ A > —% v N TCDDBY — N\ 67
NI E NTy ZEREZIGET S LI ETCEET, CODBEREZ 7 v 7
O— RLfhoa—PeHFGIsr2e b exEd, BRoWEE 7y T —
Nicix., [CDDB] # A 7waZ#{iHL 7,

X120.2 KsCDDOZ—Y A>T x—R

i04: Time Bomb (02:24) -
@ )

] Pause oG- F Play 49:47
- Il vol: 4% 04119

o Stop 2 FEject
Rancid - ...And Out Come The Wolves

M Previous M Next Kt

Random Loop = CDDB ] Extras ~

2032 A—F 4 AF—SDEE:YvEVY

F—F 4 AR, SESERY —NMICE S TEITTEET, Z2TlE =
7/%74/%@%LT% F 4T — &%I/ﬂ*hbfﬁi?éﬁ%
ODWCHIHL £9., D7 I 74 ANy TV — g A3 A —5 4 AL
TEFSREL &V £ 77,

A—FaAFT—sDT - RNEBEDEHOOAT Y
NS4 2=

Ogg Vorbis (vorbis-tools/Ny 7 —NNIMIEO A — 7 ¢ A AT, Bl
ETIEERHENYOA =T 4 ATV =V —BLOR—-FZ T IVMP3T L AV —TH
PHR—hEINTHET, o7yl hDOWebX—Vlidhttp://www
.vorbis.com/ T,

=B SV A T E
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BV AT LITIE, OggVorbisz V7R — KT 25Y =L O g L <
WE T, oggencld, WAVY 7» f L% Oggll Ty aA— KT 572017 52
XY RIA Y =VTY, FEESNTZ . wav T 7 A L% Ogg VorbisiC R 5
IZlE. oggenc myfile.waviEFITLET, -hA 7> 3T, Zofios
A =2 OMENFORENET, OggenclIn] Ly hL—hToOTrya— K%
PAR—-BMLET, ZOHET, JVEELEMOEETEET, By b —
FofKb VIS, BERGEE-g/NTA—F TIHET L2 b TEET, b
FA=2lE ey hUb—bhE2RELET, ne-MEHHTL L, e
IkKOEy NL— hEfEETEET,

oggl23id, =\83\'7d> KT A »0gg7 L —V—"T7, oggl23 mysong.ogg
mEpa<y e L CGEEIL £7,

KAudioCreator|lC & 54 —F 4 A 57— 49 DEE

KAudioCreatorld, #¥8DCDY v NX—7 7 VU /r—3 3 T (X 20.3.

[KAudioCreatoriC & 574 —F 4 ACDD Y v B 7] (311 X—=I) B T
{ 72&Wy), KAudioCreatorx fCfifi 95 &, CDOTXTD T v Z7H¥ [CD kb
Fw 2] ZFoRENET, Yy T L Cmrya— K75 8Ty 7 2EIRL
9. NI v INREWETDICE. [Zra0] > [TANLEZHHE] O

[FIANLITZT ¢ ] ZEHLET, % [Zra0] > [V
ZiEN] OEIGEIL Yy ez ya—-RERKBLET, coYar
ONFLIRNNE, [P 7] # 7%2MHL Th#ERAL $9. KAudioCreator! 35
NEWICCTHAEV AN T y ANV EAKRT S5 2 TE T, amaroK,
XMMS. F 7-lFHelix BansheeZz D7 L —v —ld, chZzffifL THAETE
E
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X1 20.3 KAudioCreator!C L2574 —5 4 FCDD Y w &2 27

File Settings Help
4 Q0

CD Tracks

Number of jobs in the queue: 13

|Jcb ‘Prcgress |Description =
01 100% W Ripping: Buffalo Tom - Rachael
02 43% %3 Ripping: Buffalo Tom - Postcard
03 0% @ Ripping: Buffalo Tom - Knot in it
04 0% @ Ripping: Buffalo Tom - The Bible
05 0% @ Ripping: Buffalo Tom - Scottish Windows
06 0% @ Ripping: Buffalo Tom - White Paint Morning
07 0% @ Ripping: Buffalo Tom - Wiser
08 0% @ Ripping: Buffalo Tom - See to Me oy
09 0% @Ripp\ng: Buffalo Tom - Register Side
10 0% @Ripp\ng' Buffalo Tom - Do You In E
11 0% 73 Rinnina: Ruffaln Tom - |ndar Milkwand

Remove Completed Jobs l [ Remove All Jobs l [ Remove Selected Jobs l

Ripping (1 active, 10 queued)

Konquerorll & %74 —F « ACDDJEHE

KonquerorZ ffifH L THRED Y v B> 7Tt 2% AH1C. KDE=2 Y K
0 =)L % —"T74—F 1 4 CD&Ogg Vorbis T > =1 — & O 57k % 30E L
¥9, [ R&~IF X7 7] > [F—714CD] DIAIEERL £7,
WEEY 2a—WE, [—] . [FA1] . B LT [Ogg Vorbis Encoder] ®3
DF AP NTHE T, W, WYRCDT A 2 HEISKRE S h
T HEME KL . CDTNA A2 Tl CRIET D VEDIRRY . 2o
TI ANV NKEEEBLIRNTL LS, T —BIEB LU0y a—4—{F
MY Z ZTRETEET.,  [Ogg Vorbis Encoder (Ogg Vorbis T > =1 — )]
BITClE, Zra—RNoWHERELET, VoI LicdA—T 445 —
FOTIWNAL " Ty o BEROT =T 4 AMONRET T A 2 THRET
5 EDICHET DT [MZ v rEROIEN] ZEIRL 7.,

Jy ErZ7at A%, CDZCD-ROMT A ZIZHiA L, [IT] /R—IC

laudiocd:/)] & AJJL TR L £ 9. Konquerorid, CD& 7 #)VFD KT w7
#FoRL F9(X204. TKonquerorll K54 —FT 4 AT —2D vy 7]
(312 X—) & BIH),
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[X120.4 Konquerorl2 L5674 —7 AT —4D vy T

Location Edit View Go Bookmarks Tools Seffings Window Help

1 00.0/0 aaEER
B Location [ #audiocd:/ H =l
@ #Home Folder )
& <ADesktop A A A A A
[“JDocuments CDA FLAC Full CD Information Ogg Vorbis
@ &mus‘c @
g (sdpublic_html ) 7 ) ) 7
£ Emp Fall - 01-R. Fall - 02 - Fall - 03 - Fall - 04 - Mr. Fall - 05 -
E 0D wav Dktr. Faust. Shoulder P Pharmacist... Gross Cha
ad
@ @
,M P 7 P 7 7
Fall - 06 - Fall- 07 -U Fall - 08 - Fall - 09 - Fall - 10 -
[ Living Too S.80's-90" Terry Waite Bournemou Riddler! wav
7 7
¢ Fall - 11 - Fall - 12 -
Shoulder P...  Auto-Tech ...
L1}
© 18 ltems - 12 Files (532.9 MB Total) - 6 Folders

RS NI-A =T 4 AT =2 % T 4 AZITHRIFTHIC1E. cwav T 7 A )V & 1%
RLU THlJoKonqueror™ + > RIC KT v 7 L, R {FHTIICaE—L ¥
9, OggVorbis® L. 22— R 7a¥ 2% kT 4121E. 0gg Vorbis” # )V F
FRFZOTHNVEDT 7 A )& DKonquerory 4 ~ K KT v 7L &
9, OggVorbis7 + V¥ % HNOIGATIC Ky 7958, 9 icmnya— R
BmEYET,

204 L—E—D 7M1 IDBAE

SUSE Linux EnterpriselC[i/fl SN T L EEDO L - — T L =Y =S If &
TV =¥ —%ERTE £ T, KaffeinelX, 77 #/)V N OKDEL—E—7 7 A )b
T. Xined L UMPlayer’s &, W OO Ny 7 T2 RTRTTEET,
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[X] 20.5 Kaffeine X 1> 7 ¢ > K
File view Player Playlist Settings Help

[ & [ [Playist - &0 1
| Player | Playlist |Gol

.
[Kaffeine Player]
0.71
= P =
9 @ -
. o 4
Play Playlist Open URL Open DVD  Open Audio-CD
A A G
o
Open Files Open Directory ~ Open VCD DVB

(3] O
g,

Entries: 0, Playtime: 0:00:00 KaffeinePart

Kaffeine CHARBERTZANIE, Ny 72V RICLk > TELZDVET (T 740 K
TiIXineMEH SN ET), Xineld, &Y KR~ IVF X7 1 7TERDZELL
L £9°, FMICOWTE, http://xinehq.de/ZBIAL T E &0,

KaffeinelZ. £ > % —% v K FICA MY =L ENEINF AT 4 7T HHET
=, ¥/, Konquerord®d 7S5 7' A 2 LTHHTEET, WHEA 7Y a1
3, IFNVAZ Y == RTCDT 7 A NVDFE, 77 A WN8\5cit N TDFY
WaEnbVET, E5ADAFy Ty ay MEIRD, BHEE L TRET S
ZrHTEET,

SUSE Linux EnterpriselC |3, Kaffeine® (37>, RealPlayer for Linux & [fJ#l & 41T
VWE 9, RealPlayerid, RealAudio. RealVideo. Ogg Vorbis. Theora7s & % -
R—=HFLZET,
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CD&LDVDDEEAH 21

K3blt. ¥—¥CD& 4 —F 4 ACD. DVDOEZALEITIREN 2T ar 5
LTT, AL A=a—06 [RILF AT+ 7] . [CD/DVDDOERK] DIE
ICEIRT 570, k3ba<w > REANLTC, codarZsazwiiil ¥4, 2
Z TCld. Linux CH]D CCDE/ZIIDVDEAERT 52—V Dizdic, FHAnE
TIART O 2 EBGET 2 EIC O TRFRICEIFL £ 7,

21.1 > —45CDZ 7=lZDVDDYERK

F—2CDEAERT DL, [Zran] > [FlLinvwoar=s K ] > [FL
Wr—2Ccb7ay=2 b OIEIGERL £9., 57— ZDVDEERT 51213,
[Zra] > [FlLnwoalzs N > [FHLiTF—4DVD 72 =2 ]
DIFEIEIRL £9, 1IRT LIS, V4 Yy RFoo Micd7uay =7 bea—
MIORSINET, M21.1. THLwTF—=27ay =7 hoffik) (316 X—)
HAOKR—LT 4 L7 NUNICHL, GHOT 4+ L7 bURRElo7 » AL
PRI 7L, ZOa—~KayJLET, [ZrAn] > [GEIZMF
TIRIE] 28R CEE0 &Rz fNd. co7ay=r7 NREFELET.
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211 #HlLF—r 70l NolEK

File Project Tools Sefings Help
EEd 960 B

(- JHLDT-ST-DV.. |« | |

A+ & HQ ¢ Fiter|all Files -
|5 screens

i firefox-bookmarkmanager png
| [ firefox-extensions.png

|| firefex-main png
& firefoxthemes.png

Welcome to K3b - The CD and DVD Kreator

[ | 4
() e
New Audio CD Project New Data CD Project
-
New Data DVD Project Copy CD.

Change the welcome screen butions with a right mouse click
Every other project type and the tools like Image writing or Formatting are accessible via the K3b menu

S, E %
=  |ETemp 237 GB/295 GB K3b 01214

FThme, Y= IV N—D [Burn] %7 V) v 7350, Cul+BZHL £,
CD/DVDICEEZ AL /-0 ESEA T a v Ho6e>D 2 TNH56 547
arMFRINET, FHHICOWTE, J212 [EXARLTat Z20h A%

<A R (Bl6 XN—IEBIHL T ZEWn,
212 EZXAuaTavzoh Ay~ +4 X

Data Project size 2.0 k8

Writing ljmage |Sgﬂmgs Volume Desc |Ellesy5tem |Advaﬁﬂz

’—Buming Device

=3 v
[HL-DT-ST DVDRAM GSAH12N |~| speed: [Auto |~] l

Writing Mede Options
Auto iz [ simi

%/ On the fly

[_| Only create image
B¢] Remove image
] Werify written data

Copies
(@
[ User Defaults « ” Save User Defaults
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[FFEAAR] 7 T21E, EZART AL 2, WL, BLOFIART T 3
VOFREWHYET, ROF T arBdHy £7,

Burning Device
ZORy T7 vy TAZa—IllE Ml ENESIART N, AR SN
¥9., SCTHESARRLOEIRTE XY,

i

5 EEUNHBRREIERT 5BRDOEE

HAEE [Auto] ZEIRL T2 80, Uk D, ol BEA R KIS A
REhEd, L2rL, Zofiz KL HEL T Y AT LNZISHS
WRETCT — 2 R TERWEEICE. Ny 7y 7 ¥ —F onffE
MWRKEL R £,

HXANLE— N
ZOF TV g lE. L—HF—DCDDVDNDOEX AL EERIEFEL £,
CDOHE. DAO. TAO. BLUORAWDINM D HiE = TE £,
[DAO] (diskatonce, T4 A2 7 v hT Y A)E— RTlE, 74 AZICH
XAATWB, V-V =W LA, A—F 1 ACDEAFKRT S
Ba., Zo0F—ReBEOL 9, [TAO] (trackatone, hF v 7 7 v bk
7 2)E— KT loES AR T O ZAWME ¢ D~ T v 7 Z LIl
HanEd, [RAW] (B—)E— NIMFHBEE®SFVELHY FEHA
M. TAIMT = ZHIEEZ MV ITDROODFTT,

DVD®D ixmo B BROEFESZoMHo L ERHATE E
Tomm@f DAOE— RTlIE<wLF Ly g FhR—h&h T
iﬁhoVW%ﬂvyaymm%ﬁﬁ?é%é@‘ﬁm%%ﬁéﬁﬁb
TSy, FHEHEE—-RNTIL growisofsZ > T EEZa[EEXT 4 7D
AOX Yy a6, 1S096607 7 A IV AT LEHNEE 5 2 88T
=ET,

HEX, [Auto] ZIERT L2 2 BEOL T, ZoHG. Kbt
REEERELET,

Simulate (>3 = L'— })
ZOWEERZ B L T PO 25 408 BRSNS ALME %
R=FL TN EINF oy VTHILINTEET, VAT LET AL
TEHEDIC, VP —ZBMIL THSIIARET,
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On the Fly
A A=Y T 7 ANVERINAFKRT 52 &, HHOT 7 2 HEZIARLE
TONT A=< AR Ea— 2Tl ZOMREZHHL 7201t
ZEV), A A=V T 7 AIIFISOA A=Y L LI ET AL CDONESL
RERIFL T D T 7 ANTHY, BFIEZDOT 7 AINVEEKRL 721k, %
DNEEZDF FCDICH I AR E T,

AA=TDRENEFRL ET,
COF T aFE AAXA=Y T ANVEEKLET, [Image] % 7D
[Temporary File] 12, Z D7 7 A INVDONAEFKELET, KT, DA
A=V T 7 AN ECDICES AL M TEET, ZOFERTH I
[V—] > [CDAA—2 %X AL] OIRICERLET, 2ot 7y g
VEMHATLHG, 2ovrrarNIChLMoT R ToF T g i3k
Moy £9,

Remove Image
HIADAE T L L S0, A A=Y T 7 AN T4 AT 5
HIRRL 77,

Verify Written Data
TLOT —F e HEAENIZT — 2 OMD5F = v 7 H L& T 5 2 21
FoT, EEAEN T e il £7.

[Image] % 7%, [Only create image] 773 a V' INERS N T L EIC
OHAFTEET, ZoE, SOXHESAL 7 7y A IVEREL £,

[Settmgs] B NNI2DDA T aH Y 9, [DatatrackMode] 3. CD
GORFHTEEY, 20X T arTlE T2 Ty 7 DEEIAL
ﬁﬁ%&i?éikﬁf%iﬁoﬁﬁﬁ\[mm]%LﬁTﬂi S LAYSRIN
12720 £9.  [MultisessionMode ] 1%, EZ AR T zbon, 77
AFTAREINTORNRAT 4 TICT =X ZIBINT 572012 E T,

[V 2—LDID] # T T, ZOTF—27aT =0 NEHNT 572D
TEL N, RITELMFRE. codad =y NIl En:7
TN —varve ANV =54 VIV AT LEASILET,  [Filesystem] %
T Tl 7 7 A V¥ A5 I(RockRidge, Joliet, UDF)D X EXITWET,
oo YYRU I ULI TrANDNR—I v ar, BEOZHEKD H
FORELET, [F] 7 7Tl o d b a—NBnoREHEH %
BETLZEMTEET,
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PEIEL CTIRTCORERRKLL =6, [FXAL] 2L CEREo=
IABT OV ZAEEEL T, £33 IS OFRTE LR M TN
izx<. [#f7] #HALSHREL £7.

21.2 A —5F 4 ACDDYERK

HARHNC, A —F 1 ACDDEKR & F— Z CDDVERIC K Z 72NN EH 0 £
ho [Zr7AN] > [FTLiF—Fr4CD71>=2 M DIAIERL £
I, o —F 4 A Ny 2 Tal s T ANVFICRTy Z 7 RR
Oy JLET, A—T 44T — Ik WAV E 72130gg VorbisD &5 & 1D
ANTHRTNERD A, 7P =7 TV FHNTET v 7% | FICHE)
THZLICED, NIy I olEFEEREL T,

CD Textx i 21X, CDDOZ A MV, 7—FT 4 A4, NTIv I8 EDT X
A MERZCDICIEINTE £ T, ZoWEERZ Y R— KL CW15CD7 L —YII,
CZONERE AN > CHERRT L EMTCEET, A—F 44 K5 v Z12CD
TextlE W Z1BNT 2I1C1E, FLDICh Ty Z72ERLET, H27 Vv 2L T
[Zansr] 2R3, LY 4 Roforsh, 15HE AT
HZEMTEET,

A =T 4 ACDEHSALIO DA 7T, T—ICDEESALLODS

Ar7areRKEHYEFHA, LML, [DAO] & [TAO] ®E— RIETKEk
B2V LET, [TAO] E— RTlE. & T v 7 ORI22F o kiR
IEAL £,

T4 v T T—8 DM DM

A—=T 4 AMDeHEZAL & 1L, Kl oFH I ARRL 2 IR L /278 E S
ABT T =PFAET Lu] RIS 22 ) &7,

PEFIEC TINRToOFRELTE LS, [FEiAL] 2L THREOH
SAART O R LML £9., £720E. N6 ORE L FRO MG TEIC
AT, [RIA] 2 LIRIEL £9,
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21.3 CDZ/zlIDVDDO O E—

AF 4 FIIEC T, [Y—a] > [cDZ=aE—] » [V—] > [DVD% =
E—] 2IRLET, fR&hizFd A 7a s ¢, X213 ICDOaE—|
(320 X—N)NIRT L DI, @AY TNA AL FBEIARTNA AT 5%
EETOET, CNETICHALAAZSARS T g 1E, S 2 TUHHT
XF9, BMoHEIC LY. CDXDVDO a2 — K ZIEET A2 b TXF
7,

X213 CDD=akE—

| P

~CD Reader Device
HL-DT-ST DVDRAM GSA-H12N -

0 Close

~Burming Device
HL-DT-ST DVDRAM GSA-H12N ~| Speed. Auto |v o

Options | Image | Advanced
Copy Mede ~Opticns
Normal Copy |+ Simulate
Writing Mode
Auto = Only create image

| Remove image

Copies
0, 1 =

{ pe,

K3b Defaults User Defaults ~ Save User Defaults

DT INA A B ERPIATRILINE . TE AT 4 TICESALE &L [On
thefly] %541 L £9. [Image] % 7 @ [Write image file to] \Z15E S 7=\
ZNCHBEFR L. A A=V OESIARIKTITOHEE. [Only create
image] % #ERL £7,

21.4 1SOA A —T DEFIAH

JTICISOA A=Y MMFICH 255G, [Y—] > [CDA A —22F XA
] OMEIEIRL £9., [FXF AL A X—2] OiE ATJT 572007 ¢
VRUMNFRRENFE T, K3k o TF = v ZHLNEE SN, [MD5Sum]
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TICZFDEMNFTRENET, ZDISOT 7 AL X —Fw IS X
O— RNLZZbDTHALIES., 2OF oy ZHLEFyra— RB&RINL 720
EoERLET,

[#f/a/]a[ﬁﬁ]wééﬁ%ﬁﬁbf\Eﬁ@ﬂamé %
LET, COICESTAGICIE. [FE] #2 Vv 7 LET,

ISOA X — Y %#DVDIZEH AL L, [Tools] > [Burn DVD ISO image] &
ﬁuhﬁbf\i%ﬂﬁ4% VEERL T, HFEALE-NEESIAR
RO TEE L €. otz d 7y a &2 RL 7, FSIAAZDVDOT —
ZREWEF = 7T bGIE. [ Verify written data] % 1#E{RL £7,

Bas

mm

21.5 2 JVFt v 3 »CDE/=lEDVD
DYERK

vw%ﬂv/a/wfxxﬁfi T EEENC b s THSAL D &
ﬁf%i? COKEEIZ. AT 4 7LD NS TNy 7y TeEZIAGE
BRI bET, By arIelil, Nl TP v T Ty AINEIENLT
w<;a#f%i? BlOER e LT, 2 OFSEEILT — # CDX°DVD721T I
IRENTWEDITTEHHY EFRA, VTR ayT 4 AVICA—FT 44
YyrvarkiBNdTb2ebTEET,

<IN Fy v aroT 4 A7 EEKRTLICE. DIToFEICENE T,

1 7. =254 27 #FKRL T, IXRTCOT7 7 AV EIBEML £,
=T 4 ACDEy Y a UDPOHEBETLILIETEEYA, T4 AT
Do NI TN S 2 EERL TL 28w, frilunky v a %
BINTA5ZeMTEERA,

2 FAEREXALICE. [FaYe2 N > [Bun] OIEICERL ¥
ER

3 KRS hbF A7l iRy 7 ANT, [Settings] % 7\HENL.,  [Start
Multisession] %iEIRL £3, DVDDOEHIE. DAOEZIARE— K& {f
HLZWTLZEn, ZOoE—RE wVFryrarzhR—-—KLT
WEH AL
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4 PEWIEC o T g v EREL £9, HEUEH 21U [5—%
CD¥ 721 FDVDDERKR) (315 ~N—2).

5 [Burn] #7V v 7 LT, ARy gy ERELET,

DET, AT 4 TICEEAXR=ABHLRY, LEICICC TRy v a v &b
MT22UMTEET. FAZDT 7 A F T4 X, WLy v ave
ﬁﬁﬂ'ﬁ‘é/ﬂ\%?ﬁi‘iﬁb\iﬁ%é\ if:ci}l\"-—Xf‘)xﬁfo‘(Q\ﬁb\i%é\&:@&??o.(
TZ2&W,

FEIIINFEyIIa VDT A RAIDEE

TNFRyTa DT AT, By varodXToxzy N EEH
TELEODAN=AVBPETCHL I LITTFEL TSN, Zod, T4
27 OB FRITNELLRY, vy v a VRUSICCTEDLY £,

21.6 FFHANEER

K3biZlE, TN E TICEHHHL 722D DFEREDIIMIC, WAVT +—< v b D7 —
T4 AT —Z DAY . CONDIEESIAR, MiaIhict—T 147
L=V ToFEomtny., MoliEbHV 4, corya s L THHT]
BEZR T RTOFEED ML, http://k3b.org/ CAFTEET,
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VEBNEREREKET %

BEFD HE 172 SUSE Linux Enterprise® D f]H Z #-7K— ~ L, Linux> 25 A
T AT 2 IR T 57201, NovellSUSEE A — T >V — A 2 =5 4
3, SESELRERELEMEL TE I, HlRS, SEIEREATHE
ShTnEY, LeAE AGICHEO R¥a XA 2B LED, A
¥—2v b toSEIEnEReMHTLI N TEET,

Al fTEBORFXa A B

BB OT T4V R¥ a2 A2 NI SEIELRBGMIBMSh T E
9, KDET A7 kv 7ICIdHelp Center’H V), T 6 8 8EhA T4
VRFXFaRXPNITIRATLZ N TEE T, HelpCenter Tld, SUSE Linux
Enterprise® [ OMEHIZNT T, A—T oV —2a3Ia=7 1 MET 2
TV = a OISRV ANT S 2 e TE £,

YaST# o TH LV 7 b =7 %A VA M=)V LI2GG, WEIZZDOY T
F7=7DRFa XA MYHEINICA > A =)L &N, KDEFAZ kv 7D
Help CenterlCFRr SN ET, 7272L. GIMPRED—ED7 T Ir—3 g~
&, YaSTE IFICA Y AR —= NV SNDIMBDOF VT A v IV TNy fr =
ZFHL THY, Help CenterlIIFTIR SN WIZENH Y 7,

A.1.1 KDE Help Center®{E A%

KDET A7 kv 76, KDEhelpcenterlC S £ SERHETTY 7 ATEE
T, 7TV =2 a NS OERBIVELREEE. TV = a o

A
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[~NNT] RE )y 7350, F721FF1F— %L T, Help Center ©
DY TV =varDRFaX L belEET, A A=a—=06, /-
lZa <> KT 4 »h 6 susehelp CHelp CenterZ L[ 9% & Help Centerd X
A4 Y RUBRKREN, 22 TANNVT Ny I 2 TITTRXTEET,

X1 A.1 KDE Help Center® X 1 > 7 1 > N7

File Edit View Go Settings Help
00O = AAL &2addbP®
Contents | Glossary | Seart|*

| Release Noles
"1 Application Manuals KDE Hel p Ce nter
"1 Administration
"I Development
"} Online Resources « Release Notes
A short description of the most important changes for
this SUSE Linux release
* Application Manuals
o Reference documentation
o KDE Introduction
o KDE Application Manuals
Manuals of applications of the start menu.
+ Administration
System administration documentation
o Linux Documentation

o Hardware
o System
+ Development
Documentation for Developers
o Languages
o Libraries
o Tools

D]

A= — &Y —)LN—ZlE, Help Centerd NWEZHIIL 720, FRL Tnvb
N—=UNEMFELIZV, Help CenterN 2 L 70 h AZ <A XTH7-0DD
FTvarvPHEINTOET, vr Y R0 LKR17 1+ —IV RIS
i A oA r~=a7)b, MEFAIHR, F21TWeb =7 & ERL 22
VT UV ONENFIRSNET,

Y4 Y RYoklloFEr— 9 v U TICE, B0 S IhH 0 £

HX
R TE MR — AWV Y =2 —TFRK/RENET, Help Centerld,
-, BHE, HRERE, SESERIN—TEHRICLTHET,
Ty r7A4arwr Uy 2 3be, f@illohs TV BRFGT, Bida]EEIC
RO ET, e AE AL TEH TlE axr RoAr7arIhic
BT 2 3 &E R~ =2 7 man) MR (info) X — Y2 BT HZ & b
TEET. £/2. HelpCenterHlE, FEDN—R T =27V T =7
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WS A8 OMERZINY Pty o4 v TF— I RX—ACT7 7 AT 5
CELTEFET, MEA T v I A —EAKRT A, cheony —2T
NCEEHICMETTCEET,

HelpCenter CHJHH TE WAL, BFEA VA=V ENTWEY TR =
TNy =V, RESNTWELY AT LSEBICL > THRY 7,

GRS
MEB ORISR S h T E T,

Search Options
Help Center% &M T 57200 DF T a VISHEINTWEY, S F &
FOMFFEELIFEL T MEREIT) 2P TEET,

FIE A.1  Help Center D18 7511

KDE help center LM 24T D 121E, MSRA 7 v 7 A% ARL T, M3
INTA—=B LETLREND O £, MRA T v 7 A E2EKRL T
GG, [Search] # T ThHe, ATy ARAERTH T
7 NHEHNICR RSN E T,

1 HEBEMEET HICVE. [SearchOptions] % 7 V) v 7 L THME ST &2 A
HLET.

2 FHT &> THRIO TN 2 M AGDEIMRHRE LT O ald,
[Method] %2V v 7 LT, T 5HET&2IERL £,

3 [Max.Results] MO AT g v 2ERL T, FXrTsby MUEHIFRL
£9,

4 MFETDHRXa XY NOMHEZIEET 25515 [Scope] oA T a
VEIEIRL £9,  [Default] %R L 7255, HONEHERIN T
LFFHD KX o A2 MAMZITGIC7e 0 £9°,  [Al] 1%, T XCoffH
DRF 2 Ay NeMZBTRICT AL £, [Custom] 13, M
FOTRICT D RFX a2 XV MeRETLHLAIHTAL £9, MERE2FEITT
HRF 2RV NETEERL TZS 0,

WEIRNGREMTET D
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5 ity a v

FlE A.2
1 M3 A Ty 7 ZAEERT 5108 A=a—06 [E] > [Build

To be able to search a document, there needs to exist a search

index. The status column of the list below shows, if an index
for a document exists.

To create an index check the box in the list and press the
“Build Index" bution.

| Search Scope

staws 4]

[ KDE Application Manuals

[ KDE Quick Start SUSE Linux Enterprise Deskiop 10
1 KDE User Guide (en)
Bl Novell AppArmor Admi
Bl Quick Start SUSE Linw skiop 10 (en)
E Release Notes SUSE Linux Enterprise Deskiop 10

(en)

[ GNOME Quick Start SUSE Linux Enterprise Desktop 10 SP1

Index folder: /ometux/ kde/share/apps/khelpcenterindex/

=

Build Index

WELEG, [RFE] 27097 LET, MR

M—ERREINFET, XRINTBY 722y 7T 5hE, REa
AV MDY T BTSN S 2 8N TEET,

HL A > T 7 DR

SearchIndex] DIFIZEIRL £9°, 7 ¢ > KiZ, BiffHelp Center TFJH
TELRFa A M- ERRENET,

MEZA Ty 7 ARERTEREF a2 XA "NE2WIRL, [£>F v 27 X(F
Bl 27Uy LET, £ 0Ty 7 AMBNERINS, & XME2FIT

TLIEMNTEET,

Search Options  |[4

Method: and

Max. results: o
Scope selection: Custom

CEEs

Scope

= Administration
= Linux Documentation
D Manpages
= Application Manuals
E KDE Application Manuals

|Gl Release Notes SUSE Linux E

Build Search |ndex... ]
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A2 D) Y — R 0EEIEER

RGO =2 TR REFa A ME, A% —%v b EDhttp://www
.novell.com/documentation/sledl0/M6T7 7 AT LI LY TEFE
7,

o EHRE BIFL 05 EE. (ROA 2 —2%y b YA MBBIHL TLEE 0,

Novell7 7 =)V P HR—KF Ly I RXR—=2A
http://www.novell.com/support/

G R—RIIa=F 1 DOYY—2A
http://forums.novell.com/novell-product-support-forums/

KDE R ¥ 2 X > hWeb¥ A k
http://www.kde.org/documentation

KDE7 7V /7 —> a3 MO RXa x> hWebH A b
http://www.kde-apps.org

Floo —RNZMET Y b, HNOEREFR TSI IbET, 2
ZIUE, CDOHEZIARIFOREES, OpenOffice.org” 7 A b DA B9 5
N2 EIE. TLinux CD-RWAIV ) X TOpenOffice” 7 A VD%
O] ok > HEEZMZEL £9., £7-. Google?lZlFLinuxH oMz >
Y http://www.google.com/linuxbHEINTWEYd, oz I
ZRIATE BB RE IR TN TEET,

WEIRNGREMTET D
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http://www.novell.com/documentation/sled10/
http://www.novell.com/documentation/sled10/
http://www.novell.com/support/
http://forums.novell.com/novell-product-support-forums/
http://www.kde.org/documentation
http://www.kde-apps.org
http://www.google.com/linux




WindowsH" 5 Linux ™\ DT

Microsoft Windows”> & Linux|Z f{T S /=515, Windows TH 7 U A D KEREE
738, SUSE Linux Enterprise® Tl & D L D17 > TV AN THER L 2 S, |
7' A 9% &, Windows°Macintosh7 27 kv T THEN7 A 2L A
T RMERENDL I LICBRAOXICRALTL &9,

X B1 KDE 57X kw7

CELEREEERF aveRETELT
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BA1 XA/ A_a—hmhoDF7T) 45—
3 VDELE)

Windows® [AH — K] A=a—D LI, BEVDT AT LA VA N—
NENTHDETRTOTOATITLE, A v AZa—POHEITS 2 &N T
TFET, A= —Z2HCE. NRNLVDKEICH SRR EDOSUSET A a2 % 7
Jy 7 LET, ZOA=Za— 3R LoEICR>TBY, 77U r—T 3
YOLHIMBA PSRN E D RIGETY, BHINICG 727 7 U r—y g v &
HICHDT L2 eMTEET, A A= —FMMlE 13.0H XA 2R
Za—ANDOTF I EA] (11 X=)EBIHL T ES0,

KIB.2 KDEDX A2 A==z —

= > @/ tux @knox ~ - Shell - Konsole
] y 1 [
ﬁ == ke
@ @ wi <E© 2

AR R ITA MO Ta T I L EFTTTLI L TEET, 2oL, Alt+
REF—ZFLTFERENDLIAS 7Oy T, 7TV r—y a2l d2a<
VREANLET, NS, a<v  REGEET7 IV — 3 VAR INUTFR
LLzbolcr £9, =720, AL H £,

750 1249 pm |
A i
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B2 774 )LDOEIE

TI7HNWVKRDKDEZ 7 AV 2=V ¥ (BLOA Y F =y N TTTH)D
Konqueror % tCifif; 9~ 2 121%, Alt+F2F% —Z L T, konqueror& AJJL £,
R—=LF4 L7 NJDarysy ’5:%'%?'3_6 Cld.  [PersonalFiles] %7V v
JLFET., Zova—%EIERRTLIEEIE AR VDT A v I AT~ KT
AL ET,

X B.3 Windows T2 Z 71— = & Konqueror

ocation Edit View Go Bookmarks Tools Settings Window Help

QL0 = aa nOE=R 2K

B Location [fhome!tux "] =

‘Name |Size |Fi|e Type |Mcd\f\ed - Permissions |Owr‘
[Ebin 48 B Folder 04/08/06 11:53 drwxr-xr-x tux
™ [~ IDocuments 80 B Folder 04/08/06 11:53 drwx— tux
[ggpublic_html 80 B Folder 04/08/06 11:53 drwxrxr-x tusx
13 ADeskiop 288 B Folder 04/08/06 12:01 drwx— tux
[E3Pictures 80 B Folder 04/10/06 16:39 drwxrxrx tux
[} [helpcenterpng  100.8 KB PNG Image 04/10/06 17:21 TW-PW-TW- tux
[“kde_menupng  615.1 KB PNG Image 04/11/06 12:51 MWW= tusx
M @kde taskbar_a.. 246 KB PNG Image 04/11/06 13:38 MWW= tux
@kde ccnlrclccn... ‘\05 2 KB PNG Imagc 04/11/06 13:58 T tux @
Q [4' e + 20 Mk Alll‘lll’\: A4 . m,z]
D & kde_explorer1.png (81.0 KB) PNG Image

T 7 AN 32— ¥ & L TDOKonquerordififild, 14H 74V ¥BLY
Konquerord® % % 7 7 A WOEH] (19 X—=)EBIHL TL 7280,

B3 OV RSA VDEHR

Wmmm@zvyﬁﬁny7b®£5’nvykify#%:vyP%%ﬁ
TLIEEIL. At+F2% — 218 L Tkonsole& AJJT 50, IR ILDY
4’/725’ c7Aay ZHL £,

Windows7» & Linux N\ D AT
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XIB.4 Windows=22~> N7 > 7k Konsole% — 3 F )b

e

| == Command Prompt

‘ET tux@knoxi~- Shell - Konsole & il
tux@knox:~ = Shell - Konso e =

Session Edit View Bookmarks Settings Help
tuxBknox:~> il

o P

2=

(W
o
u
2
=
Q
LS
B
=
3

a2 R T4 BT AR 0. 5155 Working with the Shell
(tDeployment Guide) % Z I L T {72 &1y,

B4 AUV Ny TOHAHARAIITA X

KDET A7 kv 7 ONMBIRENELZLET HI21E, Alt+RF—%2F L T,
kcontrol® AJJLE T, EETEILHEICIE. TAYZ by Tois5m, A
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X B.5 Windows® 2> h2— ) NF )L EKDE3 > h @ — )& > 5 —

A" Personal Settings ©)
Eile View Setings Help

Desktop

Internet & Network

&KDE Components

Peripherals

%Regmna\ & Accessibility

g}i Secunty & Privacy Hostname:

]

System:

Release: 26.16-15-smp

e Machi 686
'%System Administration | i oonE

Use the "Search” field if you are unsure where 1o look for  pariicular
canfiguration option

—
@ Sound & Multimedia

FAMC oW TE, 21U TKDEZ > ha— v v % —ffiff]] (53 X—V)%
ZHL TL 2 &0,

BS U Aty b7y T

SUSE Linux EnterpriselC 7'V > % ZiBfl, £72i3%y b7 v 7512013 AA
¥ A= 2 —7» 5 Printing ManagerZ i 2dfi L £, 7V > & OB HIER. Bl
VadoEH., BIOANY AT LOFENTEET, i oOWTE H
128 71 > ¥ DEFE 207 XN—)e B L TLEE 0,
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X B.6 Windows® 71 > %/FAX & KDE DPrinting Manager

& Configure - ROE Control Module & p

Pnnt management as normal user

Some print may need P ges. Use the
"Administrator Mode™ button below to start this print management tool with
administrator privileges.

| Add ) Printer_ £y print Server 77 Print Manager_ _:IV'“" {9 Documentation_

& 7 A Mail POF File @ Prntto File PostScriph
3 Advanced Faxing Tool (ksendfax) [ RG] Send to Fax

&4 Information | |23 Jobs -, Broperties i Instances

Print to File (PDF) .

Type: Special (pseudo) panter
State. Idle (accepting jobs)
Location: Local file
Description: Wnte PDF/Acrobat file
URL

Device
Model

Print system cumrently used: CUPS (Common UNIX Prnt System) >
Server. localhost631

Administrator Mode v QK K Ccancel

B6 77U — 3 VEDIYEA

Windows® % A 7 /N— L [Gl#f1C, KDED FEBO/NR LG, BN TS 7 4
VR EZRLIUIVEA L2 M TEE£7, /2750, Windows& iV, KDE
TIHEBOT A Ny T TCERRL TS L LT TEET, ChonF A
7 by TRE. SNy 2T EBALZ LM TEET,

FTav T a—bhy bE—%2FERATS

Sa—bhy hE—%2ioT, o2 r by TRZUIVEZAT, Th
FHTEWEL TWA 7T r—y a v RAITAZEMTEEYT., 77V
r—3a yBETIVEZ D123, Alt+ <Tab>F — 2L £9, Ctrl + F1.
Ctrl+F2, DX —DlAGOEEMHTLZICLY, 727 by T
PHHEICUIOVBEA L2 MW TEET,

X B.7 Windows/N % /L& KDE/N %)L

prcke rae

= el e | fm 2 Wrcows . — o pcck Ut —Fart 3 o NS
[ = e % ml ™ wx@knox:~ - Shell - Kensole N
ODWE L B o rarauwor Qus AW

q3:3.
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F2AI Ny TIne, Z7ANMRTF 4 L7 M), BEOUE—RKRAN Fol
EOY—ERT IRV ALEY, BADTZ 7 ANRT A LI MRy hT—
oo 2 —FICHH S ¥ 5 Z &3 TE £, SUSE Linux EnterpriselZ 13,
Iy NO—=IHFY =217 72 A L0, UV —2ARERT D200,

IFEFSELRFEVPHESNTOHET, ZHHORy hT— 7 iEE Bivo
AV FOFREIIEL T, *y N =7 FoEF) Y -2 - 2%
Konqueror® 7 7 A V= % — T ¥ (I L CRIHICBIHTE £7,

X B.8 Windows?D~ 1 3w k17 —2 &Konqueror?® % v b7 — 2 ZH]

P My Network Places ‘;”E”X‘
Fle Edit WView Favorites Tools Help "

eBack = Q- @

3 X 9| @~

,O Search [ Folders

Mame

] Add Mety{ Location Edit View Go Bookmarks Tools Settings Window Help
9 Network g O SN B
#hriovel Co : P A ::
@Ertie et | B> Location: | [ services

2 DATA on | N - i
($1ftp suse.c] — I {/ 1" él ‘
By webd \ KR\
Slsuise cs.Lit AllSLP Services S5H File S5H Termina | WNC Connection  whenvhttps
& Browsing
3
5]
[ e v
|
I’y

[ |[@[6tems - 0 Files - & Folders

Iy NI =2 U= 2ANDT 72 ZDHMICOWTL, F9=m rw =21
V= ZNDT IV Z T3 X—=) e B TL72E 0,
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LinuxV 7 bz 7OHE

Lmux L o7 TV r—=va ML Twabzo, 2L othsE,. 120
i @ﬁ@/UnF/a/#%@iT 272l BRI b WL 7277V
=g R RDOUBTOIIESTIEH FHA, =2 Tld, —#iZeWindows
V7 N =7 L[S /)78 Linux 7 7Y i — /a/cowTﬁMLiﬁ &
Iy arTl TNEWFEDO T OT TV r— a &Y L. Windows
TIVIr— gy F ST ALinuxkd 7 TV r—v g v, BLOZFol}
FZOWTCERHL £9, &IED\VB\5cnRICIE. FNFNDLinux7” 7V 7 —
v oa YoM, oS RADY v ENTHWET, VI T =2T D
BT 2ATFEICES L, X THLL T TU =2 3 USRS Ty
L2720, ZOYARNPTERTHILIEH FEA,

FAy T RRT7IV— 3>

CZTCHIHESNTOWEITRTCDT TV =2 a vMTF I ANV KT AT L
WA VAR —=ILENDLITRY A, 07 7V r—3 3 13, #1lH
aﬂ@éhfwﬁwﬁ%&ﬁ%@i?oﬁ%?é7ﬁ07~>3ywﬁw

gl VAT LAEHHICBEWEDELZSW, 7T =T g Uil
mt F o TREEN T DLIEEE. YaSTR ALty T U r—s 9>
TAVAR=ITCEET, YaSSTO Y 7 b7 = VEY — )L OMEFSEER (f -
T Nyl =V EDFTLIEEN,

C.1 {FECHFT7 1« R)

2Tl R TCHR /IR Linux DA T 4 A R AV83\5c T k7 = 7\'83\'5¢
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AAAL =K, T—=EXR=A, W2tV 7 b0 =7, B 7uav=7 NE
Y7 =270 £9,

&£C1

Windows & Linux D77 + X/ 7 N o= 7

520

Windows 7 7V o — 3 v

Linux7 U5 —> 3>

F7 4 AAA— b

J—RK7atk vy

R 7 b

N
<
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\/
N

!
|

Fx Ty h

N— 2
Mhat

7ﬁylﬁ%ﬁﬁ

YA Ry T

Microsoft Office.
StarOffice*. OpenOffice.org

Microsoft Word,
StarOffice/OpenOffice.org
Writer, WordPerfect

Microsoft Excel,
StarOffice/OpenOffice.org
Calc

Microsoft PowerPoint*,
StarOffice/OpenOffice.org

Impress

Microsoft Excel. MicroCall

Origin

Microsoft Access.
OpenOffice.org Base
Microsoft Money, Quicken
Microsoft Project

MindManager, Free Mind

OpenOffice.org, StarOffice.
KOffice

OpenOffice.org/StarOffice
Writer, KWord

OpenOffice.org/StarOffice
Calc, Gnumeric., KSpread

OpenOffice.org/StarOffice
Impress. KPresenter

OpenOffice.org Calc, Kst,
Gnuplot, Grace (Xmgr).
LabPlot

OpenOffice.org Base,
Rekall, kexi, Mergeant,
PostgreSQL

GnuCash, KMyMoney
Planner. Taskjuggler

VYM (View Your Mind).
Free Mind, KDissert

FreeMind

FreeMindZ FJlHL C. ¥4 > K~y 72Fk WET L2212k, B
DHEAZEMHEACT LN TEFET, lHIC) - RBLUO /) —RoAZ A
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V& a2 — LT, HTML, RTF, X —)L7% & D\83\5c— A6 T X A N%&
\VO3\5c Y {115 Z &M TEET, \'83\'7dA > K\83\'7dv 7ix, HTML &
XML ED S F EERFANICT 7 AR— FTEET, FEIcOWTL,
http://freemind.sourceforge.net/wiki/index.php/Main_Page
B TL72E 0,

GnuCash
GnuCashld, HAB L CENOH 7L EHT 5720 D\V83N\5¢7 k7 =7
Y — )LV CY, GnuCash®iFAHIC DWW T, http://www.gnucash.org?k
ZIL TLIZE0,

Gnumeric
Gnumericl¥, GNOMET 27 b v FFHIFH D\95\5¢:+H\83\5¢ ) = — 3 5
> T, Gnumeric®DiFEMIIC DWW TIL, http://www.gnumeric.orgkh %
BHL T2 En,

Gnuplot
Gnuplotld, FEEICHSJTHMMOE W, a2~ RI A »THIHT 57—
27y NHYZ MY =27 T, MacOSHE L UO'Windows 7 7 v N 7 — AL
TYHFHuEETY, GnuplotZ23Fakd 5 72w i, PostScript. PDF,
SVG. BLOZOMMDIA Ty ZR—- v TEL0, BFICTay b &
WG E £ 9, GnuplotdiHAHIC DWW TIE, http://www.gnuplot.info/
index.htmlZZHHL T2 &0,

Grace
GracelZ. LinuxZ ZLl3 & A TR TOUnx THIHTE 5, JEFICTEAR S
hiz2D7vay NHY—=IVTY, V974 NV a—HP A F—Tz— A%
ffioT 7y MEFK, sl £, Graceld, Yy h 26T
VL DI 7Y R—- ML TWET, =7 ZAKR—- MEICIE, JPEG,
PNG. SVG. PDF, PSBLUEPSHEENE T, FHlCOWTIE nttp://
plasma-gate.weizmann.ac.il/Grace/%ZZIHL TL 2 &,

Kdissert
Kdissert!3 7 A 77 & 2> 7 K &2\8A\5cRT L7007 TV /r—a v
T, R AEFAEERGRE L TOETA, Hin, ERREETE, =Y
=7, BVRABNTAV R EICOHEM T, ET7 AT 720 NI
W, V) — IS £, \83\'7dA >~ K\'83\'7dy I 5, PDFY 7 A
V. T X A b SCFH(OpenOffice.org Write & 1), HTML Y 7 A JL72 & D,
SFEIELLNNEAEKRTEET, FHICOWTUE, http://freechackers
.org/~tnagy/kdissert/ZBIHL T2 &0,
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Kexi

FAMC OV TIE, KOffice (340 XN—)%&BIHL TLEE W,

KMyMoney
KMyMoneyld, KDEOHAH 7 7 A F > A< 32—V ¥ TT, SELHHR
\OAN5c Y — VBRI L 2 2 ic k), A — T N8\N5c— AD AN L —
T4 VT VAT LD A=Y =DME AR 2 1B 5 2 LN TEET,
KMyMoney D iFAHIZ D TlE, http://kmymoney2.sourceforge.net
B T2 &0,

KOffice
KOfficeld, KDETZ 27 kv FICHMGSNIA T+ AZAAL =TT, T—
K714 v H(KWord), \95\5¢Z[E\83\5¢ 7 b (KSpread). 7 LY > 7 —3 5
> (KPresenter), < D OWAGNUEE 7 7 1) /r — 3 3 »(Kivio, Karbonl4,
Krita), 7 —#X—270 > h T KKexi)®, o< DEY 2 — DT
f&L CTWvET, KOfficeDiHilc DU TlE, http://www.koffice.org/
I TL72E 0,

KPresenter
DWW T, KOffice (340 X—3I)&BIHL TL 72 &0y,

Kst
KstiZ ) 7V A LDT — B FoR & AR T — 7 EEZ L 72 7 a
KDz DKDEY 7V /r— g > Cd, Ksticld, BERI A T AR —
RUTTF=ADT YT 4 TIRE BRIV b A N5 L &
FNTBY., T304 HER4Sc TR T £9°, Kstoifflico
WL, http://kst.kde.org/ZZIHL TLZE 0,

KWord
FFAMC DWW T, KOffice (340 N— )& BIHL TL 2 &0,

LabPlot
LabPlotld, 2/KTCE 721d3KILo 7 — % 7 ry &L, EHT 5729
DITATILTY, Vo7 T8 EEROMANSERT L2 LT
1007y MWEROV I 7 EEL I eMTEET, £ ek
T =2 A UIERMEL TuvE T, LabPlotdFflc DWW TIE, http://
labplot.sourceforge.net/%ZZIHL T2 & W,

Mergeant
MergeantlZ, GNOMET A7 kv JHDOT =4 X—270 > RV KT,
SRS DWW T, http://www.gnome—db.orgZ ZI{L TL 2 & W,
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OpenOffice.org
OpenOffice.orgld. Microsoft Office &[] DISEEER I FOA —T VY — 2D T
7V Jr—3 37, OpenOfficeorgld, 7 — K7ty ¥ (Write), Kat
HY 7 heT—FRXN—A =Yy Base), 7L EVFT—Tar<pr—
¥ ¥ (Impress). {7 7127 Z L(Draw), B L O 7D F7FE & X\ (Math) %
AERT HEATT 1+ # 2 ZU@S 1A 74 AAL =TT, 7TV —
v avA B T =— AlFMicrosoft Office 7 7 7 — 3 7 7 I VICRL
ITHE Y. Microsoft Office = — VIZHIIE A D & 5 T X TOREENTIE L £
9", OpenOffice.orglIMicrosoft Office 7 7 r—> g o5 —2% A
R—hTELD, T4 AR = NEORTH AL —XTT,
OpenOffice.orglZIEWindows/ N — 2 > & $H 5 /=8, Windows = — V%
Windows% {fif L 222885 7 — 7 \83\5c— ATV A 2 2 & I8 T & &
9", OpenOffice.orgDiFAlIC DV TIE, http://www.openoffice.org/
EHBIALTL IS, 72, AFEHDOpenOffice.orglc T 2HTH, 47+
AZA — M EEHRISHNL THET,

Planner
Planner|, WindowsfH® 711 Y = 7 NEHY — )L L [EI5F OFSRER 2T 2
ZeHHNETAHGNOMET 27 vy FHlo7ay =7 NEHY —)LT
T, B SN T LEEEE L TIE. GanttF v — MERE. 2 27 &2 U v —
2D DEFHEOE 2 =72 ENH Y £9, Plannerd iffllc DT,
http://www.imendio.com/projects/planner/%ZIHL T 72 &
Uy,

PostgreSQL
PostgreSQLI%, ~F ¥V g HEBx— 7 Y MUK 22—
PEFROME L OB Z ZOEESQLOINRY 72y & R— N 57
T2 ML=y gF T —FRXR=2FH T 25 LT, PostgreSQLD
SHHC DWW TIE, http://www.postgresqgl.org/ZEHBIHL TL /2 &
Uy,

Rekall
Rekallld, 77— ¥ RXR—=ZA&FT %Y -V TT, HiRh—hIhTnd5—
& N — 2%, MySQL. PostgreSQL. XBase XBSQL. IBM DB2. LU
ODBCTY, RekallZ{fiff] 9 %L, &EDLKR— T 1 —LfEk 7—
BX—=27 TV DG EET =2 DA VR— NI AR IR TE
F 9, RekallOFHIC DWW, http://www.thekompany.com/
products/rekall/ZZHL T ZE W,
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StarOffice
StarOfficelZOpenOffice.org D ¥ H {iA& D /N — 3 5 > T, Sun Microsystems?)®
FfE L CvyE 9, Windows*°Solaris% & e, ®H DT T v b7 4 — L TH
Fu]GET, 7 U —hii(OpenOffice.org) TIZAFH T E 7y, W O DEE
eE45c ZEN TV E T, StarOfficeDEEMIIC DWW TIE, http://www
.sun.com/software/star/staroffice/ZHBIHL T &,

Taskjuggler
Taskjugglerld, #¥EThHi /170y =7 NEMY 7 b =7 T, Gantt
F v — M5 E BT 570, & LAR— FNXML, HTML, #7213
CSVIERN) 2L Ty =7 ML Y., 77V r—varoa
< R A ARFICEN T v — W13, Taskjugglerd 75 7 ¢ L7
0y hTY REMHTEET, TaskjugglerdiffHicDWTIE, http://
www.taskjuggler.orgZ ZIHL T2 &0,

VYM (View Your Mind)
VYMIE, \'83\'7d1 > K\83\'7dy T EB L OBEL T EZ ey a7
MALT H\V83\N5c 7 R =7 TT, 1FE A COIEL, 1o~y 271y
JCHFRTTEET, I oFE BHICVONTAA, HIFR. F 2R
LZeWNTEET, VYMIE, \83\7dy T DI EDENEE, fHETL L)
W77 5 28N TEET, \83\7dA >~ K\83\'7dy 72l U~
7. A, BEOA A=Y HIBMTEET, VYMV83\'7dA >~ K\'83\'7d v
TIEXMLIEX 2T 5729, HIMLIERA CRHICZ 7 A R— N TX £
9, VYMODGEHIC DWW TIE, http://www.insilmaril.de/vym#% %
BHL T2 &0,

C.2 Network

Ko7 a3 TlE, 2y NT—2HoESEFSE L Linx7 7V —> g%
HNMLET, BUAROHILInuxD T T IH, B A=), Fyrv 754
7 MIOWTERIHL £7°,
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# C.2 Windows &LinuxDFfy NT—2 7 ko7

SRy Windows 7 7U 4 —> 3 Linx7 7)o — 3>
v
Web~7 Z o7 ¥ Internet Explorer, Konqueror, Firefox,

FTTRA=NTFTAT
VPN R L

AAZ M Ay -
VNIRCT ZA 7 ¥k

DT AT
)

VoIP(Voice over IP)

FTPZ 54 7 >~ &

Firefox*. Opera
Microsoft Outlook™,
Lotus Notes. Mozilla
Thunderbird*

MSN. AIM#*, Yahoo!*
Messenger, XChat, Gaim

NetMeeting

X-Lite

leechftp. wsftp

Opera. Epiphany
Evolution. Kontact,
Mozilla Thunderbird
Gaim. Kopete,

Konversation, XChat

Ekiga (VLA D
GnomeMeeting)

Linphone. Skype

gftp. kbear

Epiphany

Epiphanyld, GNOMET A7 kv JH @D, W08 0571172 Web 7 Z w74
TY., ZORN9N5c & kD% < 1E, Firefox & I TV £ ¥, Epiphanyd
FEHIC DWW T, http://www.gnome.org/projects/epiphany/%

ZHIL TL 2 &0,

Evolution

EvolutionlZ, X —)l, TEKR., BIO7 KL AROKRELR HAGH /-

GNOMET 27 kv 7O ANHEHET Y 7 7 =7 T7 . Evolutionld &
JERTET A=V T 4 W F MEFd T2 a v B L UPamT /N A AN D [E) A
HEZ 12 L. Exchange ¥ 721ZGroupWise”? 74 7> b & L CTFEITTH 2 &
O TELD, BHRIEAOREM Y RT3, Evolution®iFilic DT
lZ. Thttp://www.gnome.org/projects/evolution/] ZZIHL T

{TZ&uy,

Firefox

Firefox!dMozilla7 o 7 7 7 I U DD A > /38—, Linux. MacOS,
Windows# 2o 8 F8ER TS5y N7 4 —LTHEFL £9°. Firefox? £ 72
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F¥vo4\sc & L ClE, 1 A Z\83\TdA K uf\'94\5c7n PR R IE 94\ 5¢, R v
TV I Ty X RSS=a—RA T 1 — R, N2AT— REH, # 7
ETIUR, BLUOEEREX 2T 4 ETITANT =D T 3 00
0 %9, Firefox Tl MR, V= "= ZF 2 \8\7b¥ v DlTe
A ETRTC OS5 Z T H 2 Z\8\TdA A TE T, Hf)7e7 KA
AR ESEED SFirefox O Web 1 kN (https://addons.update.mozilla
.org/?application=firefox)6 % 7 > H— K TX %7, Firefox?®
RIS DWW TE, http://www.mozilla.org/products/firefox/%
BHHL TLZ&v, TKDE2—#771 Ky ¥7-1% TGNOME = —477 1

Rl .OFirefox D& S L T2 Sy,

Gaim
Gaiml%, AIM&ICQ(Oscar” 1 s =1)l), MSN Messenger, Yahoo!*, IRC,
Jabber, SILC. GroupWise Messenger®74%: & OEN D711 s a)L %P R— k
TLEMHEA VA U N Ay 2P TR T LTY, Gamk [HHT 5
. HEOMry T =207 hTr MIa s A v L TCEHICE R 5 F ¢
FNVTF vy bTEFET, GaimlZlEWindowsN\—Y 3 b H D F7, &%
IT. Gaim|FPidginiC LHIMEE SN E L 7z, PidgindFFEic DT,
http://www.pidgin.im/ZZHHL T2 &0,

gftp
gftpld. GTKY =V F v N&{HTLFTPY 947> N TY, [ARF 7~
o— R, Sz 7 7 A VERROWEBE, 7 7 A VilinikX 2 —, T4 L7
N &fko ' oa— R, FTP7af v o¥R—h UE—-KrT1 L7 b
VOXv v o7, Ny TBLOIENY Y TDT 7 A VIRIK, T v 7
7Y RRBy OV R-bh s LREERZENTHE T, sHflliconT
. http://gftp.seul.orgZZIHL T ZE W,

kbear
kBearld, DB A N AD[EFHENE, 32O 2 —E— R, #Hfio7a b
T)U(ftp. sfipZe EYDHR— b, YA MNSNTdR—V ¥ TITV A, T
A7 F =IOV R— b, B ZEN5c, BLOZOMDZE L DFk94\'5¢
W& LKDEFTPYZ 4 7 > N Td, FMic>0WTE, http://
sourceforge.net/projects/kbearZ B L T 72 &1y,

Konqueror
Konquerorl®, KDEDBIFE /- HIERS /=, ZHNO7 TV r—v 3
YCY, T ANRE=V ¥R KX a A ha—7 e LCEFLET
M, JEFICHES )T A <A AHDOEOWeb 7 T 7T H D £7,
Konqueror|£CSS(2). Java?” 7 L v k. JavaScript, Netscape” 7 7' A >
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(Flash, RealVideo). DOM. SSL7% & D#T OWebfEi#a %7 R— h L £7,
Eo. ME SN TR L ORIV S =Nz 2 L. 7 Tff
XTI XYY R— KL %7, Internet Explorer, Mozilla, OperaZs & D%
DOHDOWebT T IHMNE Ty I~—0 %A ViR— 52 TEET,
Konqueror® il DWTIE, http://www.konqueror.org/ZHIHL
TL 7Z2& vy, Konquerorll DWW T, TKDEzZ—#77+1 K OWeb7Z w7
POELZIL TLEE 0,

Kontact
Kontact!, KDEDf NHEWEHEA A — N T, W A—Ib, AL UH,
7 R VAR, Palm& O[aiFEES & N T £ 9, Evolutiond L 9 12,
ExchangeX°GroupWise D7 74 7 > h & L CHHWFT 5 Z LMW TEE T,
Kontactld 2% > K7 B > OKDEY 7'V 77— 3 »(KMail, KAddressbook,
KOrganizer, 35 & O'KPilot) % ffl 5t T, MHEH 2T X T OPIMEE'94\'5¢
IR 54 5 1 2L £, Kontact®FEMIIC DWW T,
http://www.kontact.org/%Z B L CL/Zsvw, TKDE=z—71
R ®KontactiCB T 2E b BIAL T ZS W,

Konversation
Konversation!d. KDEF D23 WIRCYZ 54 7> hT9, SSLIF oY
R—=br, ANTAZ 7T, HEF v 2V, BT @G0 Xy &—
V. ) 2 N ok, Unicode. — AN HEER Frv Y4 R
TNDH A LAY T DFRIR, ] AERiF s B L W - TBEERS Z £ T
W¥ 9, Konversation® iFflllc D ClL, http://konversation.kde
orgZ BIHL TL 7280,

Kopete
Kopeteld. IRC. ICQ. AIM. GroupWise Messenger. Yahoo. MSN, Gadu-
Gadu, LotusSametime, SMS X v &z —3 Jabber’t & 711 h )% H7R—
NI EEFTHENRCTNA Y AZ U M Ay T %Y =)L T, Kopeten
DM DWTIEL, http://kopete.kde.org/ZHBIHL TL 72 &0,
FKDE =z —+"771 KJ ®Kopetellf T 55 bHBIAL TLZE 0,

Linphone
LinphonelZ. EH%EETHXE 72 VoIP (Voice over IP)7 5 A 7 > K C, SIP7 11
AL EEHALCGEEEL £9, FMicowW T, http://www. linphone
.org/H B L TL 728y, LinphoneD &= b i { 7281y,
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Mozilla Thunderbird
ThunderbirdiX, MozillaA A — b D—Hf& b, EFA—IVI T4 T b
77V r—3 3 C9, Microsoft Windows°MacOS T & FJ H 0] \'94\'5¢ .
%mb@m¢MW®ﬁ«v T A TV AT LD S Linux N DT E RS
ZL ¥ 79, Mozilla Thunderbird® iFAHIC DUy TlE, http://www.mozilla
. org/products /thunderbird/ZZHHL T 7ZE W,

Opera
Operald, VEIIGU CETFRA=NVITA TN, Fry NEYV2—)UR
EDOMN 7 R 2 Z1E#CE 50 /)72 Web7 Z ¥ T, Operald., Ry
TV T Iy F V. RSS=a—RAT7 4 — K, HAHXNENTdA A u]\'94\'5¢
7 NI EE04\5c, NAT — R\8\Tdr—V v, BLUOZ Iff& TS5
ZRNONScH IR L 9, FaMERCIE. ThTho sk )L &AL iR
W7 782 TEEY, 20 —)LIZIiEWindowsH b & 5729, Wlndows

2P HEZICLinuxICFHTTEE T, Operad®iFlic DWW T, http://
www.opera.com/ZBIHL TL 2 &0,

Skype
SkypelZfT< D7 F v b 7 #— L(Linux, Windows, Mac Os X)[H® 7 7
Vr—varT @EheEHeTy Ry -2 ROES2HMAL T, A
VA =%y N ETOBEGHIHHTEE Y, SkypeZ (T o&EE 77
AT F—IVERIIIN—F OFEIIRETT, FMICONTIE, http://
www . skype.com/ZBIHL T2 S0,

XChat
XChatl¥Windows & MacOS X721 T72 <, 1F& A ¥ DLinux & UNIXT 7 v
N7 4 —LTEIWETHIRCY 947> b TY, http://www.xchat.org/

C3 WILFAFT4 7

IKDX 7 g Tl LinnkHOEY N dH H\V8N\NTAVTF AT 4 77 7V
r—arEHNLET, Sa 7T L—Y—, B RNEEY ) a—2 g,
Ei@tvﬁﬁ%vww WICDOWTERL £,
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# C.3 Windows ELinux D~ IF X7 4 7/ 7 ho=7

S5

Windows 7 7 U o — 3>

Linux7 7V 4 — 3

I =4 FCDV

CD Player. Winamp.

KsCD. Grip. Helix

V—f— Windows Media Player Banshee
CD/N—F — Nero. Roxio Easy CD K3b
Creator
CDV v /N — WMPlayer kaudiocreator, Sound
Juicer., Helix Banshee
=54 A4 7L —  Winamp, Windows Media  amaroK. XMMS,
Y — Player, iTunes Rhythmbox, Helix Banshee
v5 A4 7L —¥—  Winamp, Windows Media  Kaffeine. MPlayer, Xine,
Player XMMS. Totem,
RealPlayer
A —7 44 T75 4  SoundForge. Cooledit. Audacity
4 Audacity
P RIFHP—  sndvol32 alsamixer, Kmix
HGEAERK Finale, SmartScore, LilyPond. MusE,
Sibelius Noteedit, Rosegarden
v 4 odlfF & i Windows Movie Maker, MainActor, Kino
® Adobe Premiere. Media
Studio Pro. MainActor
T LV EDORE AVerTV. PowerVCR 3.0, xawtv (analog). motv
CinePlayer DVR (analog). xawtv4, tvtime.
kdetv, zapping
amaroK

amaroK A5 4 7 7 V=Y =133 & Eh A —F 4 AN oL, oA >~
H—=2y NIIAROARNY =I VT d =T 4 AErAETEET,
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amaroKl3 /Ny 7 =2 R & L CHHET 25 > Ry — "D R—- K957 7
ANHE A T NI T & F 9 (HE I FaRts ¥ 72 1T GStreamer), amaroK ® iFAfl1C
DUWWTCIE, http://amarok.kde.org/ZHMHL (L Z&w, [KDE=z—
VA R DamaroKICH T 55 L BIAL T 7230y,

Audacity

Audacity\ FHERL DRE )70 7 > g5y — VT, Ogg Vorbis ¥ 72 IZWAV

T 7 AN, ik BROBHENTEET, FIvIoIF o
TR DM S FITTE, KR %E WAV E /2130gg Vorbislc =7 AR — KT

T F 9, AudacityDFFEMIC DOV TIE, http://audacity.sourceforge
.net/EZHL TS0,

Helix Banshee

Helix BansheelZ, GNOMET A7 b v 7HOSEEHB L OH4E 7 71U r—
> 3 »C79, Helix BansheeZ i35 &, CDDA R — b, iPod D
Hav v g ol iPod2 6 OERHOEEHAE, T4 77 VU6 ol
OHAEY A NDIERR. A 7oV TRy 6O —FT 4 ABLD
MP3 CDDAEIR R & 217D S &M T £9, . FTGNOME=—+ 7
o1 K] #BIHL TS0,

Grip

GriplIGNOMET 27 kv FI1ZCDV L — Y — DFFER IR L 3., FF v
7 & T IIWANLT —H OCDDBMZE V7R — kL £, FFliconTd
http://www.nostatic.org/grip/ZZHIHL T2 &0,

Kaffeine

Kaffeineld, Ogg Vorbis, WMV, MOV, AVIZ%Z ZLelgii W4 —F 4 7B &
CEFTHERE VR — 8T 25 24583\ TAVF AT 4 77 7 V) Ir—
varTY, SEIERIATOT LAY AN A VR— ML THREL.
27 =¥ ay MeFRL, AT 4 7ARN) —L%kBa—)bn— R4
A2V IRIFETE £9, KaffeinedD i Fllic DWW TIE, http://kaffeine
.kde.org/ZHBIL T2,

KAudiocreator

KAudioCreatorld, #¥&DCDV v /X—7 7V /Jr—3 3 > 9, KAudioCreator
FEIRN A THEY AN vy AV EEKRTH IV TEET,
amaroK, XMMS. ¥ 7zidHelix Banshee/z & D7 L —vY —I%, ZhZHH
L THATE£9, KAudiocreatord {§i FH /50 Fflic DWW Tld TKDE=2—
W1 Rl . £7zlFhttp://www.icefox.net/programs/?programs=
KAudioCreatorZ BIHL T 72 &1y,
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kdetv
KDET A2 by 7HoO7Fa s 5 LA e oo o7 7 1) r—
v a v TY, kdetvDiFICDWTIE, http://kde-apps.org/content/
show.php?content=11602%ZIH L T 72 &,

KsCD
KsCDI¥, KDET 27 kv VHo, & T/NoCDT L —Y 77 r—
v rTY, a—PA U F T == AFIWEDON— K7 =7CDT L —YIZ
FEFIZL T ED T, LT <5 TnET, KsCDIZCDDB% H
R—=hL. A7 =2y " ERITZO—HINDT 7 AN AT LANE NT v
DRTNNANLDONEREPETEE T, sFI OV TIEL http://docs
.kde.org/en/3.3/kdemultimedia/kscd/ % ZIHL T &,

K3b
K3blZZHERERA T 4 THERRY — )V C., KT w 77> RRay 7EFIC kS
CF—%., =544, ©54CD. BLUODVD7ay =7 K E{ERTE
F9, KbDFMII DWW TIE, nttp://www.k3b.org/3%ZMHL TL 72
IV, KBbOEZBIHTLZI L TEET,

LilyPond

LilyPond| 3 MRl DGR T 5 ¢ Z T, ATJ7 4 —\83\7dy MET F A K

R=2ADD, FEOTF AT 4 ML TEEEZFERTEET,
2—PFFAN—=A T, RY 74 =— O & OHARL KL O M %2
WS 20035035 0 ¥ A, LilyPondTld, Z @ XD 72 ML T HE)
MICRENET, a— K&, ¥ 75F 27D oFlRidEL Y
R—hr&hE7, H7/F. PNG. TeX. PDF. PostScript. 35 & O'MIDIC T
7 AR — K~ TEE 9. LilyPond®DiFlllc > Tl http://lilypond

.org/web/ZZIL TS0,

MainActor
MainActorld, ZIVEOETA A —H 1) 77 "7 =7 T9, MainActor
I21EWindows/N— 2 g > A% 5 729, Windows): & LI T CE £,
MainActor D FHllIC DV T, http://www.mainactor.com/%Z B L
TLIEEw,

MPlayer
MPlayerld W2 DDV AT L ETERITTCELL—E—T LAY —T7,
MPlayer®:£illC DV T, http://www.mplayerhqg.hu/homepage/
design7/info.htmlZHBIHL T 7230,
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MusE
MusE® = — )V, LinuxMHD58722\83\7d)VF k F v 7 A Z D174
5 Z & T, MusEDFEHIICDWTIE, http://www.muse-sequencer
.org/index.phpZ ZIHL TL 72 &0,

Noteedit
NoteeditlZLinux D it /)72 555 T 5 ¢ % T9, NoteeditZ {§iH T 5 &,k
ZA{FR L. MIDI, MusicXML, LilyPond’7z & D% < DA THMEE A >
A—=FBLUOZZ Z7R— M TEFEJ, Noteeditd FMIICDOWTIL, http://
developer.berlios.de/projects/noteedit/ZZIHL T Z &y,

Rhythmbox
Rhythmbox|Z, GNOMET A% kv THoig/17e, ZHK DO AT+ 7T L —
YTI, LAV AMEMHHL (I a—Yy a7y 28, 7
TIRTLIEWTEET., A7 =Sy hIVF B R-FLTE
97, Rhythmbox®iffllC DV TIE, http://www.gnome.org/projects/
rhythmbox/%Z ZH{L T 72 &0,

Rosegarden
RosegardenlZ KL O FREfRHHFRIEC. A —7 4 A, MIDIY —7 ¥, Bk
OEEE T 5 ¢ 7 BSEER L 97, Rosegarden®iFflllc D T, http://
rosegardenmusic.com/Z B L T 23,

Sound Juicer
Sound JuicerlZ, GNOMET 27 b v FHO#&LCDY v /=7 7V )5 —
> 3 > C9, Sound Juicer®EFAIC DWW TCIE, http://www.burtonini
.com/blog/computers/sound-juicer Z B L T2 &,

Totem
TotemlZ, GNOMET 27 kv JHOL—E =T L =Y 7T U Fr—2 g~
¢, Shoutcast. m3u. asx. SMIL, B L Uraof4Y A ~%ZHR—HML,
F—\83\'7b— R TH > h I — )LSa\NO4\5¢ T, ML WA —F 1 45 &
VCEeT A AT #BEL £9, Totem®iHMICDWTIEL, http://www
.gnome.org/projects/totem/Z S L T Z &y,

tvtime
tvtimeld, 79 a2/ 5 LV EoREnlzooidd 7 7V r—3v 3 C1,
tvtime D i EAH & {FH /7D W T, http://tvtime.sourceforge
.net/ZHBIHL T 2S00,
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xawtv & motv
xawtvl$ 7+ a5 L eE Y R—- T o 7 L oiE L gl zdD7 7
Vr—ar T, xamv/ B2 Y =7 N OFFMICOWTE http://linux
.bytesex.org/xawtv/EZIHL T ZE 0,

xawtv4
xawtvdlIxawtv? T U r —2 g Y ORMAN—T g 0T, T asesoH
VDM GO —F 4 AT AREEYHR— ML ET, sFHlIcO0NTIE
http://linux.bytesex.org/xawtv/ZZIHL T 7Z &0,

Xine
Xinel¥, CD, DVD, BLUVCD%Z HETLHB\TANVF AT 47 T LAY —
T, ZLONTAIVF AT 1 TIEAZMIRL £9°, FHic>WTL
http://xinehqg.de/ZHBIHL TL 7230,

XMMS
XMMSIE— &2 )VF AT 4 7HAT T ) r—3 9 > €, S5EEAICE
sEGb¥, CD&O0gg Vorbis7 7 A VOEAZYR— KL ET, XMMS
1 Winampl 2TV 5 728, Winamp® 2 — BT X £ 9, XMMS
DFFMIZDWTIL, http://www.xmms.org/ZZBIHL T2 &,

zapping
GNOMET 27 kv THo7F a5 LD ig L gl /zb o7 71
r—3 a3 Y, Zapping®ififlic DWW T, http://zapping
.sourceforge.net/Zapping/index.htmlZZIH{L T2 &,

C4 75749 RA

ZITE VI 74w ZANH DD OLinuxY 7 R =7V Y a—3 g 10
OWTHIALET, Shoovy 7 vy =7ICldh, ZVEO A A — Iy —
. WAL B ) BRIV A=Y a7l I LT TR, MR
RIGE 7 7 = a bbbV ET,

& C4 Windows ELinuxD 7> 7 w7 A T ho=7

B Windows 7 7Y 45— 32 Linx7 7 Usr—< 3>

72 A A —Vime%E  Microsoft X4 > K KolourPaint
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Windows 7 75— 3>

Linx7 74— 3>

Jarv=y gt
A A — Vi

Ry a2 A A=Y DI

B4

SVGiim &

3DA A —Y DYERKR

FUINEEOET

AX

A A=V Ea2—7

Adobe Photoshop, Paint Shop
Pro. Corel PhotoPaint, GIMP

Adobe Illustrator,
CorelDraw, OpenOffice.org
Draw. Freehand

WebDraw, Freehand. Adobe
Illustrator

3D Studio MAX. Maya.
POV-Ray. Blender

H AT A—=HHEET L Y
Jh=7

Vuescan

ACDSee

GIMP. Krita

OpenOffice.org Draw,
Inkscape. Dia

Inkscape. Dia. Kivio

POV-Ray. Blender,
KPovmodeler

DigiKam, F-Z7Rv K

Vuescan, GIMP

gwenview, gThumb,
Eye of Gnome, f-spot

Blender

Blenderl¥. Windows. MacOS. LinuxZxZH%< D75y N 74— LT
HTELi /1L o B v 7= A= 52 =)L T, Blenderdifill
I2DWTIE, http://www.blender3d.com/ZZIHL T /ZE W0,

Dia

Dial3VisiolZ i 9" % Linux D [6)FFdl i &2 Hi & 4 Linux 7 7V 7 —3 3 >~
T, *v hT—=2, UMLF ¥ — N &, ZLONKRT AT 7T Lk
A—=hFLFET, =7 ZAKR—-bDZAICTIE SVG. PNG, EPSIH D 7,
NABLDEAT T ITLE A TEYR—MT 520 #H LR 2R
XMLIEATIEEL £9. Dia®iFflic DWW TlE, http://www.gnome
.org/projects/dia/ZBIHL T &,

Digikam

Digikam!%, KDET 27 kv 7HOEEET V2 VFEEHY — )L TT,
VeIV I TTIINARA=TEA RN TRIETEET, 7L

352 KDE = —H% A R


http://www.blender3d.com/
http://www.gnome.org/projects/dia/
http://www.gnome.org/projects/dia/

NLEERL T 7 2IBMT 58, HIOYVTT4 L7 RVIA A=V %
I —HFIIWebP A MA A—VH TV ZAR— b T&$£7, Digikam®D
N OWTIE, http://www.digikam.org/ZSIHL T 7280, £
7z. TKDEz—#774 ] ®DigiKamiCB T2 &b BIHL TLE &0,

Eye of Gnome (eog)
Eye of Gnomeld. GNOMET A7 kv VHOWBZEE 2 —7 77TV r—3 g
VT, FFMIC DWW T, http://www.gnome.org/projects/eog/
EBIL TLEE0,

F-Spot

f-spotid, GNOMET 27 kv Mo, FikieT ¥ 7 VHFEEMY —)LT
T, TIUNRLOERE B, HIMLN— YR EDK ¢ 72T AR— N AT
TaroYR—h HIET —HA TDCDNDEZ AR ENTAET,
F 72, fspotz A\8\TdY RIA VO a—7 e LTHHATLZ Y
TEE7, fspotiC BT 2iF ML http://www.gnome.org/projects/
f-spot/ZBIHL TL7Z&w, £/2. TGNOME=—%7+4 N Di%47
LHEHHBIHL TLZE0,

gThumb
gThumblIGNOMET 27 b v THDOA A=Y a—7, TIUW, F—7h
F AP T, gphoto2lC LA TV HNA A=V DA ViR— h&eHiR—KL,
AR 222405 L OBIE2RITTE, —EDONRANCHE > TA A =1
BT AT TTNNLEFRTE £9, gThumbd I DT,
http://gthumb.sourceforge.net/%ZZIHL T2 E W,

Gwenview
Gwenview!d, KDEH DY > TNV lifge 2 —7TT, 74 NVEY Y —7 ¢
VRIE Ty ANIARNT 4 RUBHY,. T 7 A IV OBEE\8d\5ciE N &
fHRICHEICE £9, FMicoOWTIE, nttp://gwenview
.sourceforge.net/home/ %S L T 72 &0,

Inkscape
Inkscapel XML DSVGL T 1 # T, Inkscapeld. Adobe Illustrator, Corel
Draw, 35 U'Visio & [A)fFDF045ce 22— f > 7 T = — A% 2L F
7, Inkscapelll¥. SVGHSPNGANDI Y AKR— K, LAY —, & 7
SF—vay, ATV =7 hDZ I —TLOREENH Y I, Inkscaped
SIS DWW TIE, http://www.inkscape.org/Z B L TL7Z &0,
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Kivio
Kiviold. KOfficeZ A — MG SN Tnb, 7a—Fyx—hH7 7V r—
v ary TTINE ThVisiod —HE, KivioD)Vy 77 > K7 4 —)UIZ
BLAEIELHTL k9, KivioDiF DWW T, http://www.koffice
.org/kivio/ZHBIHL T2 &,

KolourPaint
KolourPaint!¥, KDET A7 b v 7HDHEWLT WAV KT a5 LT
T, ZoTaTILEMHL T, A7 7T L0NA 2 MO, A7
V—=r¥ay b, BEH 7A3AVOEREDI AV 2FRTTEET, &F
FMZDOWTIL, http://kolourpaint.sourceforge.net/%ZZIHL T
RS,

KPovmodeler
KPovmodelerld, KDET A7 kv 7 &M SN T 4, POV-Rayd 7 1 >
N> RT7, KPovmodeler% {f 21X, POV-RayA” U 7 MZDW T D&t
LWHIEED 2 S TYH, AT 0 U — B2 —05POV-Ray = ili N DA
PADMTAE T, AT 4 77POV-Ray A7 1) 7 | % KPovmodeler|Z { > 7 —
NTHZeHTEET, GFMICOWTIE http://www.kpovmodeler
orgE BHHL T2 E W,

Krita
Krital., Adobe Photoshop & The GIMPIZ} 9 5 KOffice D% Td, /&
VAR = ZDEEIFRE & ORICHT 2 2 28T E £ 7. ilH Adobe
Photoshop*°>The GIMPIZ 3 % L 9 7. £ < O RL 7% W4 S bkaE 2% fifi 2. T
WET, MOV TE, http://www.koffice.org/kritaZzZIHL
TLEE0,

OpenOffice.org Draw
S DWW TIE, OpenOffice.org (341 X— )& BIHL TL 72 &0,

POV-Ray
POV-Ray(Persistence of VisionRay) h L =% % ffif]T 25 &, LA L —2
JenS L) M EMHL GRITO T4+ MY TV AT 4 v 7%
A A=V EAFKTE £9. POV-RaylllIZWindows/N— 3 »03d 5 7=
DT T Ir—3 3> dOWindows —HIIEZICLinux/N— 3 3 >~ dﬂ]@
AL ZEMTEET, POV-RayDHNCDWTIE, http://www.povray
corg/ B L TL 23,
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The GIMP
GIMPIZ. Adobe PhotoshoplZ 39 % 7 — 7 2\83\'5¢— Z D A HLH, T,
GIMP!JPhotoshop & [A]ZF DFSREZ IR 5720, Ya T =y v a oA
A= VIS L T E 9, GIMPIZIEWindows N—Y 5 b H D 7,
FECOWTE, http://www.gimp.org/ZZIHL TL 2 &y, GIMP
DEEBHTLZ L TEET,

VueScan

VueScanld, EDT Ty b7 4 —LIHHATESL AF ¥ 2N\83\5¢7 b =
TCT, BHADOR U E—DAFX ¥ F VT T =TIHTLTA VA R =)
TEET, Ny FAX vy, A= bT7x—h A, 1 HEOHHIH ORI
F¥ RNRED, AX ¥y FONFN— R =7, 612, AT A ROl
WA TDOAT v F ) A AR T 5720 D )VF A% ¥ b HR— b
TWET, BT oE@iENEE, [FhEICFEITTE £, FFHi
X, http://www.hamrick.com/index.htmlZZIHL T 7Z& W0,

CS5 VAFTLEIEL D 7 IIVEIR

ZITE YATLEME 7y A NVEH D20 OLinuxY — )V ORI OWT
ML, X ARNZT 4 ¥, V—RAA=RIZT 4 Ny I 7y T I a—
varv, BLOT—hATY =IO L £,

& C.5 Windows ELinux D> AT NG E 7 7 A NEHDY) 7 N7 =7

ARy Windows 7 7)o —2 3 Linx7 IV o—> 3>
v

Ty AN =Ty Windows Explorer Konqueror, Nautilus

TXANTT 4 H A Elk, WordPad, kate, gedit. (X)Emacs.
(X)Emacs vim

PDFDAERX Adobe Distiller Scribus

PDFt = —7 Adobe Reader Adobe Reader. Evince,

KPDF, Xpdf
T X A K Recognita, FineReader = GOCR
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AR Windows7 7V 4o —> 3 Linx77U&s— 3V
V4

Ay RIA VHMETZ Y zip, rar, arj. lhaZt & zip. tar, gzip. bzip27%

VTN &
GUIN—ZADHfE7 a7 WinZip Ark. File Roller
Z I
N—RTF 4 A7 ®»/N—  PowerQuest, Acronis. YaST, GNU Parted
T4 arEH Partition Commander
Ny 77w 77 N7 = ntbackup, Veritas KDar, taper, dump
>

Adobe Reader

Adobe Reader for Linux(¥, Z®O7 71— 3 > ®Windows¥ & U'Machlx
ICTERISIEL T E T, Linxfiovy 77> K7 4 =ik, ftho 75y
N7 =LY DL —7T9, Adobe Acrobat2 A — b Ofthod 2 ik — %
v M3 LinuxiCHE SN T A, GFlCODWTIE, http: //www
.adobe.com/products/acrobat/readermain.htmlZ S L T 72
Iy,

Ark

AtklZ. KDETF A7 hw THOGUIR— ANy 7 T 7S5 LTT, 27
TVl —3 g, zip. tar.gz. tar.bz2. lha., rar’t & o —#xi]
WA EYHR—-RFLTWET, 7—NATHOE—~T 7 f VDFIR, 1%
R HEfE,. M EFEITTE£9, ArkAKonqueror & At LS /- 2 1T &
V. WinZip& [affi2, 77 A INSNTAR—T v DA LT 7 AR A= a2 —h
577 a (T —NATOMKELRNeFITTHI b TEET, ArkD
SR T A2 M. TKDE=2—# 741 N) OKDEF A7 kv
T T LEEBIHL TLZS 0,

dump
dump\83\7d> RIZT7 7 A WS AF LD T 7 A VEFERL, Ny 77w
TTLRENDL T 7 AIVENFEL, IHESNTVWDLT 4 A7, T—7,
F 2T DMDFCIENIMNTAKIC T 7 A Ve a — L £7, restore1 < > K
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Evince
Evinceld. GNOMET 27 kv 7H @, PDFH J UPostScriptlizA D K& =
YhbEa—7TY, FMcOW T, nttp://www.gnome.org/
projects/evince/ZBHL T2 &,

File Roller
File Rollerl:, GNOMET A7 kv THOGUIN— ANy 7 T 7 5 INT
T, ZoTarILE, AkE[AFEORREZ IR L T d, e
TCl&. http://fileroller.sourceforge.net/home.html % SIHL
TS0,

GEdit
GEditl¥GNOMET 27 kv 7 DANANTF 1 7T, Kate & [AFkOESRER T2{H
L9, FFMicoOWTE, http://www.gnome.org/projects/gedit/
EHIHL TL 7280,

GNU Parted
GNU Partedl, X—F 4 > a>rBLPZDT 7 AT AT LOFFRK. K
YA AEE Fry 2/, BLUOab—-okooav s R4 Y —)
T, MILOARL—=F 4 VIV AT LD D AN— AR T L1565
i, 2oV = NVEHHL T4 27 OfHEZHEL., N— KT 1 27
TTF—XF%av—L¥7, Fllcon L, http://www.gnu.org/
software/parted/ZZIHL T2 &0,

GOCR
GOCRIFI AL FRFMOCR)Y — VT, AFX v v ENLETHFARA A=Y
ETXANT 7 AIVICEIRL 9, FicOWTE, http://joer
.sourceforge.net/ZZMHL T 23,

gzip, tar, bzip2
T4 AT OMHEZIKG TNy r =R T a7 o LMIRELH Y
FI, IERE TV T ZLNFZe 5 7215 ¢, LinuxlZWindows C
HTHIN TNy r—=VEABIIET 5 Z &3 TCE 7, bzip2ldgzip
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kate
KatelZKDEA A — R DAV NT, —hNLVERIFVE—-NTERDO T 7 A4
NREIFFCRE 2 &M TE £ 9, Katell 3o, 7av =7 b
T 7 AINVOVERR. BEOWBAZ ) T NFRITOWEERH L0, T rs
<ITIRIBOY — )V T, FFMIC DWW TIL, http://kate.kde.org/ %%
L TL 72 &0,

KDar

KerrlIKDET 4 A7 7 —HhA TH# KL, "= RO =T7HTONy 77 v T
V) a—3CT, KDaritark FER D hra b H]T 5720, 77—
NA TR EimAHPAETICHEM D7 » A VL TE, ANy 27 v T
2ERRT L2 & %)'C“%i?"o KDarld, 7—hA T E D AT A 2125
HLT, AFA AT L )T —2CDXDVDOEZARE MY HT5HZ LN T
T F 7, KDarDiFC DWW TlE, nhttp://kdar.sourceforge.net/%
BHL TLIZ&0,

Konqueror
KonquerorlZKDET 227 kv THDOFT 7 )V kDT 7 A WN83\T7d % —
T, Web7 U, R¥xaXAr b, @ffea—7, CDVU vy X—=& L {ff
HT5Z2ebTEET, KonquerorZ 7 7 A V<% —TV ¥ & LTHRHTS
JFCoWTE. TKDE=2 =774 F) OKDET A7 kv JICHT 25 %
ZHL TS, Zo7 7V 77— a rOiFflico>un T, http://
www.konqueror.org/ZZIHL TLZ2& 0,

KPDF
KPDElZ., KDET A7 kv 7H®OPDFE 2 —7 77U/ —3 3 C9, PDF
DIRZHE'94\'5¢5>, Adobe Reader & [GJff D 7 IV A7 1) — & — Rig XDk
\ON5c¥H ) F9, FFMICDOWTIE, http://kpdf.kde.org/ZHIHL
TLIEE N,

Nautilus

Nautilusid. GNOMET A2 by TDFT 7 4 )V~ DT 7 A JIN83\7d % —
T, NautilusZFRIE, TANTRRFa X Ok, 77 ANV 7 7
NEDFRREEH], A7 1) T hOFT, CDNDT —F HEIAZL, URIH
=3 a YOFREIMTAFE T, Nautilusz 77 AV~ r—Y v & L THEH
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Ty I LT, 7T RIATEMHL T T 7 ANVDONy 77y T EHIT
ERATCEET, V77 ANVET = AAT T 74Ny I T v TT5HI L
LTEET, 74 V7 MY OBIGHIZEREAR—- KL £7, Ficon
T, http://taper.sourceforge.net/ZFZIHL T2 &,

vim
vim (vi improved)l&, vie WO FFXFANTZT 4 270 I LT,
vimlZlZa~ > RE—- REHFAE— RH L7720, HEICE->TL Hh
% £ TR0 £, EARNRFEII Mo T+ A N5+ Z L[E LT
TAN vimlZlE~ 7 v oitik, 7 7 A NVIER oM & ER, i _E o
DNy Tyl EDA=—= AT arB3H 0 ET, sl O TL
http://www.vim.org/ZZIHL TL7Z& 0,

(X)Emacs

GNUEmacs & XEmacslZ 727 = v ¥ g+ I)VHTZ T ¢ # T, XEmacsld,
GNUEmacs% 2412 L TV FEJ, GNUEmacs® ¥ == 7 )ViClE,  [Emacsl®
WHEB L O A7 <A XalET, BNV T K& a X2 MEEEZRHA 72U 7L
BALFRIRTT 4 A TT) il TnEd, [ Zo2o0x5 4%
DOEEFEITIZ L A LRIC TTA, 2L o@EWNEH Y £7, RS SRS
SEmacsLispSan T2 & BREEZ KISk TE £9, v v 7ah,
XU 7k HAGE HERE. BEEREOZL OFHENYR—-hahT
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Xpdf
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A=K TT, Ea—=77 7V —33&, PostScript®® 7 F A MM
DI AR=NT 7L IIZEENTHET, FMICOWTE http://
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C6 VI MO T7HFE
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SRy Windows 7 7Y 4 —> 3> Linx7FU&s—> 3>
O PR Borland C++, Delphi, KDevelop. Eric,
VisualStudio. .NET Eclipse. MonoDevelop.
Anjuta
Y —=)lF vk MFC. Qt. GTK+ Qt. GTK+
N, T VisualStudio GCC
TNy T — )b Visual Studio GDB, valgrind
GUITH A ~ Visual Basic, Visual C++  Glade. Qt Designer
N— g VEI Y A Clearcase., Perforce, CVS. Subversion
VA SourceSafe
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AnjutalZ, GNOME/GTK+®D 7 77— g YBIFRHDIDETY, HfjER
BE. T RETE. N T4 MRNScoH b T 1 ANEENTOE

9, GTK+DIEZMT Y, Perl, Pascal. 3k Wavall L AHBFEZVR— KL
TWET, GDBR—ZDT Ny HEZENTHE T, AnjutadiHlic D0
T, http://anjuta.sourceforge.netZH ML T E &1,

CVS
CVS (Concurrent Versions System)l&, 74— 7 >V — A Dz & HEZL /N —
Varvarha— v A7 ATY, Zhid BEOLnuxT 4 ARY B a—
v g YIZE& FE T B Revision Control System (RCS)D 7 H > L KT
9, FEHIC DWW TIE, http://ximbiot.com/cvs/wiki/ZHIHL TK
720,

Eclipse
Eclipse Platforml%, H A% T T 7 A 1 & - TRRa] BEZ ARG B AR TR
ERRETELLIICHE SN THET, R=2F 1 ANV ba—T g1
I, TTeJavabiRIRE b S E N 7, MOV TEL http://www
.eclipse.orgZBIHL TLZ S,
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htmlZ B L TLE S0,

GCC
GCClE, Mo r oI v VEifHlovay Ny Reffo, ar g
FaL sy grTY, BREOFL WY A b, Fifll7e K3 o X2 M,
http://gcc.gnu.orgZ B L TLZ &0,

GDB
GDB, MemTmr oI v JERTEPNIZTar I LHDOT Ny 7
Y =)V T, GDBDOIFMIC DWW T, http://www.gnu.org/software/
gdb/gdb.htmlZ B L T2 &0,

Glade
Gladeld. GTK+¥H L UOGNOMERHFEHD 2 —W A > 7 T = — AN HFT
9, GTK+DIEMNI, C. C++ C#. Perl. Python, JavaX"Z Do =ik
PAR—bFLTWET, .Glade?DiffIC DWW TIE, http://glade.gnome
corg/EHBIHL TS0,

GTK+

GTKHI T T T 4 W a—H A 2B T =— A%AFRT 5 712 D\83\'7d)VF
Ty hAR—=LY =Ty E T, TRXTOGNOMEY 7 r—3 3 >,
GIMP, BLUOZofho7 7 ) r— g CHHTEE9, GTKHIC/C+
PIAoEiE o0 R— T4 L0IG IS T ET, GTKIFRAIEGIMP
DI=DIETR SN /z7z®,  TGIMP Toolkit] & >9 RIS/ > TWET,
[ FFHIC DWW, http://www.gtk.orgZ B L TLZ &, GTK+
EEHEOBEMRMCOWTIE, http://gtk.org/features.html
#LanguageBindingsiCF & O 6N TWET,

KDevelop
KDevelop Tld, H72 % Si8(C/C++. Python, Perl’s &) T 1/ L& Lk
TEET, KDevelopiZld, R¥=o X2 b7 I oW, B oOidRrhERE
ety —AaA—RT5T 44, 22 A FDOGUL B LU % DMOKHEN
Z¥ENnF9, FMOWTL http://www.kdevelop.orgZ® ZHI{L T
T2&wn,

LinuxY 7 b 7 = 7 O E

361


http://www.die-offenbachs.de/eric/index.html
http://www.die-offenbachs.de/eric/index.html
http://gcc.gnu.org
http://www.gnu.org/software/gdb/gdb.html
http://www.gnu.org/software/gdb/gdb.html
http://glade.gnome.org/
http://glade.gnome.org/
http://www.gtk.org
http://gtk.org/features.html#LanguageBindings
http://gtk.org/features.html#LanguageBindings
http://www.kdevelop.org

362

MonoDevelop

Qt

Mono Projectld, .NETBHFE T 7 v b 74— LDOUnixN\—Y g v et —7
\83\5¢— A THHFEL T oA —-T VRS =27 FTTYT, Zo7nv=
7 o HIE, UnixBIREN I O A TS5y N 74— LDONETY 7V 7 —
va v E\N8AV5CER L TETE 5 L9175 2 & T9. MonoDevelopld,
Mono D RHFEFRITICIDE % fifi5¢ L £ 9. MonoDevelop D i+l DT,
http://www.monodevelop.com/% ZBIH{L T /2 &1,

Q. V'S 74 WNa— A B2 T=—ATT IV r— g BRT L
OOTATITLTATFTI)TY, Zhilk->T, 7By gt
07 L RNRICHAETEE T, Q74 77V IFLinux CHEHTE 27210
T <, —HoUnixFElE, Windows, 35 J U'Macintosh ¢ b T £ 7,
LEM>T 20T Ty 74— LICHRICHIETE 2 7075 L
LR TEE9, SEMICOWTIL, http://trolltech.comZHBHIHL T
23w, QUL 2BEFRE SO BRI OWTIE, http://developer
.kde.org/language-bindings/ICE O HNTNET,

Qt Designer

Qt Designerr. QtH L UKDETORIFRHO 22—V A >4 T = — AL LT
T4 —LENFTT, KDevelopDEO—aife LT, £/ F v Rryay
T— RTEIEL £9, QtDesignerlZ. Windows T & #{F L. VisualStudiold
FAA — MIHMET L2 L b TEET, QtDesignerdatflllic DT,
http://trolltech.com/products/qt/designer.htmlZZH{L T
TZEW,

Subversion

SubversionlXCVS & [AAf DFSFEL IR L £ 9725, X Z o) & RO
EH BERETZ77AN0EeT 4 L7 NUANDTH v Fp & OREEN RS
TWE T, Subversion®HR—IX—Fhttp://subversion.tigris
.org/TCY,

Valgrind

Valgrindld, x867 7V /7 —> a v DF Ny Z7BLO07a 7y A1) 7 H
D, TaTILDAA—KTT, ValgrindDEIC DWW TIE, http://
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ThinkFinger K & A /N % {fi[§ L C. SUSE Linux Enterprise®!3—%EDIBM I L O
Lenovo ThinkPadlZi&#% & 71 Cv» 5 UPEK/SGS Thomson Microelectronics D 455\
J—=F%YKR—-bLET, BUHFELY —FEZooFy 7~y 71U
S, AZ Y R7B Yy FNA ZAE72IFUSBF — R — RIS AR TR S
TWEJ, MOV TE, http://thinkfinger.svn.sourceforge
.net/viewvc/*checkout*/thinkfinger/README.inZZIHL T2 &
WV, VAT AR - AR S N TW LS. a s g v e AT — R
FOEEORENTIMA T, AMRGRREZ R TE £ 9, fElE &8kl ik, 22—
PIHHFY — Z IG5 AN ST 50, 21382 —-RE2 AL T %
ThcarZ A LET,

N—=RY=7F =y 7 TT7yv 7T hy TITHESNIZ(ER1EY AT LIRS
*Lf:)ﬁﬂ U= shizga, Ny r— ylibthinkfinger\
pam_thinkfinger, yast2-fingerprint-reader”?VHEJHNIIA A K —
NENET,

BUE, 22—V T LI ABRTEET, 22—V OEHT — 1T /ete/
pam_thinkfinger/login.birllR{FINE T, TERGLEALZEIT 5113,
YaST( D.2JH [YaSTIC Lk 45RO (364 X—)) ZZBH)E /23BN
TraryEMHTEStf-toolAY Y KT A Y —)U( [D3IH Ttf-toolll
LDIEMOEM] 367 X—)) ZHBH)oWThPEMHL 7.
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D.1 Y/ R—bENB7T7V5—3 Y
Eroay

PAM®E Y = — )bpam_thinkfinger Cld, (ROT7 TV r—v a7 73

AT U TTRRGREEZ AR — b L T E T (TR C o5 & THRRERAIND 2V

RENDDITIEH D THA):

« GDM/KDMNOBR 7 A v E7zidar A > = )b

» GNOME/KDET A7 b v 7 COMHH DT v 7 fiff s

* YaSTORHIG & YaSTEY = — )b

« rootN—3I v ¥, sudoF zldgnomesuTOT T U —3 g > OFLH)]

e su¥ /zldsu-usernamell L 5RO 2 —YIDANDLEHE

D.2 YaSTIC & A5 DEIR

FIE D.1  fEilaEAE O HLIL

FFED 2 —H120 U CEMGEEEZ BN T 21ClE, — IS ¥ 7 YaST THEAL
PR — N EHMNMCTHLERHY 9,

1 YaST##C§iL C. [/N— K= 7] > [FingerprintReader] % i#{R L %
K
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Fingerprint Reader Configuration

2 XEX A 7T, [UseFingerprint Reader] % HAMIL T, [E1]
27Uy LTEENEZRFL, Y4707z %7.

SFEIERA-PFIL TIEHEZER TS L LD L2,
FIED.2 15 DERR
1 YaSTC [tF =2 VU1 &z2—4] > [User Management] % 7 V) v 77 L
T [2—PLon—TOEH] Y477 2ZlEET. VAT LAD
2P FELFIN—TD) A NPFRREINET,
2 fER ST o —VemRL, [WE] 22 Vy 7 LET,

3 [Plug-Ins] # 7T > MU ZEIRNL T e. [EE)] 227V v
L C [Fingerprint Configuration] % A4 77 & £,

4 YaST/ 6. AN 0 ol EZRIERmA3EIE 6 1A F TIER & sn IS ¥ 5
rkoTar T IR ENE T,
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& Fingerprint configuration

5 fEIEFICINGE SN, [[aEd 5] 227 v 7 LT [Fingerprint
Configuration] ¥ A4 77 a—HFox L 7ar#HLC 7,

6 TSR % YaST ¥ 7213 YaSTE Y = — )L OEHNC b {F T A121%. root
DIF Y BT L2 LENH Y £7,

CDEOICE. [2—E TN —TOEH] XL 7a s T 4 IVE k
[ ZFhz2—H] IZHEL, rootTY MU ZEIRL CrootDIER %
Fito EHICLCERL T,

7 BNl oa—Vofgie &t Lizo. [7] 270y 7 LTEMY A7
7%, EEERFELET,

-V OIERMIEFICER SIS, 2—%L IDUH [ KR—-bENhE 77
Vir—ygrerryary] G4 XN—) IRI7ryarer7yyr—
Ta L TR EANZT = R s & TR T 5 MERTE S Lo ick
V)ij‘o

BUE, YaSTICITIEM OMEE F 72 1I3HIRMREREIZH 0 FHAMN, a~ 2 KT A1 >~
M OIEMEMEEE 2 IFHIRRTE £9, M WL, B OMEE F 72134
Fr (367 N—I) eI L TLZ &0,

YaSTTlE, 77 ANV AT LHICT CICHRIFESN T LIER T 7 A )U(* . bir)
A VRN TAHIEUTEET. [N— K= 7] > [Fingerprint Reader]
0w LT, 187 r ANDHLT 1 L7 N UEERERLITIASILET,
[FET] 227Uy 7 LTA R— ML 9. 507 7 AV 158007 7
ANDT T4V ET 4 L7 N /etc/pam_thinkfinger/login.birll=
E—&hET,
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D.3 tf-toolll K BAFERHDEIE

FIE D.3 15D EER
1 Vo V2T, root& L CuasA4>LE7,

2 HEDOaA—HoIEM 2 &R T 5121F. UToL2ICATILET,

tf-tool --add-user login

tf-tool/ 6, XY o] GEZIERABEIE 5 b £ TIHEM & s IS
"@éck57oti'/7}‘75‘§'%TéﬂiT

3 ERGREE A YaSTE /=1ZGNOME=Z > h 2 — )L > % —DYaSTE Y 2 —
JVORCENC O T A1C1E. root DIFH L BT L LENH Y £9°,

2—YPOIEMMIEFICER SIS &, 22—V IDUH R—-h&Shd7 7
Vr—Yarerrzyar) 364N—)) | gﬁ“'@”?ﬁ/a/t'}?j‘)/fﬂ
Ta A LB E N AT = R &b & Cilil T 2 miERTtE 5 koI
nET,
FIE D.4 HEH DG E 7= 1L HIFA

1 V= )VEBWT, root&LCuazA4>LET,

2 WEDaA VO OB EMIET 2101%, DIToa~wy RERTLE
ER
tf-tool --verify-user login

3 22—V DIEHEY — 7‘ :;ﬁiUf;'}HXbﬁ‘i'?— tf-toollHFERZ Z D2 —H
WL TREFES NI T Y > b &R L, 50— T 085 Ay
-V EFRRLET,

4 2—HFOIENEHIRT 51CE, Toavy RtZoa—Voiibd s
BT 7 A NVEHIRL 7,

shred /etc/pam_thinkfinger/login.bir
tf-tool--—acquire T, tf-tool%® T ANFEITTEET, fHIL/tmp/test
bir& U THRIES N, tf-tool-—verify CMEETEE 9,
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D.4 FFHIEHR

s TV =l MDOR—ILX—TFhttp: //thinkfinger.sourceforge
.net/IZHH £,

o PETHIZ2 3. A VAR =V L7 AT D /usr/share/doc/
packages/libthinkfinger/README% ZHIHL TL /2 &1y,

« pam_thinkfingerB L Utf-toolIlDW T~ =2 7MYl
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SUSE Linux Enterprise® Cl¥, >V 7 JVWacom7 A A% fifd 5% 7L v b
PCEIR—bLET, A VA= NVDORYAIZDMD > AT L L [ERCT AN
Ny lr =D D FEICIEMT 20E23H Y £, Totk. ATITA
A A WNREL £7,

FE:6AE Yy T —XF I F+ TDH T L v FPCORLEE

BlfE, # 7L v bPCIERE Y b7 —F T 7 F ¥ TCOAVR—FhENR T E
9, 7Ly hPCOWEEZGAL Y b7 —FF 7 F v THHT5I21E, 326y
RS AT LB A VA RN=IVT LH0ERHY £,

BTy RPCNy =% A VARV L TCTF I XA RIELLSHRETLH L,

AHATAEWINDL XL D AN, Ditorryarer7 T ) r—v g

VICHHTEET,

« KDMZ 7z13GDM~\oa 7 A

« KDEEGNOMETF A7 kv 7 oMHiD T v 7 fiflfh

o =V IOl FoME. 7T —3 g v oidll, KT, B A ZELHE,
U4 RUOHE) T4 Y RO T =N A, ATV = hDRTy
V& RNHy T8 ZOMDKRA VT4 Y TTNA AT AT v F /Ny
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« X Window System® 7 7 U r—3 3 > DY = AF v ifak D H
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« Jarnal¥ 7213 Xoumal/ze E D7 TV —3 q VTCORAEBERE IE A v
F. F7zldDasheril L5 KEDT F X b Dtk

FEA VAN —NWIIKLELGRFX—FR—FFELIITOR

SUSE Linux Enterprise® A > A b —)Lild, X% AN)j5 A4 2 & LT
TEEHA, #7 Ly MPCASHAARDF —R— RE /1T 7 v F /8y KA
SN T 2RWES, YATLEA VA N—=VT 57201 F —R—
RElI~m 2% % 7Ly FPCICHEfmL £,

E1 9Ly FPCRyHT—DDA VA
b—Jb

YaSTiZ# 7 L v hPCE HENMNCMIE LRV DT, Y AT LD A A k=)L

FFA VAR RISy =V ZIBEMLTA VAR =)L LET, ¥ T Ly

RPCOA VA b= )URF —IZlE, RO =V 0H 0 £,

« jarnal:JavaR— 2D AEVERH 7 TV r— 3 >~

« xournal: A BB LA v FHT7 TV r—v g v

« xstroke: X Windows System[r]i} ¥ = ZF ¥ — ik 7 11 75 L

+ xvkbd: X Window System[a]{J & — KR — R

+ x1l-input-wacom: Wacom% 7' L' v FMulF X A/JEY 2 — )V

+ x1l-input-wacom-tools: Wacom#% 7 L v Nl iE, . 547
21

Ny lr =2Fa<ry R4 VS TFITA A=V T 528, YaSTOA

VAN—ING = ERT A2 TEET,

1 YaST N r =V <3 =V x 2 a<xy RoA UnoilET 50, /203
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—gAO
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2 [y z] T, [ NEF=2] BERL AN =TT NV—TLE Nz
RIAOTREIR Ny r =Y 2 For L £7,

3 [Additional Software] V)V —7TC, A VA N—=)NVT 5 & 7L v FPC/N
F—rv—7 L%,

4 [[GET2] #2297 LT, Nulr—YoA A N=)VEBKBLE
7.

E.2 Wacom> /5 ADEE

BTy NPCRyr =% A VA M=)V L7Tcb, 7Ly bTNA AL KIE
L £, BIff. SUSE Linux EnterpriseldSaX2(Z & %5 WacomT /N A A D IE % Y
AR=FLTWERFA, CDLED, VAT LXKET 7 AINEiHET L0END
DET, SATLEHEORN, /etc/X11/xorg.conf7 7 A )VEELHET
TET,

EEXRERE D 7 A WICATENBREZTI EN—RD 2 7HEET 2
aJREMENH Y £
/etc/xX11/xorg.conf 7 7 A W EHET HANI, TLOT 7 A INVDINy J

Ty TEERLET, 77 ANVDZoMor s g v ERELRNWTLE
I, N—= R = 7HMEGT HalgEMENH Y 7,

WacomT NA AD . /ete/X11/xorg.confll Ml E.1. TWacomT /3 A
ADPIE] B2 X—=) WIRT LTI TiBEmL £7,
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# E.1 Wacom 7 /54 X DFEE

1. LIT® X912, InputbDevicekZ ¥ g ZiBML £7,

Section "InputDevice" @

Driver "wacom"

Identifier "Mouse [5]"

Option "Device" "/dev/ttySO"

Option "ForceDevice" "ISDV4"

Option "InputFashion" "Tablet"

Option "Mode" "Absolute"

Option "SendCoreEvents" "on"

Option "Type" "cursor"
EndSection

Section "InputDevice" @

Driver "wacom"

Identifier "Mouse [7]"

Option "Device" "/dev/ttySO"

Option "ForceDevice" "ISDV4"

Option "InputFashion" "Pen"

Option "Mode" "Absolute"

Option "Type" "stylus"
EndSection

Section "InputDevice" ©

Driver "wacom"

Identifier "Mouse [9]"

Option "Device" "/dev/ttySO"

Option "ForceDevice" "ISDV4"

Option "InputFashion" "Eraser"

Option "Mode" "Absolute"

Option "Type" "eraser"
EndSection

® /dev/ttySOIIEmLT=2 T Ly =V IV ATIFNA ZAD
HP Compaq tc4200Z {9 555, 20\ VIl/dev/ttys2% i
L ET, SaXeoo S/ —2 g VCRBENFEL WL DI, 7
INA ZNZ1E"Mouse [5]1 " IDE Y YT hE T,

BTV NAEATAANIT NA ADKIE,

® Y TULy MUAPANITNA ZADHE, N2 DZ DML <
DWOT TV —2 gy CANEHET S oI hE T,

®
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2. ITNofr%serverLayout® 7 ¥ g VIZIBL £7,

InputDevice "Mouse[5]" "SendCoreEvents"
InputDevice "Mouse[7]" "SendCoreEvents"
InputDevice "Mouse[9]" "SendCoreEvents"

CDEIEEFTLHE, /Jete/X11l/xorg.conflF T X Ik £
‘g‘o

Section "InputDevice" @

Driver "mouse"
Identifier "Mouse [3]"
Option "Buttons" "5"
Option "Device" "/dev/input/mice"
Option "Name" "ImPS/2 Generic Wheel Mouse"
Option "Protocol" "explorerps/2"
Option "Vendor" "Sysp"
Option "ZAxisMapping" "4 5"
EndSection

Section "InputDevice" @

Driver "wacom"

Identifier "Mouse [5]"

Option "Device" "/dev/ttySO"

Option "ForceDevice" "ISDV4"

Option "InputFashion" "Tablet"

Option "Mode" "Absolute"

Option "SendCoreEvents" "on"

Option "Type" "cursor"
EndSection

Section "InputDevice" ©

Driver "wacom"

Identifier "Mouse [7]"

Option "Device" "/dev/ttySO"

Option "ForceDevice" "ISDV4"

Option "InputFashion" "Pen"

Option "Mode" "Absolute"

Option "Type" "stylus"
EndSection

Section "InputDevice" @

Driver "wacom"

Identifier "Mouse [9]"

Option "Device" "/dev/ttySO"
Option "ForceDevice" "ISDV4"
Option "InputFashion" "Eraser"
Option "Mode" "Absolute"
Option "Type" "eraser"
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EndSection

[...]

Section "ServerLayout"

Identifier
InputDevice
InputDevice
InputDevice
InputDevice
InputDevice
InputDevice
Option
Option
Screen
EndSection

@ © & ® @

"Layout [all]"

"Keyboard[0]" "CoreKeyboard"
"Mouse [1]" "CorePointer"

"Mouse [3]" "SendCoreEvents"
"Mouse [5]" "SendCoreEvents"
"Mouse[7]" "SendCoreEvents"
"Mouse[9]" "SendCoreEvents"

"Clone" "off"
"Xinerama" "off"
"Screen[0]"

T 7 4 N D2 AKIE,
WL <iBEmshiz,
WL <iBmshiz,
WL <iBmshiz,

Ty b ATITNA A
D"Mouse [5]". "Mouse[7]". "Mouse[9]"A’X ServerT /NA A|Z

Bnshxd,
ZOFEME, KFEDs Ty FPCTHEHEL £

howto/x11) CFIHZMERL T2 S0,

3. X Window System®D i ENFL T L7z, aZ 7o M3 h0, Fllda—%
A VH T 2— A% T L Tinit3ss init 52 Ea sy — L TEITL

C. X ServerZ ftcEfL £,
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5}

BTV M= IWVATT A ZDHKIE,
2TV NAZ AT AATITNA ADFHIE,
2Ty b UAYFASIT A 2D

#HflE, Linux Wacom
Webt A M(http://linuxwacom.sourceforge.net/index.php/


http://linuxwacom.sourceforge.net/index.php/howto/x11
http://linuxwacom.sourceforge.net/index.php/howto/x11

E3 7L v FPCO—FEH L ERED(E
FA

WacomT NA A& HELZH, XU EASITNAAL ZE L TEHTESL LD
7w ¥,

E 3 1 ﬁtL_.\ :_ I\\\d)ﬁﬁﬁ

KDEF 72I3GNOMET A7 b v a7 A 4 512%, E£/2d@Efmoay 7 %
iR BIClE, 22—V L NNAT— REZRERVICATIT L2, arz A >
T4 =)V RD NIFEKREND 3 CHEE —R— Rxvkbd CANJL E£9, F—
A= REZHETAHICNE. FREFHMEINTICT 72 2T 510, K FHEDxvkbd
T4 —=IVR%ZZ Uy 7 L TxvkbdA A Y A= —ZHHEET,

K E.1 xvkbd [KEF —A— K

I O N G G | ok 02.7)

EHHHHHHAHNRRREE NN
tab [a|w|e|r|T|¥|u| 1 |o|r]i % Del I?—h:rne Bup ggup +
contol | Al s|o| Fla|ulalx] ] || Retwun ‘Eeﬂ g Eﬁght L

Shift z|lx|lc|lv]|eB|Hn|M ‘ > ; 500;; Shift :En ’ %wn SF'gDn »
kb B3 | | et Meta| At | <[]t | 4 [Foeus| O - -

07 A ARICxvkbd Z T 21213, A v A== 6T 50, /0T
Tz VDS xvkbd CHREE L F 9.

E3.2 54 A7 LA DOlEx

BT Vy NPCEZA Z[dllind 208, T4 AT VAT T T 4908 T Ly
INDIE R3S EE 110 ﬂﬂéhiﬁh KDET A7 b v 7D, KRandRTray
%ﬁﬁbf\?4x7b4%%@%f%ﬁf@%iti%%x%*%bi?o
KRandRTray!3X Server ®RANDRILREEHEM] T OKDEY 7' L v K TY,
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1 A A=a—F7F Y =)V Hkrandrtray . KRandRTray % jtCf
LEd., 21T, KRandRTray7” A I VN Y A7 Lk LA ICiBnsh E
ER

2 T4 AT VA AT HICE. 74227y 7L TCarysTHFARR

=26 HNDOMEEERLET., T4 AT VAMH LW ARICT

WCEERL 9, /2, VY9749 27Ty bomEbEHEIh, X
OMENY L < fiffRah 7,

GNOMET A7 kv 7 DigE. FITEEEOMEE TSR 2 L v 2 (T
TERA, FHICOWTL BYH I TN a—T 427 B79X—)
ZHIHL TLIEE N,

E3.3 V1 AF v REBOFER

xstroke Tl, N2 FNEZDOMDERA T4 VI TNAATDOY = AF ¥ &,
X Window System®D 7 7 ) r— g A~NDAJj& LT TE £, xstroke”
V7 7 Xy ME, Graffiti* 7 7 Ly MIE{loaz=2 a -7 7)1 7 7 Xy K
T9., HUNcT 5L, xstrokel AJJ#HE T+ —HASNTWE T 4 VR
WICEELET,

1 A AZa—6, Y 2V SxstrokeZ§if] L T, xstroke%
EILET, T, RovuvAarBy 2L b b AICiBnshE
7,

2 XUTTHFAMNANEHRT 7T r—v g v eidiL £ —3
TN 4 R TEFANIT 4 . OpenOffice.org Writer/ &),

3 VAT v —ilalT— REHMCT LI Ny A arkiEy
Vw7 LET,

4 XUFERAWDORA VT4 VITFNA AT, Vo974 9 78Ty b b
T EPDY 2 AF % ZITVET, xstrokeld Y = AF ¥ 2 X ¥ 7T ¥
L. X ANMNCHELTC I A —HADHLT7 TV r—ar s v Ry
ISRl £9,

5 7a—hAEWWOT 4 > ROICHTICE. HRlOY 1V RO%2X T
JyZ LTLIEBLZOEFICLET(ELIE. A by Toar bk
O— )% —CEHRLEF—R—-Kya—rhy bEMHL £9),
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6 VAT YT — R2MmNCT LIl RovurAarky o) —E
20w 7 LET,

E34 RUHEFHUIEAETDIERE AT v F

NUTHEERT HICUE GIMPO LS T A} 757 4 v 7 5 1 # % ff
FHL 72 Y. Xournal ¥ 7z13Jamal’e & D AR 7Y 7V r—> 3 V2L £
9", Xournal & Jarnal D lj /5 % {fi 5 T, X TRAERHZ/EK L., PDF7 7 A )L
WICaXAyhEffFeonEd, W<O2PDT Ty b7 4 —LTHHHTE SJava
R—=2D7 TV rr—3 g2 LT, JamalilldFE AN a oKL —3 g U ESEE
LHY T, FMTOWTIEL http://www.dklevine.com/general/
software/tcl000/jarnal-net.htmZZBIHL TS, ary5 oY%
RIFTH L X, JamalldT — % %7 — N A A ja)icT — 7 2 fR{FL. =
NICIISVGIER D 7 y A Vb EENE T,

Jarnal ¥ 7213 Xoumalz X f > A =2 —76, £7/2lEY = )ViZjarnal £721%

xournal & AJJU CHEEL £9°, Xournal CPDF 7 7 A VIC T X > b &[T 5
Wik, [Z7 74 ] > [Annotate PDF] #FRL T, 77 A IV AT L5
PDF7 7 A WEBEE T, XU ELIENORA T4 7T NA Z%MHL
CPDFICHEMRZENT. [Z7 4] > [Printto PDF] TEENEEZMHRFL ¥
E
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K E.2 Xournalll J: 2PDFDFFH

Eile Edit Mew Journal Tools Options Help

Hd e+ 0000 G QKANE

Vo /rmmHOL - sonmEuEEnEE -
D.1 Installing Tablet PC Packages =

YaST does not automatically detect Tablet PCs, therefore you need to install additional D
packages during or after installation of your system. The TabletPC installation pattern
contains the following packages:

= jarnal:aJava based note taking application

application for note aking and sketching
» xstroke: a gesture recognition program for the X Window System
+ xvkbd: a virtual keyboard for the X Window System <&M \('{ % &\Q,-e,

» x1l-input-wacom: X11 input module for Wacom tablets

\ = xll-input-wacon-tocls: provides configuration,
for Wacom tablets

You can either manually install the packages via command line or select the pattern for
installation in YaST:

1 Start the YaST package manager from the command line or open YaST and select
Saoftware > Software Management.

r

]

[l [ [I+]

Page o1z Layer | Layer1 - H

Dasher® (Ef)7e 7 7V r—> 9 T3, F—KR—KATIMWEHRTIER0,
FRFAATERWEEICEL TOET, VLT T, XUETT
KEOTFTHF AN EFEHRICASTITEL LI 9 (F 23 FHRRBHR TR
SN L XIS D ATITNA R),

A v AZa—=06, FET =)V Sdasher & AJJL TDasher % itCif] L
T, Xy HcENT e, 7TV =2 a UNEHO U X — LA
YLET, FROFTFEMSLENS, TR ARNERE ZIETHI S 1,
74 v Ry EERCIenE T, ESAR L E LITREET 2123 T4
ATVA "X TCIRZ )y 7 LET, U4 VR NETCA LA EL
E
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X E.3 DasheriC J: 57 F 2 N Dt
File Edit Options Help

ERZ RN B &

Helloe World
. b
C
— c
f e
. ?ﬁ

1.0
1
L

DasherOME&lE, 2L O SETEIEL $£9°, I Dasherd®Web¥ A b %
LTL7ZEn, gl RE¥a X b, T, bL—=07HTXFZAMDD

%9, http://www.inference.phy.cam.ac.uk/dasher/% Z% 72
I,

E4 SN a—F4 Y

HEF —R— K2 7 A VEHICFRR S e
. a2 A VHEEDMUEF —R— RIcFEREnanz enH v 9, =
NEPERT HITIE, Crl+ Alt + <—Z 972, £72137 7Ly FPCOLY
THXF—(NEF—AR— ROV AL— NEF VLML T L5E) %2
L. XServerZ lici L £9, HF—R— KD FLEFRSI N 0WiGE
. B —AR— K22 L — M EF ML, N— R =27F—R—-K
AL B YA L FET,
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7574w 78Ty hOEENGNOME TEHE I gty
xrandraA XY KT, Y26 T 4 AT VA DS EEETEET,
xrandr--help& AJJT 25 &, ﬁﬁqf%éﬂ‘j\‘/a UIFRORENE T,
7574927y hoE AEIRICEET LICE, a<v > RELTo
INCEHELFT,

1 D F7 ) (0% [A]dix):

xrandr -o 0 && xsetwacom set "Mouse[7]" Rotate 0

* 90RE[EldR(FFE AV | #E):

xrandr -o 3 && xsetwacom set "Mouse[7]" Rotate 1

« 180 [ #ix(#):

xrandr -o 2 && xsetwacom set "Mouse[7]" Rotate 3

« 2705 AR D L HE):

xrandr -o 1 && xsetwacom set "Mouse[7]" Rotate 2

Fitoa~< >y Rlid, /ete/xX11l/xorg.confiXiE7 7 A IVONFIZE > T
B 9, I E1. TWacomT /NA ZADFIE] (372 N— D) DTN % ff
AL7GE, a~v >y Rididi&lzeB0) *&Lbbi'é‘o xorg.conf D%
Ty NAZATGAANTITNA ZADOIDEEHEL =8 E1E, "Mouse [7] "%
HLWIDICERL £,

E.5 S35

ZZTCaHLEETY TV =Y a v o—FRFMES T4 NIV TH Y F
A, TR K OREIC OO T ORI ERDS, A VAR =Lz
AT D /usr/share/doc/package/packagename ¥ 7=13Web FIZH U F
kR

« Xournal D~ == 7 )UIL, http://xournal.sourceforge.net/manual
.html 2B L TS0,

« Jarnal® R¥ = X > MF, http://www.dklevine.com/general/
software/tcl000/jarnal.htm#documentationil®H ¥ F7,
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+ xstrokeD~ == 7 )L X—E, http://davesource.com/Projects/
xstroke/xstroke.txtilH Y 7,

« Linux F CX%#ET 5 fiklE. WacomWebY 1 M(http://linuxwacom
.sourceforge.net/index.php/howto/x11)% HBIHL T /2 &1y,

« Dasher7 1Y =7 MIDUWWTIE WebY A bhttp://www.inference
.phy.cam.ac.uk/dasher/IZi iR EREH Y 77,
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